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01  Introduction 

iDig Connect is a machine guidance system designed for excavators, compact track loaders, skid steers, 
CTL grader and dozer attachments, and other earth-moving equipment. It puts a real-time view of where 
your bucket is, where your design surface is, and how much you need to cut or fill — directly inside the 
cab. The result is faster work, fewer grade-checker trips, less rework, and a safer jobsite. 

If you have run a laser receiver before, you already understand the basic idea: a reference somewhere 
out on the site tells the grade checker its elevation. iDig Connect takes that idea and adds wireless angle 
sensors on the boom, stick, and bucket so the operator inside the machine always knows where the 
bucket tip is in three-dimensional space — not just up and down, but in and out, side to side, and at what 
slope. Add the iDig Spotman GNSS receiver and you have full RTK-corrected position information, the 
same technology surveyors and dozers use for site grading. 

This guide is written for construction operators, site superintendents, and owner/operators in North 
America. It assumes you are working in US Survey Feet or International Feet, using NAD83 State Plane 
coordinates, and connecting to the Spotman GNSS receiver. Every instruction is explained in plain 
language with real-world construction context. 

 
About This Guide Series 
This is Volume 1 of 8. It covers everything you need to do at the shop or bench before going to the 
machine — unboxing, mounting the Control Box in its cradle, powering on for the first time, applying 
licenses, updating firmware, configuring remote support, and connecting your cloud account. 
Subsequent volumes cover Hardware Installation, GNSS Configuration, Machine Calibration, 
Settings & Configuration, User Interface, Projects & Coordinate Systems, and Field Operations. 

The Three iDig Connect Tiers 

iDig Connect is sold in three software tiers — 2D+, 2D Project, and 3D — that share the same hardware 
and grow with your work. You start where you are, and upgrade through paid software licenses when you 
are ready. There is no need to swap the Control Box, the cradle, or the sensors; the Spotman GNSS 
receiver and the chassis sensor used by 3D will fit any Connect system. 

Tier What It Does Typical Use 

Connect 2D+ Wireless angle sensors on boom, stick, 
and bucket give depth, slope, distance, 
and Smart Tape measurement. Works with 
a rotating laser for elevation reference. 
Optional Spotman GNSS adds elevation 
reference without a laser. 

Trenching, pad preparation, 
basement digs, footing excavation, 
slope work — anywhere you would 
otherwise be checking grade by 
hand. 

Connect 2D 
Project 

Everything in 2D+, plus the ability to import 
one DXF design file (up to 150 m × 150 m) 
and operate in 3D mode using the Front, 
Side, and Map view. Uses the Spotman 
GNSS for positioning. Up to 5 projects 
stored. 

Small-to-medium contractors who 
get a single DXF from the engineer 
for each job — utilities, parking lots, 
building pads. 
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Tier What It Does Typical Use 

Connect 3D Full 3D machine guidance. Unlimited DXF 
and LandXML imports of any size. 3D 
visualization of design and bucket. Create 
surfaces in the cab. Pairs with iPoint for 
survey and stakeout. 

Site work, road and highway 
construction, pond and detention 
basin grading, large commercial 
pads, anything where the design 
comes in from a surveyor or civil 
engineer as a 3D model. 

 
 

Real-World Tip: Buy the Tier You Need Today 
iDig Connect is designed to be upgraded later. If you mostly dig footings and trenches, start with 
2D+. When you land your first project that comes with a CAD design, add the 2D Project license. 
When you start running large grading projects — or want to stop hiring grade checkers — step up to 
3D. The hardware does not change; only the license does. 

How This Guide Is Organized 

The complete iDig Connect User Guide is delivered in eight volumes plus two appendices. Each volume 
is self-contained but cross-referenced. The order matches the order an installer or operator typically 
encounters the material — start at Volume 1, work through to Volume 8, and you will have walked from an 
unopened box to a fully calibrated machine grading to a 3D design. 

Volume Covers 

Volume 1: Getting Started Introduction, system overview, unboxing, first power-on, licensing, 
software updates, remote access, and cloud file configuration. 

Volume 2: Hardware 
Installation 

Mounting sensors on boom, stick, bucket, and chassis; mounting 
the Control Box, LED Bargraph, and Spotman GNSS receiver; 
CAN wiring for tiltrotators. 

Volume 3: GNSS Receiver 
Configuration 

Configuring the Spotman receiver: WebUI, NMEA outputs, NTRIP 
corrections, SIM card setup, UHF radio, base-station receive, and 
pairing to iDig. 

Volume 4: Machine 
Calibration 

The full calibration sequence: cradle, boom and stick wizard, 
bucket, swing boom, chassis, GNSS 3D, laser receiver, tiltrotator. 
Accuracy checks and calibration backup. 

Volume 5: Settings & 
Configuration 

All Settings menu options — language, units, sound, sensors, 
GNSS, Restrictive Mode, display, storage, LED Bargraph, audible 
alerts, joystick buttons, import/export. 

Volume 6: User Interface & 
Work Screen 

Work-screen anatomy, view layouts, toolbars, and a complete tool 
icon reference. 

Volume 7: Projects, 
Coordinate Systems & 
Surfaces 

Coordinate system selection, geoids, site localization, project 
creation, design import, layer management, and project 
import/export. 

Volume 8: Field Operations Daily operating procedures for 2D, 2D+, 2D Project (3D Lite), and 
3D modes. Dynamic Laser Catch, Swing Boom, Smart Tape, 
Height Alarm, surface creation, and the daily 3D workflow. 
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Before You Start Volume 1 
You need: the iDig Connect kit you purchased, a Phillips screwdriver, glass cleaner spray (for 
window-mount prep), a USB stick formatted to FAT32, and access to a Wi-Fi network for software 
updates and licensing. You do not need to be parked next to a machine to work through Volume 1 
— most of this can be done at the shop or in your truck. 
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02  System Overview & Product Tiers 

Every iDig Connect system, regardless of tier, is built from the same family of hardware components. 
Knowing what each piece does — and which ones ship with your specific kit — makes the rest of 
installation and calibration much easier. 

The Core Hardware Components 

Component Purpose 

Control Box (BT142) The main computer. Runs iDig Connect software. Mounts in the 
BT447 cradle on the cab window. Touch screen interface. 

BT447 Cradle Suction-mount holder for the Control Box. Houses the power input, 
USB ports, CAN switches, and the Bluetooth/WiFi dongle. The 
dongle must always be in the top-left USB port. 

LED Bargraph (BT445) Stick-mounted LED display visible in the operator's peripheral 
vision. Shows cut/fill at a glance so the operator does not have to 
look at the touch screen during continuous digging. 

CT149 LED Bargraph Cradle Suction-mount holder for the BT445 LED Bargraph. Typically 
mounted on the front window of the cab, in clear sight of the work 
tool. 

Mini Sensor (BT144) Wireless angle sensor used on the boom and bucket. Also serves 
as the tilt sensor on machines equipped with a tilt bucket. Bluetooth 
communication. Solar-rechargeable internal battery. Snaps onto 
the XD422 mini plate. 

XD422 Mini Plate Kit Mounting plate for the Mini Sensor. Ships with 3M adhesive tape 
(XD416MS) and cleaning wipes (XD417). One plate is installed on 
the machine for each Mini Sensor location. 

Combo Sensor (BT145) / Big 
Combo (BT147) 

Wireless angle sensor used on the stick. Includes a built-in laser 
receiver, which is why it goes on the stick — to catch a rotating 
laser beam for 2D elevation reference. The Big Combo (BT147) 
provides a wider laser-catch window for larger machines. 

XD412 Combo Plate Kit / 
XD436 Big Combo Plate Kit 

Mounting plate for the Combo or Big Combo Sensor. Ships with 3M 
adhesive tape (XD416) and cleaning wipes (XD417). One plate is 
installed on the stick. 

Chassis Sensor (BT476) Cab-frame sensor that tells the system how the cab is tilted, which 
is critical for both 2D accuracy and 3D positioning. Wired for power 
(CT425C Y-shielded cable) but communicates with the Control Box 
over Bluetooth. Uses the same XD422 mini plate as the Mini 
Sensor. 

Spotman GNSS Receiver 
(CT140T) 

Multi-constellation RTK GNSS receiver. Mounts on the cab roof to 
give the system precise position and elevation anywhere on the 
jobsite. Required for 2D Project and 3D. Optional with 2D+. 

BT/WiFi Dongle USB dongle that plugs into the top-left USB port of the cradle. 
Provides Bluetooth links to all sensors and to the Spotman, plus 
Wi-Fi for remote update and remote access. 
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2D Project Limitations 
If you operate a 2D Project system, you can import only one DXF design file per project, and that 
file must fit within a 500 m × 500 m area. The system stores up to 5 projects total. There is no 3D 
view — you work in Front, Side, and Map views only. If your project size or count exceeds these 
limits, you need a Connect 3D license. 

The Upgrade Path 

All three Connect tiers share the same Control Box, Cradle, LED Bargraph, and Angle Sensors. The 
differences are the software license, whether the Spotman GNSS receiver is included, and what kinds of 
designs the system can work with. That means upgrading is almost always a matter of adding a license or 
adding a Spotman — the installed sensor plates on your machine don't change, and the calibration you 
have already invested in stays intact. 

Moving from 2D+ to 2D Project typically means adding the CT150 software upgrade plus a Spotman 
GNSS receiver and iPoint license. Moving from 2D Project to full 3D adds the CT137 software upgrade — 
no new hardware required. Two additional licenses unlock specific advanced features in Connect v5 
software: Swing Boom (CT145), which allows the operator to swing the boom on machines equipped with 
a swing-boom feature while iDig continues to provide accurate guidance, and Dynamic Laser Catch 
(CT155), which lets the operator capture the laser elevation while moving rather than holding the bucket 
still in the beam. Both ship with a 120-day free trial; see Section 06. 

 
Plan Your Upgrade Path Before You Buy 
Talk with your iDig dealer about where you expect your business to be in the next few years. 
Because the Connect platform is designed to grow with your work, upgrading between tiers is 
almost always a matter of adding a software license (and, for 2D+ → 2D Project or 3D, adding a 
Spotman GNSS receiver). The installed sensor plates and your existing calibration are preserved 
through the upgrade. 
The stick-sensor choice is a separate conversation — it depends on how you use iDig. The Combo 
Sensor (BT145) works for many machines. The Big Combo Sensor (BT147) provides a larger 
laser-capture window, which makes it much easier to catch a rotating laser to bench after moving 
the machine. If you work with a laser transmitter regularly — especially on larger excavators — the 
Big Combo is the better starting point. 
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03  What's In the Box — Package Contents Checklist 

Connect systems ship in many different configurations depending on what you ordered — the tier (2D+, 
2D Project, 3D), the stick sensor size (Combo vs. Big Combo), whether the Spotman GNSS receiver is 
included, whether you added the Spotman backpack kit for off-machine survey, and any extra-machine 
kits for additional excavators. Rather than list every possible permutation, this section tells you what to 
look for and verify, regardless of which configuration you purchased. 

iDig Connect systems typically ship in a rugged foam-lined case (BT485) that holds the Control Box, 
sensors, LED Bargraph, and accessories. Unpack everything and lay it out on a clean bench or tailgate 
before you start. 

 
Critical: Unpack and Verify Before You Start Installation 
Sensor plates use a permanent 3M adhesive. Once a plate is installed on the machine, it does not 
come off cleanly. Always confirm you have every component before starting installation — finding a 
missing chassis sensor halfway through is far more painful than finding it on the bench. Take a 
photo of the open case for your records, and check every item against your dealer's order 
confirmation. 

Verifying Your Connect System 

Regardless of which configuration you ordered, a Connect system should include all of the following core 
components. Use this list as a bench check — confirm each item is present, undamaged, and that the 
sensors show battery life when removed from their plates and re-seated. 

Component Verify 

Control Box (BT142) Present, screen intact, no visible damage. The serial number 
(CB######) is on the back and also displayed at the bottom-left of 
the main Settings screen. 

BT447 Control Box Cradle Present, suction cups intact, power connector and USB ports free 
of debris. 

BT/WiFi Dongle Present. It is a small USB dongle; it installs in the top-left USB port 
of the cradle. 

BT445 LED Bargraph Present, LEDs visible, USB cable intact. 

CT149 LED Bargraph Cradle Present, suction cup intact. 

Mini Sensors (BT144) You should have one per Mini Sensor location — typically boom 
and bucket. Check each sensor turns on when removed from its 
plate and re-seated. 

Combo or Big Combo Sensor 
(BT145 or BT147) 

One per machine, for the stick. Contains the built-in laser receiver. 

Chassis Sensor (BT476) One per machine. The BT476 is required for the chassis position 
on all current Connect installations. Wired for power via the 
CT425C Y-shielded cable; communicates with the Control Box over 
Bluetooth. 
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Component Verify 

Mounting Plate Kits One XD422 Mini Plate Kit per Mini Sensor location, plus one 
XD412 Combo Plate Kit (for BT145) or XD436 Big Combo Plate Kit 
(for BT147) per stick, plus one XD422 Mini Plate Kit for the chassis 
sensor. Each plate ships with 3M adhesive tape and cleaning 
wipes. 

CT425C Y-Shielded Power 
Cable 

4-pin Y-shielded cable from the cradle to the BT476 chassis 
sensor. 

Spotman GNSS Receiver 
(CT140T) 

Required for 2D Project and 3D. Optional with 2D+. Confirm 
antenna, connectors, and carrying accessories are all present. 

GNSS Mount (CT139) Required on machines where the CT139 geometry works. Provides 
the bracket that holds the Spotman receiver on the cab roof. Verify 
the bracket, hardware, and any pre-drilled mounting plates are 
present. See the note below on whether the CT139 is the right 
mount for your machine. 

Software License File(s) A .lic file or activation email for any purchased tier license (CT150, 
CT151, CT137) or feature license (CT145 Swing Boom, CT155 
Dynamic Laser Catch). See Section 06 for activation. 

 
 

Critical: GNSS Receiver Must Be 1 Meter from the Center of Rotation 
The Spotman GNSS receiver must be mounted at least 1 meter (39.4 inches) away from the 
machine's center of rotation. This distance is required for the system to resolve heading correctly as 
the cab rotates — mounting closer than 1 meter will not produce reliable guidance. 
On most larger excavators, the CT139 GNSS Mount bracket achieves the 1-meter offset without 
modification. On smaller machines or machines with an unusual cab geometry, the CT139 may not 
provide enough offset — in that case, a custom GNSS bracket must be built for the machine. 
Evaluate the geometry before installation, and contact your iDig dealer if you need a custom mount 
fabricated. 

 
 

Real-World Tip: Confirm Your Order Before You Dig In 
Before starting installation, cross-check the components in the case against what you ordered from 
your iDig dealer. If anything is missing or damaged, call your dealer right away — most missing or 
damaged items can be replaced within 2 days, and it does not matter whether installation has 
started. Catching a short-ship on day one saves you chasing a part mid-install. 

Calibration Tools 

The calibration toolkit is included with every iDig Connect system. These items are used during the boom 
and stick wizard calibration in Volume 4, so keep them together so they're easy to find when you need 
them — they are reused across every machine you install on. The calibration toolkit ships in a dedicated 
black soft roll-up case, separate from the foam-lined case that holds the Control Box and sensors. 
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Item Part Number Purpose 

Laser Pointer XB525 Laser pointer with L-bar and 5/8" to 1/4" connector. 
Provides the laser line used during the boom and stick 
wizard calibration. 

Tribrach XD477 Holds the laser pointer level on a non-elevating tripod. 

Magnetic Target XD470 Mounts magnetically to the bucket teeth or stick to provide 
a target for initial sensor alignment and laser calibration. 

Laser Adapter XD478 Fits the XB525 laser pointer to the tripod / tribrach setup. 

Extension Rods XD471 Initial-setup extension rods used during laser calibration to 
set the laser height accurately. 

 
 

Keep the Calibration Toolkit With the System 
Because the calibration tools are reused for every install and every re-calibration, keep them rolled 
up in the black soft case that ships with the Connect system rather than loose in a truck box. Losing 
the XB525 laser pointer or the XD470 magnetic target will stop a calibration cold — they are 
purpose-built for this workflow and are not items you can easily substitute from a general-purpose 
toolbox. 
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04  Control Box & Cradle Setup 

Before powering on the Control Box for the first time, you need to mount its cradle, mount the LED 
Bargraph cradle, and connect the dongles and cables that will be in place during day-to-day operation. 
This section covers the bench-or-shop setup; the optimal placement on each specific machine is covered 
in Volume 2. 

 
Before You Start 
You will need: clean glass-cleaner spray, a clean rag, the BT447 cradle, the CT149 LED cradle, the 
BT/WiFi dongle, the LED Bargraph (BT445), and the CT425C Y-shielded power cable. The machine 
should be off and the cab should be empty enough to reach the front and side windows. 

Choosing Mounting Locations 

The BT447 cradle holds the Control Box and typically mounts on the right-hand side window of the cab 
where the operator can reach the touch screen with their right hand. The CT149 cradle holds the LED 
Bargraph and typically mounts on the front window in clear view of the work tool, so the operator can see 
cut/fill at a glance without taking their eyes off the bucket. 

Both cradles use suction cups designed to hold securely on clean glass. Before mounting, confirm two 
things: (1) the front window can still open and slide normally with the LED cradle in place, and (2) the side 
window can still slide normally with the CBox cradle in place. It is much easier to find a different mounting 
spot now than after the suction cups are stuck and the cables are routed. 

Step-by-Step: Mounting the Cradles 

1 
Power the machine off and remove the key. 
All installation work happens with the machine off. Do not skip this step — accidental 
hydraulic movement during install is a serious hazard. 

 

2 

Clean both window mounting locations. 
Spray glass cleaner on a clean rag and wipe the inside of the front window where the LED 
cradle will mount, and the inside of the side window where the CBox cradle will mount. The 
glass must be free of dust, grease, and residue for the suction cups to hold. 

 

3 
Test fit both cradles before committing. 
Press each cradle lightly to the glass without engaging the suction lock. Confirm that the 
windows can still open and slide. Check that cables (next steps) will reach without strain. 

 

4 
Engage the BT447 cradle on the side window. 
Press the cradle firmly to clean glass and engage the suction-cup lock. Verify the cradle is 
solid by tugging gently. 
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5 
Engage the CT149 cradle on the front window. 
Same procedure. The LED Bargraph should sit in the operator's peripheral vision when 
looking at the work tool. 

 

6 

Run the cables and tidy them. 
Route the power cable, the LED cable, and any sensor cabling along existing wiring runs in 
the cab. Avoid routing across pinch points (door hinges, sliding windows, seat tracks). We 
recommend tidying cables using 6" zip ties and 3/4" cable tie mounts so they don't snag the 
operator's clothing or controls. 

 
 

The BT447 Cradle — Ports and Switches 

The BT447 cradle has a small but important set of connectors. Knowing which port does what prevents 
almost every "why won't it power on" or "why doesn't the LED light up" support call. 

Port / Switch What Goes Here 

Power input (4-pin, 
screw-locking) 

Cradle power cable from the machine's 12V or 24V outlet. Align the 
connector correctly, push in firmly, then screw the locking ring until 
tight. 

Top-left USB port BT/WiFi dongle. This port is reserved for the dongle — do not put 
the LED here. The system will not connect to sensors or remote 
services if the dongle is in the wrong port. 

Other USB ports LED Indicator (BT445), USB stick for software updates or imports, 
or any other USB accessory. Any of the remaining USB ports can 
be used. 

CT425C Y-shielded cable 
connector 

If you are using the BT476 chassis sensor in backward-compatible 
mode (older firmware) or you simply want to power the chassis 
sensor from the cradle, the CT425C connects here. 

CAN switches #1 and #2 Inside the cradle (T10 Torx access). Factory-default ON. They only 
need to be touched when troubleshooting CAN data from a 
tiltrotator (see Volume 2 Section 09). Leave them alone during 
initial setup. 

 
 

Critical: The BT/WiFi Dongle Must Be in the Top-Left USB Port 
The Connect software only looks for the Bluetooth/WiFi dongle on the top-left USB port of the 
cradle. If you plug it into any other port, the system will not pair sensors, will not connect to the 
Spotman receiver over Bluetooth, will not see Wi-Fi networks, and will not allow remote access. If 
anything stops working unexpectedly, this is the first thing to check. 
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Step-by-Step: Connecting the Control Box to the Cradle 

1 
Confirm the BT/WiFi dongle is firmly seated in the top-left USB port. 
Push it in until it stops. A loose dongle is a common source of intermittent sensor drop-outs. 

 

2 
Connect the LED Bargraph cable to any open USB port on the cradle. 
Not the top-left port — that is reserved for the dongle. Any other USB port works. 

 

3 
Connect the cradle power cable to the machine's 12V or 24V outlet. 
Most operators tap the standard accessory outlet in the cab. The Connect system accepts 
12V or 24V. 

 

4 

Slide the Control Box (BT142) into the cradle. 
The BT142 has alignment features that match the cradle. It should seat firmly without 
forcing. Confirm it is held securely; you should not be able to pull it loose with light hand 
pressure. 

 

5 
Verify the LED Bargraph is plugged in correctly. 
The BT445 LED Display sits in the CT149 cradle on the front window. Its cable should run 
cleanly back to the BT447 cradle. 

 

6 

Do not power on yet. 
If you are also installing sensors at the same time, complete the sensor plate installation first 
(Volume 2). If you are only doing initial software setup at the bench, you can proceed to 
Section 05 to power on. 

 
 
 

Real-World Example: Setting Up a CT741 Kit on a CAT 320 for the First Time 
On a typical CAT 320 cab: mount the CT149 LED cradle on the front window, low and to the right 
side so the operator can see cut/fill while looking at the bucket. Mount the BT447 cradle on the 
right-side sliding window, in the front portion (closer to the operator) so the touch screen falls 
naturally to the right hand. Tap the cab's standard 12V accessory outlet for cradle power. Run the 
LED cable along the top of the dash, dropping down behind the right-side B-pillar trim to the BT447 
cradle. Total install time at the bench: 15–20 minutes. 
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05  Powering On for the First Time 

With the cradle mounted and the Control Box seated, you are ready to power on. The first power-on takes 
you through two short tasks: choosing your language and your time zone, and setting your units of 
measure. This section walks through each one. Sensor pairing, machine profile creation, and the actual 
machine calibration come later (Volume 2 for installation, Volume 4 for calibration). 

First Boot — What to Expect 
Apply power to the cradle. The Control Box will boot in about 30 to 45 seconds and display the iDig 
Connect main work screen on its first power-on. From the work screen, tap the screen to bring up the side 
toolbars and tap the Settings icon to enter the Settings menu. The Settings menu is your home base for 
everything in this section. 

Settings Menu Section What You Configure Here 

Basic Settings Language, time zone, units, sound, sensors, GNSS receiver, 
storage, brightness, sleep mode, Restrictive Mode. 

System Settings Machine profiles — create, select, edit, and back up the calibrated 
machines on this Control Box. 

Work Settings LED Bargraph configuration (resolution, deadband, depth/reach 
modes), audible alerts (depth, reach, laser catch, sensor loss, 
collision). 

Remote Access Wi-Fi connection, sending a remote-support session link by email. 

Import/Export License manager (apply purchased .lic files), backup/restore 
machine parameters, import projects, factory reset. 

Software Update USB-based updates, Remote Update over Wi-Fi, sensor firmware 
updates, coordinate-system downloads. 

 

Step-by-Step: Initial Language, Time Zone, and Units 

1 
From the work screen, tap to bring up the toolbars and tap Settings. 
The four-tile main Settings menu opens with Basic Settings, System Settings, Work Settings, 
and Remote Access. 

 

2 
Tap Basic Settings. 
The Basic Settings screen opens, organized into Global, Sensors, and Other groups. 

 

3 
Tap Languages. 
The Choose Your Language screen displays national flags. Tap the flag for your preferred 
language. North American users select English. 
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4 

Set your time zone. 
Inside the Languages screen there is a Choose Time Zone option. For US operations, scroll 
to America/Denver, America/Chicago, America/Los_Angeles, America/New_York, etc., to 
match your local time. 

 

5 
Tap Units. 
The Choose Your Units screen opens. This is the most important first-time setting — it must 
match your project. 

 

6 

Set Length Units. 
For US construction work, choose US Survey Feet (most state plane projects, most US civil 
engineering designs). Choose Imperial (decimal feet) only if your project specifically calls for 
International Feet — confirm with your project engineer if unsure. Metric is also available. 

 

7 
Set Slope Units. 
Most US construction work uses Percent (%). Some highway and rail projects use degrees 
or per-mille. Match your design documents. 

 

8 
Set Heading Convention. 
Degrees is standard for US construction. Match your project. 

 

9 

Set Coordinate Convention. 
For US construction work, set this to North / East / Elevation. This matches the convention 
used by surveyors and most civil engineering output, including iPoint. Confirm with your 
project engineer if the design documents specify a different convention. 

 

10 
Exit back to the Basic Settings menu. 
Your language, time zone, and unit settings are now active. They persist across reboots. 

 
 
 

Critical: Match Your Units to Your Project Before Calibrating 
Length Units affect every measurement the system displays — depth, reach, slope distance, 
coordinates, calibration values. If you calibrate the machine in meters and then switch to US Survey 
Feet, the on-screen values change but the underlying calibration is unchanged. The unit setting 
drives interpretation, not the data. Get this set correctly before you begin calibration in Volume 4. 
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06  Licensing & Activation 

iDig Connect uses two kinds of software licenses. Tier licenses (CT150 for 2D Project, CT151 for 3D, 
CT137 for 3D Lite to 3D upgrade) determine what the system can do — whether it can import 3D designs, 
how many projects it can store, whether the 3D view is unlocked. Feature licenses (CT145 Swing Boom, 
CT155 Dynamic Laser Catch) unlock specific advanced operating features in Connect v5 software. 

Both feature licenses ship with a 120-day free trial activated by tapping a single button inside the License 
Manager. After the trial ends, a perpetual license is applied by importing a .lic file — a small license file 
your dealer sends you that is tied to your specific Control Box serial number. 

Where Licenses Live 

License management lives under Settings > Import/Export > License Manager. From this screen you can 
see what is currently licensed, activate the 120-day trials, and import a .lic file from a USB stick. 

Step-by-Step: Activating a 120-Day Trial 

1 

From the Settings menu, tap Import/Export. 
The Backup / Restore Machine Parameters screen opens, displaying tiles for machine 
import/export, project import/export, language import, manufacturer import, boot screen, and 
License Manager. 

 

2 
Tap License Manager. 
The License Manager screen opens, showing the licenses available on this Control Box and 
their status. 

 

3 
Locate the feature you want to trial — Swing Boom or Dynamic Laser Catch. 
Each licensable feature shows an activation icon. If a trial has not been activated, the icon is 
the trial-start icon. If it is already active, the screen shows how many days remain in the trial. 

 

4 
Tap the trial-activation icon for the feature. 
The system activates a 120-day trial for that feature. The trial is one-time-only per Control 
Box — you cannot reset it. 

 

5 
Verify the trial is active. 
Return to the License Manager screen and confirm the feature now shows trial days 
remaining. The feature is immediately available for use. 
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Best Practice: Activate Both Trials On Day One 
Both Swing Boom and Dynamic Laser Catch ship with their own 120-day trial. There is no penalty 
for activating both trials on the day you receive the system, even if you don't plan to use one of 
them right away. Operators who get hands-on experience with these features during the trial are far 
more likely to find them valuable enough to license. Activate both, try both, and decide before the 
clock runs out. 

Step-by-Step: Applying a Perpetual License 

When you purchase a perpetual feature license or a tier upgrade, your iDig dealer emails you a .lic file — 
a small text file generated for your specific Control Box serial number. To apply it, copy the file to a USB 
stick, plug it into the cradle, and import it from the License Manager screen. 

1 
Save the .lic file to the root directory of a USB stick. 
Do not put it in a folder. iDig Connect looks for license files at the root of the USB drive. The 
USB does not need to be empty — other files can coexist with the .lic file. 

 

2 
With the Control Box powered on, plug the USB stick into the cradle. 
Any open USB port works for importing licenses. The dongle remains in the top-left port. 

 

3 
Open Settings > Import/Export > License Manager. 
You should already know this menu path from activating a trial. 

 

4 
Tap Import License. 
The system reads the USB stick and looks for .lic files. 

 

5 

Select your .lic file from the file browser. 
If the .lic file's serial number matches the Control Box, the import succeeds and the feature is 
activated permanently. If the serials do not match, the import fails — contact your dealer for a 
replacement license. 

 

6 
Verify the license shows as active. 
Return to the License Manager screen. The licensed feature now shows as Active 
(perpetual) rather than Trial (days remaining). 

 

7 
Remove the USB stick safely. 
Use the Remove USB option from the Import/Export screen rather than yanking the stick. 
This prevents data corruption if the system was mid-write. 

 
 

iDig North America  |  Page 21 



iDig Connect User Guide 

 
Critical: License Files Are Tied to a Specific Control Box 
Each .lic file is generated for one Control Box serial number. You cannot use the same .lic file on a 
different Control Box, and you cannot move a license to a different Control Box without contacting 
iDig dealer support to issue a replacement file. Find the Control Box serial number at the bottom-left 
of the Settings menu screen (it appears as CB######). Always verify your dealer has the correct 
serial number before purchasing a license. 

 

 
Real-World Tip: Where the Control Box Serial Number Lives 
The serial number appears as a small text string near the bottom-left edge of the main Settings 
screen, in the format CBXXXXXX (e.g., CB202063). The same serial number is also etched into the 
back of the Control Box. Take a photo of the back of the Control Box on day one and save it to your 
phone — it makes ordering replacement licenses, warranty service, or remote support much faster. 
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07  Software Updates — USB & Remote 

iDig Connect software updates come out periodically with new features, bug fixes, and added support for 
new sensors and tiltrotators. There are two ways to apply an update: via USB stick (works without an 
internet connection — best for updating multiple machines or when Wi-Fi is unavailable) and via Remote 
Update over Wi-Fi (single-click, but requires the Control Box to be connected to the internet). 

Both methods can also update sensor firmware (boom, stick, bucket, chassis sensors) and download 
additional coordinate systems on demand. Sensor firmware updates and coordinate system downloads 
only work over Remote Update; USB updates only update the Control Box itself. 

 
Critical: Major Version Upgrades Can Affect Calibration 
Some software updates change how the Control Box reads a sensor or introduce new sensor types. 
Before applying any major version upgrade (anything that changes the first number, e.g., 4.x to 5.x), 
read Section 08 of this volume for background on the chassis sensor transition. Plan to back up 
your machine calibration first (Volume 4 Section 25) and budget time to verify or redo calibration 
after the update. 

Method 1: USB Software Update 

USB updates work in any environment — no internet required. The procedure has three parts: prepare 
the USB stick, copy the firmware files, and run the update on the Control Box. 

Step-by-Step: Prepare the USB Stick 

1 
Plug a USB stick into your PC. 
Any USB stick at least 1 GB in size works. The stick will be erased in the next step, so don't 
use one with files you need. 

 

2 
Right-click the USB drive in File Explorer and choose Format. 
On Windows: open File Explorer, find the USB drive in the left sidebar, right-click, and select 
Format. 

 

3 

Set File System to FAT32 and click Start. 
iDig Connect only reads FAT32-formatted USB drives. NTFS and exFAT will not be detected. 
Confirm the format dialog warning — formatting deletes everything on the drive. Click Start, 
wait for the format to complete, and click Close. 

 
 

Step-by-Step: Download and Copy the Firmware 

1 
Open a web browser on your PC. 
Chrome, Edge, Firefox, or Safari all work. You will need an internet connection here, but the 
Control Box does not. 
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2 
Navigate to the iDig Connect firmware folder. 
Open iDig Connect Firmware Downloads in your browser. The folder lists every released 
firmware version. 

 

3 

Locate the latest firmware folder. 
The folder is named with the version number (for example, iDigConnectFirmware_v5.x.x). 
The latest version is at the top. If you are unsure which version to download, contact your 
iDig dealer. 

 

4 
Download the firmware as a compressed (.zip) folder. 
Most browsers will download the entire folder as a single .zip file. The download is 
approximately 350 MB and may take a few minutes depending on your connection. 

 

5 

Extract the .zip file. 
Right-click the downloaded .zip in your Downloads folder and choose Extract All. Click 
Extract in the dialog. You will now have a folder containing several files (appli.gup..., 
rootfs.gup..., u-boot..., updater..., zImage, and a .dtb file). 

 

6 

Copy all the extracted files to the root of the FAT32-formatted USB stick. 
Open the extracted folder and the USB stick side-by-side. Select all files (Ctrl+A) and drag 
them onto the USB stick. The files must be at the ROOT of the USB drive — not inside a 
subfolder. The USB drive should look like a flat list of files when you open it. 

 

7 
Safely eject the USB stick. 
Use the eject option in your PC's taskbar to ensure all files have finished writing before 
unplugging. 

 
 

Step-by-Step: Run the Update on the Control Box 

1 
Power the Control Box OFF. 
The USB update process only runs at boot. If the Control Box is on, the USB stick is ignored. 
Power off completely before continuing. 

 

2 
Insert the USB stick into any open USB port on the cradle. 
The BT/WiFi dongle can remain in the top-left port — you do not need to remove it for the 
update. The update USB stick can go into any of the other available USB ports on the cradle. 
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3 
Power the Control Box ON. 
The system boots, detects the firmware files on the USB stick, and begins the update 
automatically. You will see update progress on the screen. 

 

4 
Wait for the update to complete. 
The full update typically takes 5 to 10 minutes. The Control Box will reboot one or more 
times during the process. 

 

5 
When the update finishes, power off and remove the USB stick. 
Power on normally and verify the new version number at the bottom-left of the main Settings 
screen. 

 
 
 

Critical: Do Not Interrupt Power During the Update 
Do not unplug power, cycle the machine's ignition, or remove the USB stick while the update is in 
progress. An interrupted firmware update can leave the Control Box in a state that requires a 
service-level recovery. Ensure the machine is running (or the Control Box is on stable shop power) 
before starting, and let the full update finish before touching anything. 

 

 
Common Mistake: USB Update Doesn't Start 
If you power on and the update doesn't run, the most likely cause is one of two things: (1) the USB 
is not formatted FAT32, or (2) the firmware files are inside a folder rather than at the root of the 
drive. Reformat the USB to FAT32, place the files at the root, power off, insert the USB, and power 
on. 

Method 2: Remote Update over Wi-Fi 
Remote Update is built into Connect v5.x.x and is the standard way to keep your system current. It 
downloads and installs new Control Box firmware, sensor firmware, and coordinate systems directly over 
Wi-Fi. The Control Box must be connected to a Wi-Fi network with internet access (a job-trailer hotspot, a 
cellular hotspot, or your shop Wi-Fi all work). 

Step-by-Step: Update the Control Box via Remote Update 

1 
Connect the Control Box to Wi-Fi. 
Settings > Remote Access. Tap the Wi-Fi network from the Known WiFi list, or tap Other to 
add a new network. Enter the network password. A green check appears when connected. 

 

2 
From the Settings menu, tap Software Update. 
The Software Update icon shows a small green badge with a number when updates are 
available. 
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3 

Tap Check. 
The Control Box queries the iDig server for the latest updates. Any new Control Box 
firmware, sensor firmware, or coordinate-system packages available for your system will 
populate the list. Always tap Check before reviewing what is available — it makes sure you 
are seeing the most current releases. 

 

4 
The Remote Software Update screen opens with four tabs. 
Release Notes (what changed in each version), CBox (Control Box firmware), Peripherals 
(sensor firmware), and Coordinate systems (regional coordinate system files). 

 

5 
Tap the CBox tab. 
A list of available Control Box firmware versions appears, with the latest at the top. 

 

6 
Highlight the latest release so it is highlighted blue, then tap Download Update. 
The Control Box downloads the firmware in the background. You can leave the screen during 
the download. 

 

7 
When the download completes, choose the same version again and tap Install Update. 
The Control Box stages the new firmware for installation. 

 

8 

Tap Update the Control Box. 
The Control Box reboots and installs the new firmware. When it comes back up, the new 
version is active. Verify by checking the version string at the bottom-left of the main Settings 
screen. 

 
 

Step-by-Step: Update Sensor Firmware 

1 
Open Settings > Software Update and tap the Peripherals tab. 
The Peripherals tab lists every paired sensor (boom, stick, bucket, chassis) and the firmware 
version it is currently running. 

 

2 
Highlight the sensor you want to update. 
If an update is available for that sensor, the action button shows Download and Install. If the 
sensor is current, you will see a green checkmark and no action available. 

 

3 

Tap Download and Install. 
The Control Box downloads the new sensor firmware over Wi-Fi and pushes it to the sensor 
over Bluetooth. Keep the sensor within Bluetooth range of the cradle (i.e., installed on the 
machine — do not pull the sensor off mid-update). 

iDig North America  |  Page 26 



iDig Connect User Guide 

 

4 
Wait for the green checkmark. 
When the update completes, the sensor shows a green checkmark and the new version 
number. Repeat for each sensor that needs an update. 

 
 
 

Real-World Tip: Sensor Firmware Updates Need Charged Sensors 
Wireless sensors are solar-recharged, but if a sensor has been stored indoors and shows low 
battery, give it a few hours of direct sunlight before attempting a firmware update. A sensor that 
loses power partway through an update is fine — the old firmware remains intact and you can 
simply retry — but you waste 5 to 10 minutes per attempt. Charge first, update second. 

Step-by-Step: Download Coordinate Systems 

1 

Open Settings > Software Update and tap the Coordinate systems tab. 
The Coordinate systems tab lists every coordinate-system package available for download. 
For North American work, look for USA_NAD83-2011 (US State Plane), 
Canada_NAD83-CSRS (Canadian Spatial Reference System), and any other regional 
packages relevant to your work area. 

 

2 
Highlight the coordinate system you need. 
The system shows the file size and last-update date. US_NAD83-2011 is approximately 27 
MB. 

 

3 
Tap Download and Install. 
The package downloads and installs. When complete, the coordinate system is available 
when creating new projects (Volume 7). 

 

4 
Repeat for any additional regions you need. 
If you operate across multiple regions, download each one. Coordinate systems do not 
consume meaningful disk space, so installing several is fine. 

 
 
 

Best Practice: Check for Updates Once a Month 
Make a habit of opening Settings > Software Update and tapping Check at least once a month. 
Software updates contain bug fixes, performance improvements, and new features that you are 
entitled to as part of your Connect system. Staying current takes only a few minutes and keeps you 
on the latest release iDig has published. 
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08  A Note on the Chassis Sensor Transition 

All current iDig Connect systems ship with Connect v5.x.x software and the BT476 chassis sensor. If that 
describes your system — a new kit received from your dealer in the current shipment window — you can 
read this section for background and then move on; there is nothing you need to do differently. 

This section exists because the chassis sensor changed a few years ago, and some existing equipment 
in the field still uses the older part. If you are servicing an older machine, swapping a Control Box 
between machines, or inherited equipment from a previous owner, the background here will help you 
recognize what you are looking at. 

What Changed 

The original 2D chassis sensor was the XD476, sometimes called the "Larger 2D Sensor." It was a fully 
cabled sensor — both power and measurement data ran through the cable — and it had to be mounted 
flat with its arrows pointing forward, parallel to the boom. 

The current chassis sensor is the BT476, the "Combo Chassis Sensor." It is still wired for power (through 
the CT425C Y-shielded cable from the cradle), but its measurement data travels over Bluetooth. This 
architecture gives the BT476 much more flexibility — it can be mounted in any orientation when paired 
with a tilted calibration procedure — and it performs significantly better than the original cabled sensor. 

 
Real-World Tip: How to Tell Which Chassis Sensor You Have 
Look at the sensor body. The XD476 (the "Larger 2D Sensor") is physically larger and has a single 
cable. The BT476 (the "Combo Chassis Sensor") is more compact, has both a Bluetooth radio and 
a power cable, and looks similar to the wireless Mini Sensors used on the boom and bucket. The 
product label on the back lists the part number. If the label is worn, the BT476 will pair via Bluetooth 
in the Wireless Sensors menu; the XD476 will not. 

What This Means for New Installations 

For new installations using a current kit, the story is simple. Install the BT476 per Volume 2, pair it over 
Bluetooth, and calibrate it per Volume 4. Your system is already on v5.x.x and the chassis sensor is 
already the current part — there is no migration, no upgrade path to plan, and no legacy behavior to work 
around. 

What This Means for Older Systems 

If you encounter an older system still running the XD476 chassis sensor, a software upgrade to v5.x.x will 
require swapping the XD476 for a BT476 and redoing the chassis calibration. Contact your iDig dealer to 
plan the swap and the software upgrade together — it is not a field upgrade you should attempt without 
the replacement sensor already on hand. 

[REVIEW: Volume 4's chassis sensor calibration procedure is where the full tilted/non-tilted calibration 
steps live. Confirm cross-reference is correct before final compilation.] 
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09  Remote Access & Support 

iDig Connect has a built-in Remote Access feature that lets your iDig dealer or support team see your 
Control Box screen and walk you through configuration, calibration, or troubleshooting in real time. The 
session runs over the same Wi-Fi connection used for Remote Update. The remote viewer cannot 
connect without an active invitation that you generate from the cab. 

How Remote Access Works 

When you start a Remote Access session, the Control Box generates a unique link and sends it by email 
to the address you specify. The recipient clicks the link in their email, presses Connect in the browser 
window that opens, and immediately sees a live view of your Control Box screen. The session is 
one-to-one: only the recipient with the unique link can connect, and the link is invalidated when the 
session ends. There is no public address for the Control Box. 

 
Critical: You Initiate Every Remote Access Session 
There is no way for someone to remotely connect to your Control Box without you starting the 
session and emailing the link. Even iDig dealer support cannot initiate the connection from their end. 
This is by design — it ensures you always know when someone is viewing your screen. If you ever 
want to end a session, simply disconnect from Wi-Fi or exit the Remote Access screen. 

Step-by-Step: Connecting the Control Box to Wi-Fi 

1 
From the Settings menu, tap Remote Access. 
The Remote Access screen opens. The left side shows Wi-Fi network selection; the right 
side shows the active connection status. 

 

2 
Tap the Known WiFi tab to see networks the Control Box has connected to before. 
If you have previously connected to a network, it appears here for one-tap reconnection. 

 

3 
For a new network, tap the Other tab (the + icon). 
A list of nearby Wi-Fi networks appears. 

 

4 
Tap the network you want to join. 
A keyboard appears for the password. 

 

5 

Enter the Wi-Fi password and confirm. 
The Control Box attempts to connect. When connected, a green checkmark appears next to 
the network name and the right side of the screen shows the assigned IP address (e.g., 
10.0.0.101) and the word Connected. 
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Step-by-Step: Starting a Remote Support Session 

Once the Control Box is connected to Wi-Fi, starting a remote support session takes about 30 seconds. 
You have two ways to share the session with your dealer: by email or by QR code. 

1 
With the Control Box connected to Wi-Fi, tap Get Support on the Remote Access 
screen. 
The Control Box generates a unique session link and opens the sharing options. 

 

2 

Choose how to share the session — Mail to or QR Code. 
Tap Mail to if your dealer is not present and you need to send them the link by email. Tap QR 
Code if you are working with a dealer who can scan a code on-screen (common when the 
dealer is on the phone with you and has another device handy). 

 

3 
For Mail to: enter the email address of your dealer support contact and tap Send. 
The Control Box emails the unique session link to the address you entered. Use the address 
your dealer provided — most dealers have a dedicated support address. 

 

4 
For QR Code: hold the Control Box screen up so your dealer can scan it. 
The Control Box displays the QR code containing the session link. Your dealer scans the 
code with their phone or tablet camera, which opens the session link automatically. 

 

5 

Wait for the recipient to connect. 
The Remote Access screen shows the session as active and displays a session ID. When 
your dealer opens the link (either from the email or the scanned QR code) and presses 
Connect, the live view of your Control Box screen begins on their end. 

 

6 

Stay on the Remote Access screen during the session, or navigate normally. 
You can navigate iDig Connect during the session — the remote viewer sees what you see 
in real time. Most support sessions involve the operator and the dealer talking through the 
work over the phone while both look at the same screen. 

 

7 
When the session is done, tap Disconnect. 
The session ends and the link is invalidated. 
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Real-World Tip: Use Your Phone as a Wi-Fi Hotspot 
On a jobsite without Wi-Fi, turn on your phone's Personal Hotspot and connect the Control Box to it. 
The Control Box uses very little bandwidth for Remote Access — even a marginal cellular signal is 
usually enough. This is the most common setup for in-cab remote support: the operator connects 
the Control Box to their own phone hotspot, then calls dealer support and either emails the session 
link or shows them the QR code from the cab. 

 

 
Best Practice: Pre-Test Remote Access Before You Need It 
Before you ever have a real problem in the field, test the Remote Access workflow at the shop: 
connect to Wi-Fi, tap Get Support, and send a session link to your own email or your dealer (with a 
heads-up that this is a test). Confirm the connection works. Having validated the workflow once 
means you are not learning two new things at once when you have an actual problem to solve. 
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10  Cloud File Access Configuration 

Cloud File Access lets the Control Box read directly from your existing Google Drive, Dropbox, OneDrive, 
or other cloud storage account. Once configured, your cloud appears as a folder during file import 
operations — load a DXF design from Drive, pull down a coordinate file from Dropbox, or grab a project 
backup that someone in the office shared to your shared OneDrive folder. There is no separate iDig cloud 
subscription; the system uses your existing cloud account. 

 
Before You Start 
You will need: an existing cloud account (Google Drive, Dropbox, OneDrive, or another supported 
provider), an Android phone or tablet with internet access (yours or anyone's — the configuration is 
one-time), and a USB stick. The Control Box itself does not need to be connected to Wi-Fi while you 
set up the configuration file, but it does need to be online when you actually browse the cloud later. 

How It Works 

Cloud File Access uses an open-source application called RCX Clone, which runs on Android. RCX 
Clone authenticates to your cloud account, generates a small configuration file (with a .RCX extension) 
that contains the access tokens, and lets you export that file to a USB stick. You then import the .RCX file 
into iDig Connect, and the Control Box uses it to talk to your cloud. 

The big advantages: no monthly cloud fee, your existing folder structure works as-is, and configuration is 
portable — you can move your .RCX file to another Control Box and immediately have the same cloud 
access there. The trade-off: cloud access tokens occasionally expire (typical for cloud providers), and 
when they do you re-authenticate in RCX Clone and re-export a fresh .RCX file. 

Step-by-Step: Install RCX Clone on Android 

RCX Clone is no longer distributed through the Google Play Store. iDig hosts the current APK installer on 
Google Drive so you can install it directly on any Android device. 

1 

On an Android phone or tablet, open a web browser. 
Any Android device works for this — your personal phone, an iDig field tablet, or a borrowed 
device. The .RCX file the device produces will work on the Control Box regardless of which 
device created it. 

 

2 
Navigate to the RCX Clone download folder. 
Open RCX Clone Download in your browser and tap the APK file to download it. 

 

3 

Allow the download and install when prompted. 
Because the APK is installed outside the Play Store, Android will show a security prompt 
asking whether to allow installation from this source. Tap Settings, enable "Allow from this 
source" for your browser, then tap Back and tap Install. This is a one-time permission. 

 

4 
Open RCX Clone. 
When installation completes, tap Open to launch the app. RCX Clone opens to a near-empty 
main screen with a + button to add a cloud connection. 
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Step-by-Step: Add Your Cloud Account in RCX Clone 

1 
In RCX Clone, tap the + button. 
A list of cloud providers appears (Google Drive, Dropbox, OneDrive, Box, and others). 

 

2 
Choose your provider and tap Next. 
RCX Clone walks you through the provider's standard sign-in flow — the same login you use 
in a web browser. 

 

3 
Sign in to your cloud account. 
Enter your email and password. If your cloud account uses two-factor authentication, 
complete it as you normally would. 

 

4 
Grant RCX Clone permission to access your account. 
The cloud provider's standard authorization screen appears. Read the permissions, then tap 
Allow or Authorize. 

 

5 

Verify the cloud appears in the RCX Clone list. 
Your cloud account now appears in RCX Clone with the name you assigned (e.g., "iDig" or 
"Company Drive"). You can navigate the folder structure inside RCX Clone to confirm the 
connection works. 

 
 

Step-by-Step: Export the .RCX Configuration File 

1 
In RCX Clone, tap the menu button (typically three dots in the top-right). 
The application menu opens. 

 

2 
Select Export rclone config. 
RCX Clone packages the cloud configuration into an .RCX file. 

 

3 

Save the file to a USB stick. 
Plug a USB stick into the Android device (or use a USB-C OTG adapter if needed). When 
prompted for a save location, choose the USB drive. The file should land at the root of the 
USB drive — not inside a folder. 
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4 
Safely eject the USB stick from the Android device. 
Use the device's standard USB eject. The .RCX file is now on the USB and ready to load into 
the Control Box. 

 
 
 

Real-World Tip: One Cloud Account Can Serve Many Control Boxes 
If you operate a fleet of machines, you only need to do the RCX Clone setup once. Take the .RCX 
file from the first Control Box and import it into every other Connect Control Box you operate. They 
will all see the same cloud folders. When the cloud token eventually expires, re-authenticate once in 
RCX Clone, export a fresh .RCX, and load it on every Control Box. 

Step-by-Step: Import the .RCX File into iDig Connect 

1 
Power on the Control Box and connect to Wi-Fi. 
The Control Box must be online to load the cloud configuration and browse cloud files. 
Settings > Remote Access > join your Wi-Fi network. Verify the green check. 

 

2 
Plug the USB stick (containing your .RCX file) into the cradle. 
Any open USB port works. Keep the BT/WiFi dongle in the top-left port. 

 

3 
From the Settings menu, tap Basic Settings. 
The Basic Settings menu opens. 

 

4 
Tap Storage. 
The Storage info screen opens with two tabs at the top: Cloud Folders and Disk Usage. 

 

5 
Tap the Cloud Folders tab. 
The Cloud Folders screen lists any cloud connections already configured. On a fresh 
system, the list is empty. 

 

6 
Tap Import. 
The Control Box reads the USB stick and looks for .RCX files. 

 

7 
Select your .RCX file from the file browser. 
The cloud configuration is imported and your cloud account appears in the Cloud Folders list 
(e.g., "iDig Cloud"). 
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8 
Verify the import. 
The Internet Connection Status indicator at the bottom-left of the Storage screen should 
show a green checkmark, indicating the cloud connection is active. 

 
 

Using Cloud Folders During File Import 
Once the .RCX file is imported, your cloud folders appear automatically in the file browser any time you 
import data into iDig Connect — for example, when importing a DXF design file (Volume 7), loading a 
project, or pulling in a calibration backup. The cloud folders show up alongside USB and local storage in 
the file directory, and you navigate them the same way you would on a phone or computer. 

 
Cloud Tokens Can Expire 
Cloud providers occasionally invalidate access tokens — most often after long periods of inactivity, 
after a password change, or as part of routine security policy. If you suddenly cannot see files you 
used to see, the token has likely expired. Open RCX Clone on your Android device, re-authenticate 
to the cloud provider, export a fresh .RCX file to USB, and re-import it into iDig Connect. The 
procedure is identical to the initial setup. 

 

 
Best Practice: Organize a Dedicated iDig Folder in Your Cloud 
Before you import the .RCX file, create a clearly-named folder in your cloud account (e.g., "iDig 
Field Files" in Google Drive). Use it as the central drop-zone for design files, project backups, and 
calibration backups going to and from the field. A clean, single-purpose folder is much easier for 
operators to navigate from the cab than your full personal Drive root with hundreds of unrelated 
folders. 
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11  What's Next 

You have now completed everything that needs to happen at the shop or bench before going to the 
machine. Your Control Box is mounted in its cradle, language, time zone, and units are configured, your 
licenses are activated (or your trials are running), the Control Box is on the latest software, and your cloud 
account is connected for easy file transfer. You can also reach iDig dealer support remotely whenever you 
need help. 

Volume 2: Hardware Installation 

Volume 2 is the installer's volume. It walks through the pre-installation checklist (tools, machine condition, 
site requirements), the 3M adhesive procedure for mounting sensor plates, the specific installation 
requirements for boom, stick, bucket, and chassis sensors, GNSS receiver mounting on the cab roof, LED 
Bargraph and CBox positioning on the cab windows, CAN-bus wiring for tiltrotators, and the boom-type 
and attachment-type configuration choices. By the end of Volume 2, every sensor plate is installed in the 
correct location on the machine and every cable is routed cleanly. 

Volume 3: GNSS Receiver Configuration 

Volume 3 covers the Spotman GNSS receiver: how RTK GNSS works (the 60-second version), 
connecting to the Spotman WebUI, configuring NMEA outputs over Bluetooth, setting up NTRIP 
corrections through a SIM card or radio, the supported radio protocols, and pairing the Spotman to the 
iDig Control Box. If you purchased a 2D Project or 3D system (or added a Spotman to a 2D+ system), 
you will need Volume 3 before doing the 3D portion of calibration in Volume 4. 

Volume 4: Machine Calibration 

Volume 4 is the longest and most critical volume. It covers the full calibration sequence in the correct 
order — cradle configuration, GNSS NMEA pairing, boom and stick wizard calibration, bucket calibration, 
swing boom (if licensed), chassis sensor calibration for the BT476, GNSS 3D calibration, laser receiver 
calibration, tiltrotator calibration if equipped, and the post-calibration accuracy checks. Volume 4 ends 
with backing up the completed machine calibration to USB so it can be restored or shared. 

Need Help? 

Contact your iDig dealer for assistance with installation, licensing, calibration, or general support. For 
real-time support, use the Remote Access feature described in Section 09 of this volume — it lets your 
dealer see your screen while you talk through the issue together.  
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01  Pre-Installation Checklist 

Volume 2 picks up where Volume 1 ended. The Control Box is licensed and on the latest software; the 
cradle, LED Bargraph, and BT/WiFi dongle are in the cab; and the sensors are ready to come out of the 
foam-lined case. Volume 2 is the physical installation on the machine — the sensor plates go on the 
boom, stick, bucket, and cab frame; the GNSS receiver goes on the cab roof; and, if equipped, a tiltrotator 
is wired into the Control Box over CAN bus. 

A successful installation starts with the right tools, a machine that is ready to receive the system, and a 
site where you can actually finish the work. Cut corners here and you will end up re-doing steps later — 
often the hard way, with the sensor plates already installed and the machine already on the jobsite. 

Tools You Will Need 

Tool What You Use It For 

Tape Measure Measuring bucket dimensions, the A–C value for the stick sensor, and 
testing accuracy after calibration is completed. 

Magnetic Plumb Bob Dropping a vertical reference line on the stick. Combined with magnetic 
hooks and a string line, this is how you create a reference line between 
the boom-to-dipper pin and the bucket pivot pin for stick sensor 
placement.  Also used for completing the manual bucket calibration 
procedure. 

String Line Running between the boom-to-dipper pivot pin and the bucket pivot pin to 
create a straight reference line for stick sensor placement and for 
measuring the A–C value. 

Sharpie Marker Marking sensor plate positions on the machine before committing the 3M 
adhesive. Also used to mark the center of the bucket for the GNSS 
calibration in Volume 4. 

Magnetic Hooks Holding the string line and plumb bob in place while you take 
measurements. Strong enough to hold during a light breeze. 

Clean Rags For the surface prep wipe-down. Use fresh rags, not shop rags that may 
have grease or solvent on them. 

Brake Cleaning Fluid First-pass cleaner for the machine surface before the alcohol wipe. 
Removes hydraulic residue, grease, and dust. 

Alcohol Wipes (XD417) Included in every sensor plate kit. Final surface prep before the 3M 
adhesive. 

Tripod Hold’s the laser pointer during the boom and stick wizard calibration in 
Volume 4. 

2-Meter Grade Rod Used during the GNSS 3D calibration in Volume 4 — the operator screws 
the Spotman receiver onto the rod and measures reference points on the 
ground.  
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Tool What You Use It For 

Four Flat Cement 
Pavers 

Needed if calibrating on a dirt or gravel surface. During the GNSS 3D 
calibration, the operator places the bucket on a paver to mark the center 
of the bucket tooth, then returns to that exact mark with the Spotman on 
the 2-meter rod. On a hard paved surface, pavers are not needed — the 
crow's foot is marked directly on the pavement. 

 

Machine Condition Checks 

Before you install anything, confirm the machine itself is in shape to receive a machine-guidance system. 
A worn machine with loose pins, hydraulic leaks, or a flaky 12V/24V accessory outlet will produce 
unreliable guidance after calibration, and chasing those symptoms through the software is a waste of your 
time. 

Check What to Look For 

Sensors and GNSS 
Receiver Charged 

All wireless sensors should show battery life. If any sensor has been 
stored indoors for a long period, give it several hours of sunlight before 
starting installation. 

Machine 12V/24V Outlet 
Works 

Plug something simple (like a phone charger) into the accessory outlet 
the cradle will use. Confirm it powers on reliably. A flaky outlet is the 
most common cause of intermittent Control Box reboots. 

No Hydraulic Leaks on 
Stick or Boom 

Hydraulic fluid will destroy the adhesive bond on a sensor plate. Fix 
leaks before installing sensors — not after. 

Pin Play Within Spec Excessive play at the boom, stick, or bucket pins produces noise in the 
calibration and in daily operation. If the machine is due for pin 
bushings, do that work first. 

Bucket Crush-Zone Check Cycle the bucket through its full range of motion and identify crush 
points where a sensor plate could be damaged. You will need this 
awareness when choosing the bucket sensor location (Section 05). 

 

Site Requirements for Installation and Calibration 

It may be easier to install the sensor plates inside your shop.   For the calibration - the installer needs 
room and a specific kind of surface to achieve a quality calibration. 

•​ Full 360° cab rotation clearance — the cab must be able to rotate a full circle without obstruction 
during calibration. 

•​ Full boom, stick, and bucket extension clearance — calibration requires the operator to fully extend 
the machine. Confirm there are no overhead wires, fences, or structures in the way. 

•​ Firm, level ground — a hard paved surface is strongly recommended. If you are calibrating on dirt 
or gravel, bring four flat cement pavers to use as reference surfaces during the GNSS 3D 
calibration — the operator marks the center of the bucket tooth on each paver, then returns to 
measure those exact spots with the Spotman on the 2-meter rod. 

•​ Side-to-side level — the machine must be level side-to-side for accurate boom and stick calibration. 
Slight forward or backward tilt is acceptable. 
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Critical: Plan for the 4-Degree Machine Tilt 
The recommended chassis-sensor calibration method requires tilting the machine at least 4°. Plan 
where this will happen before you start installation. If you have a blade, you can extend it fully down 
to tilt the machine. You can also position the machine on native ground that meets the 4° 
requirement. The key is that the machine must remain completely stable and not rock during 
calibration — avoid soft ground or unstable supports. See Volume 4 for the full calibration 
procedure. 

 

 
Real-World Tip: Finish Sensor Plate Installation at the Shop 
If you have the choice, install the sensor plates at the shop rather than on the jobsite. The adhesive 
needs a clean, dry, warm-ish surface, and the machine needs to sit undisturbed for the adhesive to 
set. A climate-controlled shop or a covered yard on a dry day is ideal. An outdoor jobsite in rain, 
snow, or extreme cold makes a hard job harder.  If you must install outside - and in weather below 
40 degrees it’s recommended to warm up the steel with a heat gun where the plates will go. 
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02  Sensor Plate Installation — General Procedure 

Every iDig Connect sensor plate — boom, stick, bucket, and chassis — installs the same way: clean the 
machine surface, clean the plate, apply 3M adhesive activator, press the 3M tape onto the plate, then 
press the plate to the machine. The adhesive cures in about 30 seconds under firm pressure and reaches 
full strength over the next 24 hours. 

The plates themselves vary by sensor — the XD422 Mini Plate is used for Mini Sensors on the boom, 
bucket, and (separately) for the chassis sensor; the XD412 Combo Plate mounts the BT145 Combo 
Sensor on the stick; the XD436 Big Combo Plate mounts the larger BT147 Big Combo Sensor. But the 
adhesive procedure is identical across all of them. 

 
Critical: The Adhesive Is Permanent 
The 3M adhesive used on iDig sensor plates is a structural adhesive — once you press the plate to 
the machine, it does not come off cleanly. Finalize your plate location before you peel the red liner 
off the tape. Mark it with a sharpie, dry-fit the sensor on the plate to confirm clearance, and only 
then commit. 

What's Included With Each Plate Kit 

Item Purpose 

XD416 or XD416MS 3M 
Adhesive Tape 

Pre-cut to match the plate. The MS variant is the smaller tape used 
with the Mini Plate. One sheet per plate kit. 

3M Adhesion Activator Small squeeze bottle or pre-moistened applicator. Primes the 
machine surface so the adhesive reaches full strength. 

XD417 Alcohol Cleaning 
Wipes 

Final surface-prep wipes. Included in every plate kit. 

 

Step-by-Step: Installing a Sensor Plate with 3M Adhesive 

1 

Select the mounting location. 
Choose a location that is smooth, rigid, and easily accessible. Avoid surfaces that flex, 
vibrate heavily, or are part of a bolt-on panel. The specific location requirements for each 
sensor are covered in Sections 03 through 07 of this volume. 

 

2 

Dry-fit the sensor on the plate at the intended location. 
Hold the sensor and plate against the machine in the position you plan to install. Confirm the 
sensor has clearance for its full range of motion, that you can reach it to pair over Bluetooth 
later, and that hoses, pins, or hydraulic lines will not interfere. Mark the four corners of the 
plate with a sharpie. 
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3 

Clean the machine surface with brake cleaner. 
Spray brake cleaning fluid onto a clean rag and wipe the marked area thoroughly to remove 
dirt, grease, and dust. Do not spray brake cleaner directly on the machine — it can drift onto 
painted surfaces or into seals. Use the rag. 

 

4 
Finish with an alcohol wipe. 
Use one of the included XD417 alcohol wipes to remove any brake-cleaner residue. The 
surface must be completely clean and completely dry before the adhesive activator goes on. 

 

5 

Apply 3M adhesion activator. 
Using the supplied 3M activator, apply a light, even coat to the cleaned area. Let it dry 
completely — do not touch or contaminate the treated area once applied. Drying typically 
takes 1 to 2 minutes depending on temperature. 

 

6 

Prepare the adhesive pad on the plate. 
Remove the red liner from one side of the 3M tape and firmly press the adhesive onto the 
back of the sensor plate for a full 30 seconds. Handle the tape only by the edges — oils from 
your fingers weaken the adhesive. The adhesive should now be bonded to the plate with a 
second red liner still facing outward. 

 

7 

Remove the second red liner and mount the plate. 
Peel the remaining red liner to expose the adhesive. Align the plate carefully to the sharpie 
marks on the treated machine surface, then press firmly for a full 30 seconds. Apply steady, 
even pressure over the entire plate. Do not slide or reposition once the adhesive makes 
contact — you get one shot. 

 

8 

Let the adhesive cure before installing the sensor. 
The adhesive reaches initial strength in 30 seconds but continues curing for 24 hours. You 
can install and pair the sensor immediately for setup work, but do not put the machine into 
heavy service until the adhesive has had 24 hours to fully cure. 

 
 
 

 
Common Mistake: Skipping the Activator 
The 3M activator is what gives the adhesive its full structural strength. Skipping it (because it is late 
in the day, because it is cold, because the activator has evaporated and you don't have a fresh one) 
will produce a weakened bond.. Do not skip the activator. If you are out of it, stop installation, call 
your dealer, and get more before continuing. 
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03  Boom Sensor Plate 

The boom sensor is a Mini Sensor (BT144) mounted on an XD422 Mini Plate. It tracks the boom angle as 
the boom raises and lowers. The boom sensor has the most forgiving installation of any sensor in the 
Connect system — it can mount on either side of the boom, and in any orientation the calibration software 
can learn — but you still want to pick a location that stays accessible for pairing and sensor swaps down 
the road. 

Where to Install 
•​ Either side of the boom — pick the side that is easier to reach from the ground or a shop ladder. 

Most installers prefer the right side of the boom (operator's side when seated in the cab) because 
the sensor is visible from the operator's normal viewpoint. 

•​ Any orientation — the calibration procedure accounts for the sensor's actual mounted angle. You do 
not need to mount it "pointing forward" or in any particular alignment. 

•​ Lock mechanism toward the top — install the plate so the sensor's locking mechanism faces 
upward. This makes it much easier to remove and re-insert the sensor during pairing or 
replacement. 

•​ On a solid, rigid section of the boom — avoid weld beads, hydraulic hose clamps, or any section of 
the boom that flexes under load. 

 
Real-World Tip: Stand Where the Operator Stands 
Before you commit the plate location, stand where the operator will stand when pairing the sensor. 
Can you reach the sensor without climbing on the boom? Can you see the sensor's status LED from 
the cab? If the answer is no, pick a different spot. The boom sensor is the easiest to install — there 
is no reason to make it hard to service later. 

Installing the Plate 

Follow the general sensor plate installation procedure in Section 02 of this volume. The XD422 Mini Plate 
Kit ships with XD416MS adhesive tape, activator, and XD417 cleaning wipes — everything you need is in 
the kit. 

After the plate is installed and cured, snap the BT144 Mini Sensor into the plate with the lock mechanism 
oriented up. The sensor will pair over Bluetooth during Machine Calibration in Volume 4. 
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04  Stick (Dipper) Sensor Plate 

The stick sensor is either a BT145 Combo Sensor (standard) or a BT147 Big Combo Sensor (for larger 
machines working with a laser transmitter). Both include a built-in laser receiver, which is why this sensor 
goes on the stick — it needs a clear line of sight to catch a rotating laser beam for 2D elevation reference. 
The BT145 mounts on an XD412 Combo Plate; the BT147 mounts on an XD436 Big Combo Plate. 
Installation geometry is identical for both. 

The stick sensor is the trickiest plate to install. Unlike the boom sensor, you can't just pick a convenient 
spot — the sensor's position affects laser-catch performance, and a poorly-placed sensor makes every 
laser-benchmark operation slower and more frustrating. Take your time here. 

Where to Install 
•​ As low on the stick as possible — the lower the sensor sits, the less the operator has to drop the 

boom and crowd the stick to catch the laser beam. Aim for the lower third of the stick arm. 
•​ On either side of the stick — check both sides and pick the side with the least hose or hard-line 

interference and the fewest crush risks.  Most installers prefer the right side of the boom (operator's 
side when seated in the cab) because the sensor is visible from the operator's normal viewpoint. 

•​ Away from hydraulic lines and auxiliary couplers — a leaking hose will destroy the sensor, and a 
hard line blocking the laser path will hurt laser-catch performance. 

•​ Clear of the dog-bone crush zone — when the bucket crowds all the way in, the dog-bone linkage 
sweeps through a specific arc. Cycle the bucket slowly through its full range and identify any point 
where the sensor could be crushed. If in doubt, install higher and accept slightly worse laser-catch 
performance. 

 
Recommendation: Rotate the Sensor Forward 10–15 Degrees 
When the stick is positioned at 90° to the ground (straight down), rotate the sensor forward 
(counter-clockwise, away from the cab) by about 10 to 15 degrees as you install the plate. This 
small forward tilt improves laser-catch range. 

Step-by-Step: Marking the Stick Sensor Location 

Use a plumb bob and a string line to create a straight reference line between the boom-to-dipper pivot pin 
(at the top of the stick) and the bucket pivot pin (at the bottom of the stick). This line is where the center of 
the stick sensor will sit. 

1 

Position the machine with the stick at 90° to the ground. 
Extend the stick so the pivot pin at the top and the bucket pivot pin at the bottom form a 
vertical line. Level ground helps — if the machine is on a slope, account for that in your 
measurements. 

 

2 

Hang a string line from the boom-to-dipper pivot pin to the bucket pivot pin. 
Use magnetic hooks to secure the string at both pins. A plumb bob can verify the line is truly 
vertical if the machine is level. The string creates the reference line the sensor will be 
centered on. 
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3 
Identify the lowest practical location on the stick along the string line. 
Moving down the string, find the lowest point where the sensor will clear the dog-bone crush 
zone, clear all hoses and hard lines, and still be accessible from the ground or a ladder. 

 

4 

Measure the A–C value from the boom-to-dipper pivot pin down to the sensor center. 
A–C is the distance from the top pin (where the stick meets the boom) to the center of the 
sensor, measured along the string line. Write this value down — you will enter it in the Laser 
Calibration routine in Volume 4. 

 

5 

Confirm A–B = 0. 
A–B is the sensor's offset from the string line. If the sensor is centered exactly on the line, 
A–B is zero. If you had to offset the sensor to avoid a hose or crush point, measure how far 
— but try to achieve A–B = 0 if at all possible. 

 

6 

Mark the plate location and the forward tilt. 
With the location marked and the A–C value recorded, rotate the sensor forward 10–15° and 
trace the plate outline with a sharpie. You now have everything you need to commit the 
adhesive (Section 02). 
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05  Bucket Sensor Plate 
The bucket sensor is a Mini Sensor (BT144) mounted on an XD422 Mini Plate. It tracks the bucket angle 
as the operator curls and dumps. The sensor has two possible mounting locations — the 
quick-disconnect coupler or the dog-bone linkage — and the choice affects both the calibration procedure 
and the sensor's exposure to damage. 

Preferred Location — Quick Disconnect 
If the machine has a quick-disconnect coupler, install the sensor plate on the coupler itself. This gives the 
sensor a stable, well-protected mounting point that moves with the bucket as a single unit. The calibration 
routine for a coupler-mounted bucket sensor is simpler and more accurate than the alternative. 

•​ Install on either side of the coupler — pick the side that is easier to access and less exposed to 
rocks, stumps, or spoil piles as the operator works. 

•​ Clear of the bucket's full range of motion — cycle the bucket through its complete range (full curl, 
full dump, full extension) and confirm the plate location never contacts the stick, the dog-bone 
linkage, or the ground. 

Alternative Location — Dog-Bone Linkage 

On machines without a quick-disconnect coupler — direct-pin bucket installations — the sensor goes on 
the dog-bone linkage. This works, but the calibration procedure is more elaborate (covered in Volume 4), 
and the sensor is more exposed. If you have the choice, quick-disconnect is preferred. 

 
Critical: Confirm Crush Clearance Throughout Full Range of Motion 
The bucket sensor is the most commonly damaged sensor on any machine guidance system. 
Before committing the adhesive, have someone cycle the bucket through its complete range of 
motion — full curl, full dump, full open — while you watch the intended plate location from every 
angle. If the sensor can be pinched, crushed, or contacted during any portion of that motion, pick a 
different spot. A sensor destroyed by an operator's first real dig is a bad day. 

Double-Layer 3M on Rough Coupler Surfaces 

Quick-disconnect couplers are often cast or heavily welded, with surface texture that the single-layer 3M 
adhesive cannot fully bridge. If the mounting surface is rough or uneven, apply two layers of XD416 
adhesive tape — one layer to the back of the plate, then a second layer on top of that — to take up the 
surface irregularities and improve the bond. 

Custom Protective Brackets for Harsh Environments 

Machines that work in rocky soil, demolition debris, stump removal, or other high-impact environments 
benefit from a custom-fabricated protective bracket around the bucket sensor. The bracket is typically a 
short piece of angle iron or plate welded or bolted to the coupler, positioned to take the hit before the 
sensor does. Your iDig dealer can share examples of brackets other operators have built for similar 
machines. 
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Real-World Tip: If You Work Rocky Ground, Budget for a Bracket 
Operators in rocky or debris-heavy environments should plan on a protective bracket from day one 
— not after the first sensor gets destroyed. The cost and time to have your welder fabricate a simple 
bracket is trivial compared to an emergency sensor replacement on a job. If you are unsure whether 
you need one, ask your iDig dealer what other operators in your region have done; they have seen 
it all. 
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06  Chassis Sensor Installation 

The chassis sensor is the BT476 — the current Combo Chassis Sensor, wired for power but 
communicating with the Control Box over Bluetooth. It tells the system how the cab is tilted, which is 
critical for 2D accuracy and is also the foundation for 3D positioning. Unlike the Mini Sensor plates on the 
boom, stick, and bucket, the chassis sensor plate is an XD422 Mini Plate but the sensor itself (BT476) is 
different and must be installed on the cab frame — not on any attached component. 

 
Critical: Mount on the Actual Cab Frame — Not a Bolt-On Panel 
The chassis sensor must be installed on the structural cab frame itself, not on a piece of steel that is 
bolted to the cab frame. Bolt-on panels flex and vibrate independently of the cab, and any flex or 
vibration becomes noise in the chassis calibration. If you are not sure whether a surface is part of 
the cab frame, find one that clearly is — check with your dealer if needed. 

Vibration Dampening 

Even on the cab frame itself, engine and hydraulic vibration can produce enough noise to degrade sensor 
performance. Two options address this: 

•​ Use vibration dampening pads between the sensor plate and the cab steel. 
•​ Use multiple layers of the included 3M adhesive tape in lieu of vibration dampening pads — 

typically two to three layers of XD416MS tape stacked between the plate and the cab steel 
accomplish the same thing. 

Sensor Orientation — Any Orientation, Tilted Calibration 

The BT476 supports mounting in any orientation on the cab frame - though if the machine is not going to 
be able to meet the 4 degrees of tilt for calibration then it MUST be installed flat and with the arrows 
pointed forward.  This is the recommended installation approach because it pairs with the tilted calibration 
method in Volume 4 — and the flat calibration method.  You have options. 

 
Best Practice: Install for the Tilted Calibration Method 
The tilted calibration method is the recommended approach for every new Connect installation. It 
pays back many times over in field accuracy. If the machine has a blade, extending it fully down is 
the easiest way to achieve the required 4° tilt. Alternatively, position the machine on firm native 
ground that provides the tilt. If you genuinely cannot tilt the machine where you will calibrate — 
some dealer demo floors, some tight shop spaces — contact your iDig dealer for the fallback 
procedure rather than assuming you have to compromise. 

Accessibility for the Power Cable 

The BT476 draws power from the cradle through the CT425C Y-shielded cable. The cable connects to the 
sensor with a screw-locking connector, which means you need clearance to screw and unscrew the cable 
during pairing or sensor swaps. The installation sequence that avoids headaches: 

1 

Screw the power cable onto the BT476 first. 
Connect the CT425C cable to the sensor before you plan the plate location. This ensures 
you find a location that has clearance for the connector, not one that merely has clearance 
for the sensor body. 
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2 
Place the sensor into the plate. 
Snap the BT476 into the XD422 plate. The sensor and cable together should form the unit 
you will mount. 

 

3 

Find the optimal mounting location. 
Dry-fit the assembled sensor and cable against the cab frame. Confirm the sensor has full 
clearance, the cable can route cleanly back to the cradle, and you can reach the connector 
to remove it when needed for pairing. 

 

4 
Mark the plate location and route the cable before installing the plate. 
Sharpie the plate location, then plan the cable route. Plan for zip-tie anchor points along the 
route — 6" zip ties and 3/4" cable tie mounts work well inside the cab. 

 

5 
Install the plate per Section 02. 
Follow the standard adhesive procedure. Once the plate is cured, press the BT476 into place 
and secure the cable along its planned route. 

 
 
 

Real-World Tip: You Will Remove This Sensor to Pair It 
Unlike the other sensors, the chassis sensor stays connected to its power cable at all times. Pairing 
the sensor over Bluetooth means unscrewing the power cable, removing the sensor from the plate, 
waiting 5 seconds, and snapping it back in. If the cable connector is in a tight spot behind cab trim 
or under a dash panel, that 30-second task becomes a 20-minute task with knuckles that do not 
appreciate the experience. Choose a location you can actually reach. 
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07  GNSS Receiver Mounting 

The Spotman GNSS receiver (CT140T) mounts on the cab roof or on the counter balance behind the cab  
to give the system precise position and elevation anywhere on the jobsite. Good GNSS mounting 
geometry is not optional — it is the difference between reliable RTK positioning and a receiver that drifts, 
loses fix, or produces inconsistent heading as the cab rotates. 

The 1-Meter Rule 

The Spotman must be mounted a minimum of 1 meter (3.28 feet) from the machine's center of rotation. 
The greater the distance, the better the system can resolve heading as the cab rotates. Mounting closer 
than 1 meter produces unreliable heading and poor guidance overall. 

 
Critical: Measure from the Center of Rotation 
The 1-meter distance is measured from the center of the machine's rotation circle (where the cab 
rotates around the tracks) to the center of the Spotman receiver. It is not measured from the edge of 
the cab, the GNSS mount bracket's anchor point, or any other visible reference. Use a tape 
measure from the rotation center to confirm. 

The CT139 GNSS Mount 
The CT139 is iDig's standard GNSS mount bracket. On most larger excavators, there is ample room to 
use the CT139 and achieve the 1-meter offset from the center of rotation without modification. The mount 
is installed with 3M adhesive (same procedure as any sensor plate — see Section 02): clean the 
mounting surface, apply the activator, press the bracket onto the treated area, and let it cure. 

•​ Install on a flat, rigid portion of the machine. 
•​ Confirm the Spotman has a clear view of the sky — no cab overhangs, no exhaust stack, no 

rollover protection structure blocking satellite reception. 
•​ Confirm the 1-meter rule with a tape measure before committing the adhesive. Sharpie the bracket 

location, dry-fit the Spotman in the bracket, and measure from the center of rotation. 

Custom Mounts for Smaller Machines 

On smaller machines — compact excavators, short-tail machines, and machines with a particularly tight 
cab — the CT139 may not provide enough offset to achieve the 1-meter minimum. In that case, a custom 
GNSS bracket must be fabricated for the machine. Common approaches: 

•​ A short piece of square tubing welded to the rear of the cab, extending the Spotman behind the tail 
for the required offset. 

•​ A side-mounted arm extending out from the cab roof on the operator's side or opposite side. 
 

 
Real-World Tip: Ask Your Dealer for Custom Mount Examples 
If you are installing on a machine where the CT139 won't reach the 1-meter distance, contact your 
iDig dealer before you start fabricating. Dealers typically have photos of custom brackets built for 
the same or similar machines by other operators in your region. Starting from a proven design is 
faster than engineering one from scratch, and it has already solved the clearance, stiffness, and 
sky-view problems you will otherwise discover by trial. 
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Sky-View Requirements 

The GNSS receiver should be configured to see satellites above a 10° elevation mask — that is, satellites 
more than 10° above the horizon. Anything that obstructs the sky directly above or around the Spotman 
will degrade reception. 

•​ No part of the cab or machine elements  (overhang, rollover protection, exhaust, stack, hydraulic 
lines) should be in the way of the Spotman tracking satellites above the 10 degree threshold. 
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08  LED Bargraph & Control Box Cradle Positioning 

Volume 1 covered the general mechanics of the BT447 cradle and the CT149 LED Bargraph cradle — 
what connects where, what goes in the top-left USB port, and the step-by-step mounting procedure. This 
section covers the placement decisions specific to each machine: where on the cab glass the cradles 
actually go, how to check window operation after mounting, and how to route cables so they don't 
become a nuisance during the workday. 

LED Bargraph (BT445) — Front Window Placement 
The LED Bargraph shows cut/fill at a glance, so the operator doesn't have to look at the Control Box 
touch screen during continuous digging. Placement goals: 

•​ Low on the front window — the LED should sit in the operator's peripheral vision when they are 
looking at the work tool. High placement means the operator has to look up, away from the bucket, 
to see cut/fill. 

•​ Slightly right of center — since the operator's right hand works the primary controls, a slight 
right-side placement keeps the LED in view without blocking the primary sight line to the work tool. 

•​ Off the window-opening path — the front window must still be able to open (tilt in or slide) with the 
LED cradle in place. Cycle the window through its full motion during dry fitting. 

Control Box Cradle (BT447) — Side Window Placement 
The Control Box cradle holds the BT142 Control Box and houses the BT/WiFi dongle and power 
connector. Placement goals: 

•​ Right-side sliding window — most operators prefer the right-side window for Control Box access 
because the touch screen falls naturally to their right hand. 

•​ Front portion of the window, closer to the operator — positioning the cradle toward the front of the 
side window keeps it within arm's reach without forcing the operator to twist. 

•​ Off the sliding window's full travel — if the side window is a sliding type, confirm it can still slide to 
both extremes of its travel with the cradle in place. 

 
Critical: Test Both Windows Before Committing 
Both cradles use suction mounts, and both windows (front and side) must still operate normally after 
mounting. Before engaging the suction lock, hold each cradle at its intended location and cycle the 
window through its full motion. If the window catches on the cradle, the power cable, or the LED 
cable at any point in its travel, you have not yet found the right location. 

Cable Management 
Clean cable routing is not cosmetic — poorly-routed cables catch on the operator's clothing, get crushed 
by sliding windows, and drape into the operator's field of view. Plan the routes during dry fitting, then 
secure everything once both cradles are committed. 

We recommend tidying cables using 6" zip ties and 3/4" cable tie mounts along the routes. The 
adhesive-backed cable tie mounts stick to the inside of the cab (same glass-clean-and-3M surface prep 
as sensor plates) and the zip ties hold the cable bundle in place. This approach keeps cables along 
existing wiring runs without drilling new holes or fishing through door frames. 

•​ Route the LED cable from the front-window CT149 cradle back to the BT447 cradle along the top of 
the dash or along the headliner — never across door hinges, the sliding window track, or the 
operator's seat rails. 
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•​ Route the cradle power cable from the BT447 to the cab's 12V/24V accessory outlet along existing 
wiring looms if available. If you have to tap a new outlet, do it through a proper fused connection — 
not a T-splice into factory wiring. 

•​ Leave a small service loop at each cradle. If a cable is pulled tight with no slack, it will strain at 
connectors and eventually fail. 

 
Real-World Tip: Cables Tell You Where the Pinch Points Are 
After you think you're done routing cables, cycle every window, every door, and the operator's seat 
adjustment through its full range of motion. Watch the cables. Anything that moves, pulls, or pinches 
during that test will become a failure a month or a year later. Solve pinch points before the machine 
leaves the shop. 
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09  CAN Bus Wiring for Tiltrotators 

If the machine is equipped with a tiltrotator — a coupler that both tilts and rotates the bucket continuously 
— iDig Connect reads rotation and tilt data from the tiltrotator's cabin module over CAN bus. The cabling 
is specific to each tiltrotator brand, but the connection at the iDig side uses the CAN port on the BT447 
cradle. 

Supported Tiltrotators 

iDig Connect supports CAN bus integration with Engcon, Steelwrist, and Kinshofer Nox tiltrotators. The 
software calibration procedure is the same for all three brands (covered in Volume 4); only the physical 
cable between the tiltrotator cabin module and the iDig cradle differs. 

Tiltrotator Brand Required Cable 

Engcon (EC206 and 
newer) 

Purple CAN-2-CAN Cable — Engcon part number 99130238. 
Connects the Engcon cabin module to the iDig cradle's CAN port. 

Steelwrist CAN-2-CAN cable with Steelwrist-specific connectors. Contact your 
iDig dealer for the current part number. 

Kinshofer Nox M12 Male-to-Female cable. Also requires a Grade Control License 
purchased and activated on the NOX Cabin Module before the module 
will output rotation data via CAN. 

 

CAN Switches Inside the BT447 Cradle 

The BT447 cradle contains two internal CAN switches — #1 and #2 — that must be in the ON position for 
the cradle to pass CAN data between the tiltrotator and the Control Box. These switches are set to ON at 
the factory, so in a normal installation you do not need to touch them. They exist for troubleshooting: if the 
Control Box is not receiving CAN data from the tiltrotator after everything else is wired correctly, the 
switches are the first thing to check. 

 
When to Check the CAN Switches 
The CAN switches ship ON. You only need to open the cradle to check them if the tiltrotator cable is 
confirmed connected, the tiltrotator is powered and producing data, and iDig still shows no CAN 
data on the Wired Sensors > CAN screen. In that case, one of the switches is likely OFF. Otherwise, 
leave the cradle closed — every cradle opening is a chance to damage the main PCB or mis-route 
a cable. 

Accessing the CAN Switches (Troubleshooting Only) 
If you confirm the switches need to be checked, the procedure is straightforward but requires care: the 
cradle opens with a T10 Torx screwdriver, and the main PCB inside is exposed during the procedure. 

1 
Power the Control Box and the machine OFF. 
Do not attempt to open a powered cradle. Power down the machine completely and wait for 
the Control Box to shut down. 
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2 
Remove the Control Box from the cradle. 
Slide the BT142 out of the cradle. Set it safely out of the way — not on the floor, where it can 
be stepped on. 

 

3 
Remove the T10 Torx screws from one side of the cradle. 
The BT447 opens from either side. You only need to open one side to reach the CAN 
switches. Keep the screws in a magnetic dish so they do not roll into the machine. 

 

4 
Locate the CAN switches. 
Switches #1 and #2 are clearly labeled on the cradle's internal board. Do not touch the main 
PCB or any other components. 

 

5 
Confirm both switches are in the ON position. 
If either switch is OFF, flip it to ON. Do not change any other switches or connectors — the 
CAN switches are the only user-serviceable items inside the cradle. 

 

6 
Close the cradle. 
Re-install the T10 Torx screws. Do not overtighten — the plastic housing strips easily. 

 

7 
Re-install the Control Box and power on. 
Verify CAN data is now reaching the Control Box via Basic Settings > Wired Sensors > CAN 
(see below). 

 
 

Verifying CAN Data 

Once the tiltrotator cable is connected and the CAN switches are confirmed ON, power up the Control 
Box and the machine and verify data is flowing. From the Settings menu, navigate to Basic Settings > 
Wired Sensors > CAN. You should see live data from the tiltrotator: rotation angle, tilt angle, and any 
other fields the cabin module is publishing. If the screen shows all zeros or no data, the connection is not 
complete — work back through the cable, the cabin module power, any required license (Kinshofer Nox), 
and finally the CAN switches. 

 
Critical: Kinshofer Nox Requires a Separate License 
Kinshofer Nox tiltrotators will not output rotation data via CAN until a Grade Control License is 
purchased and installed on the NOX Cabin Module. This is a separate license from any iDig license 
— it is purchased through Kinshofer and installed by inserting a Mini-to-USB adapter (provided by 
Kinshofer) into the back of the NOX Cabin Module and running the license installer. Expect to do 
this step before any CAN cabling work; without the Grade Control License, the CAN output is 
disabled regardless of cabling. 
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The tiltrotator software calibration — entering the AC measurement from the rotator's center of rotation to 
the quick-attachment pin, setting sensor gains, and aligning the rotator's zero position — happens in 
Volume 4 as part of the full machine calibration. 
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10  Machine Configurations — Boom Types 

iDig Connect supports two boom configurations on excavators: a standard single boom and a second 
boom (also called a knuckle boom or double-deported-arm). The correct configuration is selected in the 
Create New Machine wizard during calibration in Volume 4 — but knowing which configuration applies to 
your machine belongs in the installation phase, because the sensor count and placement are the same 
either way and you want to select the right option when you get to the wizard. 

Standard Single Boom 

The standard single-boom configuration describes any excavator whose boom is a single piece of steel 
from the cab pivot to the stick pivot. The boom sensor sits on this single boom element, and the 
calibration wizard learns the geometry of that single element. 

•​ One boom sensor (Mini Sensor / BT144) on the boom. 
•​ One stick sensor (Combo or Big Combo) on the stick. 
•​ One bucket sensor (Mini Sensor / BT144) on the bucket coupler or dog-bone. 
•​ One chassis sensor (BT476) on the cab frame. 

The vast majority of excavators in North American construction are standard single-boom configurations. 
If the boom is a single piece and does not fold or articulate independently from the stick, it is a standard 
boom. 

Second Boom (Knuckle Boom / Double-Deported Arm) 
The second-boom configuration describes excavators whose boom articulates at a second pivot — a 
knuckle-boom excavator or a double-deported-arm machine. These machines have an additional 
hydraulic joint partway along what looks at first glance like a standard boom, allowing the operator to 
break the boom angle independently from the stick angle. 

•​ Sensor count and placement are the same as the standard configuration — the second boom does 
not add sensors. The Connect software handles the additional articulation in software based on the 
selection in the wizard. 

•​ Visual identifier — a standard boom has one upper hinge (between the boom and the cab). A 
second boom has two upper hinges (cab-to-boom, then boom-to-second-boom before the stick). If 
you see two visible pivot points above the stick, it is a second-boom machine. 

 
How to Tell at a Glance 
Stand to the side of the machine and trace the line from the cab pivot to the stick pivot. If it goes 
straight (with only minor taper for structural reasons), it is a standard boom. If the line breaks at a 
visible pivot partway along, it is a second boom. This check takes 10 seconds and saves an 
incorrect wizard selection in Volume 4. 
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11  Attachment Types Supported in Connect 

iDig Connect provides machine guidance for specific attachment types. Not every attachment on the 
market is supported, and attempting to run Connect against an unsupported attachment produces 
unreliable or incorrect guidance. Confirm the attachment type is supported before installing sensors. 

Supported Attachments 

Attachment Type Connect Support 

Standard Bucket (Classic 
Bucket) 

Fully supported. The default configuration. Bucket sensor on the 
quick-disconnect or dog-bone (Section 05). 

Tilt Bucket Supported with a tilt sensor kit purchased separately. The tilt sensor is 
an additional Mini Sensor (BT144) mounted on the tilt bucket to track 
the tilt angle independently from the main bucket angle. 

Tiltrotator (RotoTilt) Supported on Engcon EPS2 the tiltrotators via CAN bus integration 
(Section 09). The tiltrotator's own rotation and tilt data are read from its 
cabin module; iDig does not install additional sensors on the tiltrotator 
itself. 

Rotator Coupler Supported. Rotation is read from the rotator's control module. 
Calibration follows the same workflow as tiltrotators minus the tilt axis. 

 

Tilt Sensor Installation (Tilt Bucket Machines) 
Machines with a tilt bucket need an additional Mini Sensor (BT144) mounted on the tilt bucket to track the 
tilt angle. This sensor uses the same XD422 Mini Plate and the same general installation procedure as 
the other Mini Sensors (Section 02). The tilt sensor is included in the tilt-sensor kit purchased from your 
dealer at the time of order — if you did not purchase a tilt-sensor kit and the machine has a tilt bucket, 
contact your dealer before starting installation. 

•​ Mount the tilt sensor plate on the tilt bucket itself — not the coupler. The sensor needs to track the 
tilt bucket's rotation relative to the stick. 

•​ Ensure clearance through the bucket's full range of motion — the tilt bucket has a shorter range 
than the main bucket, but the sensor still needs to clear any mechanical stop or hose path. 

•​ Calibration follows the tilt-bucket calibration procedure in Volume 4. 
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12  Installation Walkthrough — Typical Machines 

This section pulls together the individual plate-installation sections into end-to-end walkthroughs for three 
common machine sizes. Use these as a reference for expected sensor placements and typical gotchas. 
Every machine is different, so treat these as starting points rather than exact recipes — always follow the 
specific placement guidance in Sections 03 through 07. 

Mid-Size Excavator — CAT 320-Class (or Komatsu PC210 / Volvo EC220) 
The CAT 320 and similar 20-ton-class machines are the most common target for iDig Connect 
installations in North American construction. Mid-size excavators typically accommodate the CT139 
GNSS mount without modification, have standard single booms, and have enough stick length for 
comfortable laser-catch performance with the BT145 Combo Sensor. 

•​ Boom sensor — right side of the boom, lower third, locking mechanism up. The CT149 LED cradle 
on the front window is visible from the seat at a natural downward angle to the bucket. 

•​ Stick sensor — BT145 Combo Sensor on the XD412 Combo Plate, mounted in the lower third of 
the stick, centered on the pivot-to-pivot string line, rotated forward 10–15°. 

•​ Bucket sensor — Mini Sensor on the quick-disconnect coupler (not the dog-bone). CAT 
quick-disconnects typically have a flat accessible surface on either side that takes 3M adhesive 
well. 

•​ Chassis sensor — BT476 on the cab frame behind the operator's seat, with two layers of 3M tape 
for vibration dampening. The CT425C power cable routes forward along existing wiring to the 
cradle. 

•​ GNSS receiver — CT139 bracket on the rear of the cab roof achieves the 1-meter offset from the 
center of rotation without modification. Confirm with a tape measure before committing the 
adhesive. 

Compact Excavator — CAT 305/308-Class (or Bobcat E35 / Kubota KX057) 
Compact and short-tail excavators challenge the 1-meter GNSS rule — the machine's physical envelope 
is too small for the CT139 to achieve the required offset from the center of rotation. Expect to fabricate or 
specify a custom GNSS mount. The other sensors install similarly to mid-size machines, but the tighter 
geometry means dry-fitting is more important. 

•​ Boom and stick sensors — same installation approach as mid-size machines. The shorter boom 
and stick mean the stick sensor ends up closer to the ground — fine, just confirm clearance during 
dry fit. 

•​ Bucket sensor — the quick-disconnect on a compact excavator is usually smaller and more 
exposed. A custom protective bracket is common here, particularly on machines that work in rocky 
ground. 

•​ Chassis sensor — on some compact excavators, the cab frame access is tight. Plan the BT476 and 
its power cable together before committing the plate, and confirm you can reach the connector for 
future pairing. 

•​ GNSS receiver — custom bracket required on almost every compact excavator. Common approach 
is a rear-mounted arm extending the Spotman behind the tail to achieve the 1-meter offset. Contact 
your iDig dealer for proven bracket designs on your specific machine. 

Large Excavator — CAT 349-Class (or Komatsu PC360 / Volvo EC380) 
Large excavators (30+ tons) benefit from the BT147 Big Combo Sensor on the stick because the wider 
laser-catch window is much easier to use on a longer boom and stick. Installation otherwise follows the 
same pattern as a mid-size machine, with more room and more tolerance for minor placement variation. 
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•​ Stick sensor — BT147 Big Combo Sensor on the XD436 Big Combo Plate. Same installation 
geometry as the BT145 (lower third of stick, on the pivot string line, 10–15° forward rotation), but 
the larger sensor body means the plate footprint is larger too. 

•​ Bucket sensor — on very large excavators, the bucket and coupler are more exposed to heavy 
impact. Plan for a custom protective bracket from day one. Operators in demolition or heavy civil 
work often build the bracket into the machine's daily inspection routine. 

•​ GNSS receiver — CT139 typically achieves the 1-meter offset easily on large excavators; the 
challenge is usually sky view rather than offset, because the larger cab may have more overhangs 
and a larger exhaust stack to work around. 

 
Real-World Tip: Photograph Every Installation 
Take photos of every sensor plate location, the GNSS mount, the CT425C cable routing, and the 
cab cable management before you hand the machine back to the operator. Photos on your phone or 
in your dealer's CRM create a reference for warranty, future re-installations, and troubleshooting. 
When an operator calls six months later saying "the bucket sensor stopped working," a photo of 
where the sensor was installed saves a trip to the machine. 
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13  What's Next 

With Volume 2 complete, every sensor plate is installed on the machine, the Spotman GNSS receiver is 
mounted on the cab roof with the required 1-meter offset, the Control Box cradle and LED Bargraph 
cradle are on the cab windows, and any tiltrotator is wired through the CAN bus to the cradle. The 
machine is ready to be calibrated. 

Volume 3: GNSS Receiver Configuration 

Volume 3 covers the Spotman receiver's configuration — how RTK GNSS works, connecting to the 
Spotman's WebUI, setting up Bluetooth NMEA output, configuring NTRIP corrections via SIM card or 
UHF radio, supported radio protocols for base-station corrections, and finally pairing the GNSS receiver to 
the iDig Control Box. If your system includes a Spotman (2D+ with Spotman add-on, 2D Project, or 3D), 
Volume 3 is your next stop before Volume 4. 

Volume 4: Machine Calibration 

Volume 4 is the calibration volume. It walks through the full calibration sequence in the correct order — 
cradle configuration, GNSS NMEA pairing, boom and stick wizard calibration, bucket calibration, swing 
boom (if licensed), chassis sensor calibration using the tilted method, GNSS 3D calibration, laser receiver 
calibration, and tiltrotator calibration if equipped. Volume 4 ends with backing up the completed machine 
calibration to USB so it can be restored later or copied to additional Control Boxes. 

Need Help? 

Contact your iDig dealer for assistance with installation, sensor placement decisions, or custom mount 
fabrication. For real-time support, use the Remote Access feature described in Volume 1 Section 09 — it 
lets your dealer see your Control Box screen while you talk through the work together.  
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01  How RTK GNSS Works — The 60-Second Version 

GNSS (Global Navigation Satellite System) receivers determine their position by measuring the time it 
takes for signals to arrive from multiple satellites orbiting the earth. A standard GNSS fix — the kind your 
phone produces — is accurate to roughly 3 to 10 feet, depending on conditions. That is fine for 
navigation, but it is nowhere close to accurate enough for machine guidance. 

RTK (Real-Time Kinematic) adds a critical piece: a nearby base station or network correction service that 
broadcasts correction data to the rover receiver on your machine. The base station sits on a precisely 
known position and continuously compares its known coordinates to the coordinates the satellites are 
reporting. The difference — the error — is transmitted to the rover as a correction. The rover applies that 
correction in real time and achieves positioning accuracy of approximately 0.03 feet (about 10 mm) 
horizontally and 0.05 feet (about 15 mm) vertically. 

When the Spotman receiver shows RTK Fix on its status display, it means the receiver is tracking 
satellites, receiving corrections from a base station or NTRIP service, and has resolved its position to 
centimeter-level accuracy. This is the operating state required for 3D machine guidance and for 2D+ 
mode when using the GNSS as the vertical reference. 

 
No RTK Fix = No Accurate Guidance 
If the Spotman shows Float, DGPS, or Autonomous instead of RTK Fix, the position accuracy is 
degraded and the system should not be used for precision grading. A Float fix means the receiver is 
receiving corrections but has not fully resolved the carrier-phase ambiguities. Wait for the fix to 
resolve, or troubleshoot the correction source. See Section 14 for connection troubleshooting. 

Two Ways to Get Corrections 

The Spotman supports two correction sources. Most operators use one or the other, depending on the 
jobsite and what infrastructure is available. 

Correction Source How It Works When to Use 

NTRIP (Network 
RTK) 

Corrections are delivered over the 
internet via a SIM card in the Spotman. 
The receiver connects to an NTRIP 
service provider (a network of 
permanently-installed base stations) 
and receives corrections as a data 
stream. 

Use when cellular coverage exists 
at the jobsite. This is the most 
common setup for construction — 
no base station to set up, no radio 
to configure, and corrections are 
available as soon as you have a 
cell signal. 

UHF Radio Corrections are broadcast from a local 
base station (your own or a site base) 
over a UHF radio link (410–470 MHz). 
The Spotman's internal radio receives 
the corrections directly. 

Use when there is no cellular 
coverage at the jobsite, when the 
project requires a local base 
station for control, or when the 
NTRIP service does not provide 
adequate coverage in your area. 
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02  Spotman (CT140T) Receiver Overview 

The Spotman is a multi-constellation RTK GNSS receiver designed for machine guidance and field 
survey. It captures signals from GPS, GLONASS, Galileo, BeiDou, and QZSS — up to 1,408 channels — 
for maximum satellite availability in all conditions. 

Specification Detail 

Satellite Constellations GPS, GLONASS, Galileo, BeiDou, QZSS 

Channels Up to 1,408 

Positioning Accuracy (RTK) Horizontal: ~10 mm; Vertical: ~15 mm 

Environmental Rating IP67 — dustproof and waterproof 

Drop Rating Survives a 2-meter (6.5 ft) pole drop 

Battery Internal Li-ion — up to 34 hours in rover mode 

Built-In Radio UHF 410–470 MHz for receiving base-station corrections 

Connectivity Wi-Fi, Bluetooth 

SIM Card Slot Built-in — accepts a standard SIM for NTRIP corrections over 
cellular data 

Compatible Software iDig Connect (machine guidance), iPoint (survey and stakeout) 
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03  Connecting to the Spotman WebUI 
The Spotman receiver is configured through a browser-based interface called the WebUI. You connect to 
the WebUI over Wi-Fi from any device with a web browser — a laptop, tablet, or phone. 

Step-by-Step: Connect to the WebUI 

1 
Turn on the Spotman receiver. 
Press and hold the power button until the LED indicators light up. 

 

2 
On your PC, tablet, or phone, open Wi-Fi settings and connect to the Spotman's Wi-Fi 
network. 
The Spotman broadcasts its own Wi-Fi network. The default Wi-Fi password is 12345678. 

 

3 
Open a web browser and navigate to http://192.168.1.1 
This is the Spotman's default WebUI address. The login screen appears. 

 

4 
Enter the login credentials and tap Login. 
Login Account: admin — Password: password 

 
 
You are now connected to the Spotman WebUI. The interface provides access to I/O Settings, Network 
Settings, Module Settings, and other configuration pages used in the following sections. 

 
Critical: Configure the Spotman Before Connecting to iDig 
The Spotman must have its Bluetooth NMEA output configured (Section 04) and its correction 
source configured (NTRIP in Section 05 or Radio in Section 09) before you pair it to the iDig Control 
Box. Pairing to the Control Box before configuring NMEA output will result in no position data 
reaching iDig. 
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04  Configuring Bluetooth NMEA Output 

The Spotman sends position data to the iDig Control Box over Bluetooth using NMEA sentences. Two 
specific NMEA sentences must be enabled at the correct output rates for iDig Connect to operate 
properly. 

Setting Required Value 

PIN No PIN required — leave blank 

GPGGA 10 Hz 

GPGST 1 Hz 

 

Step-by-Step: Configure Bluetooth NMEA Output 

1 
In the Spotman WebUI, select I/O Settings. 
The I/O Settings page lists all communication interfaces. 

 

2 
On the BT row, select Settings. 
The Bluetooth output configuration page opens. 

 

3 
Set GPGGA to 10 Hz. 
This is the primary position sentence. It must output at 10 Hz for iDig Connect to receive 
position updates at the rate the system requires. 

 

4 
Set GPGST to 1 Hz. 
This sentence provides the position accuracy estimate (HRMS/VRMS). iDig uses it to display 
fix quality. 

 

5 
Confirm there is no PIN configured. 
The Bluetooth connection between the Spotman and the Control Box must be made without 
a PIN. If a PIN is set, the Control Box will not be able to pair. 

 

6 
Select Confirm to save the settings. 
The Bluetooth NMEA output is now configured. 
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05  SIM Card Setup — T-Mobile 

T-Mobile is one of the most commonly used carriers for iDig receivers. There are two APN configurations 
depending on how your SIM was provisioned — check your SIM card documentation to determine which 
to use. 

Step-by-Step: Configure T-Mobile APN 

1 
In the Spotman WebUI, navigate to Network Settings > Mobile Network Settings. 
The mobile network configuration page opens. 

 

2 
Set Auto Start to Yes. 
This ensures the cellular connection starts automatically when the Spotman powers on. 

 

3 
Set Network Mode to 2G/3G/4G Auto. 
The receiver selects the best available network automatically. 

 

4 
Set Auto Connect to Yes. 
The receiver reconnects automatically if the connection drops. 

 

5 
Enter the APN and authentication settings. 
See the table below for the correct values for your SIM. 

 

6 
Select Save. 
The SIM card settings are now configured. 

 
 

Setting Standard T-Mobile SIM iDig-Provisioned T-Mobile SIM 

APN fast.t-mobile.com simbase 

Dialing String *99# *99# 

Username   

Password   
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Which APN Do I Use? 
If you purchased the SIM card yourself from T-Mobile, use fast.t-mobile.com with no username or 
password. If your iDig dealer provided the SIM card, it is likely an iDig-provisioned SIM that uses 
simbase with admin/password. Check the documentation that came with your SIM, or contact your 
dealer. 
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06  SIM Card Setup — Verizon 

Verizon SIM cards use a single APN for both standard phone SIMs and data-only SIMs. 

Step-by-Step: Configure Verizon APN 

Follow the same procedure as T-Mobile (Section 05, Steps 1–4 and 6), then enter the following APN 
settings. 

Setting Value 

APN vzwinternet 

Dialing String *99# 

Username (blank) 

Password (blank) 
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07  SIM Card Setup — AT&T & Other Carriers 

The setup procedure is the same for every carrier: navigate to Network Settings > Mobile Network 
Settings, set Auto Start to Yes, Network Mode to 2G/3G/4G Auto, Auto Connect to Yes, then enter the 
carrier-specific APN and credentials from the table below. The Dialing String is *99# for all carriers listed. 

Carrier APN Usernam
e 

Passwor
d Notes 

AT&T (Phone 
SIM) 

nxtgenphone (blank) (blank) For standard phone SIMs. 
Case-sensitive. 

AT&T 
(Data/IoT SIM) 

broadband (blank) (blank) For AT&T data-only and IoT 
plans. Try this if nxtgenphone 
does not connect. 

FirstNet 
(AT&T) 

firstnet-broadband (blank) (blank) First-responder priority network. 
Requires a FirstNet-activated 
SIM. 

Google Fi h2g2 (blank) (blank) Rides on the T-Mobile network. 

Mint Mobile Wholesale (blank) (blank) T-Mobile MVNO. Capital W 
required. 

Visible vsblinternet (blank) (blank) Verizon MVNO. 

US Cellular usccinternet (blank) (blank) Regional carrier. 

 
 

If Your Carrier Is Not Listed 
Contact your carrier and ask for the APN settings for an IoT or M2M data device. You need the APN 
name, username (if any), and password (if any). The Dialing String is *99# for virtually all carriers in 
North America. Enter the values in the same Mobile Network Settings page as any other carrier. 
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08  Configuring NTRIP Corrections 

NTRIP (Networked Transport of RTCM via Internet Protocol) delivers RTK corrections to the Spotman 
over a cellular data connection. The Spotman connects to an NTRIP correction service provider using 
credentials supplied by the provider. Your NTRIP provider will give you the five values listed below — 
enter them exactly as provided. 

 
Before You Start 
You need an active SIM card installed in the Spotman, a data plan that supports the SIM (see 
Sections 05–07 for carrier-specific APN setup), and the NTRIP credentials from your 
correction-service provider. 

Step-by-Step: Configure NTRIP Corrections 

1 
In the Spotman WebUI, select I/O Settings. 
The I/O Settings page lists all communication interfaces. 

 

2 
On the RTK Client row, select Details or Connect. 
The NTRIP connection configuration page opens. 

 

3 
Enter the NTRIP credentials provided by your correction service. 
Domain/IP, Port, Mount Point, Username, and Password. Enter each value exactly as 
provided — these fields are case-sensitive. 

 

4 
Select Connect. 
The Spotman attempts to connect to the NTRIP service using the SIM card's cellular data 
connection. 

 

5 

Verify the RTK Client row turns green and shows Logged In. 
A green indicator and the text "Logged In" confirm the Spotman is receiving corrections. If 
the row stays red or shows an error, verify your credentials and SIM card data connection 
(Sections 05–07). 
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09  Configuring UHF Radio Corrections 

When corrections are delivered from a local base station over UHF radio, the Spotman's internal radio 
must be configured to match the base station's radio settings exactly. Every parameter — protocol, 
channel bandwidth, frequency, and baud rate — must match. A mismatch on any single parameter will 
result in no corrections received. 

Step-by-Step: Configure the UHF Radio 

1 
In the Spotman WebUI, navigate to Module Settings > Radio Settings. 
The radio configuration page opens. 

 

2 
Turn the Radio On. 
Set the Radio toggle to On. 

 

3 
Set Auto Start to Yes. 
The radio starts automatically when the Spotman powers on. 

 

4 
Match the Protocol to your base station. 
The protocol must match exactly. See Section 10 for the supported protocols and the name 
mapping between base-station and Spotman terminology. 

 

5 
Match the Channel Bandwidth to your base station. 
25 kHz or 12.5 kHz — this must match. 

 

6 

Match the Frequency to your base station. 
Select the radio channel that corresponds to the frequency your base station is transmitting 
on. If the frequency is not in the default channel list, see Section 11 for creating a custom 
frequency file. 

 

7 
Select Save. 
The radio settings are now configured. The Spotman will begin listening for corrections on 
the configured frequency. 

 
 
 

Every Radio Parameter Must Match the Base Station 
Protocol, channel bandwidth, frequency, and baud rate must all match the base station exactly. The 
most common cause of "radio shows no signal" is a single mismatched parameter — typically the 
protocol name, because different manufacturers use different names for the same protocol. See 
Section 10 for the protocol name mapping. 
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10  Supported Radio Protocols 

The Spotman supports the following radio protocols. Each protocol is available in both 25 kHz and 12.5 
kHz channel spacing. FEC is disabled on all protocols. 

Protocol Channel Spacing Modulation Link Rate 

TrimTalk / TT450S 25 kHz GMSK 9600 

TrimTalk / TT450S 12.5 kHz GMSK 4800 

Satel 3AS 25 kHz 4FSK 19200 

Satel 3AS 12.5 kHz 4FSK 9600 

Transparent 25 kHz GMSK 9600 

Transparent 12.5 kHz GMSK 4800 

 

Protocol Name Mapping 

Base-station manufacturers sometimes use different names for the same radio protocol. When 
configuring the Spotman to receive corrections from a third-party base station, use the mapping below to 
select the correct protocol name in the Spotman WebUI. 

Base Station Protocol Name Spotman Protocol Name 

TrimTalk Base TT450S 

Satel Base Satel 3AS 
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11  Creating & Loading a Custom Radio Frequency File 

The Spotman ships with a default radio frequency channel list. If your base station transmits on a 
frequency not included in the defaults, you must create a custom frequency file and upload it to the 
receiver. 

Default Channel List 

Channel Frequency (kHz) 

1 456.05 

2 456.55 

3 457.05 

4 458.05 

5 459.05 

6 460.05 

7 461.05 

8 462.05 

9 462.55 

 

File Format 
The custom frequency file is a plain text file named radio_channel.cfg. Each line defines one channel 
using three fields separated by a comma: the frequency band prefix, the frequency in kHz, and an 
availability flag. 

Field Values Meaning 

Band Prefix L / M / H L = Low (below 430 kHz), M = Middle (430–450 
kHz), H = High (above 450 kHz) 

Frequency e.g. 456.05 The frequency in kHz assigned to that channel 
number 

Availability U / A U = Unusable, A = Available 

 

Step-by-Step: Upload the Frequency File 

1 
Create the radio_channel.cfg file on your PC. 
Use any text editor (Notepad, TextEdit, or similar). Enter one channel per line in the format 
described above. Save the file as radio_channel.cfg. 
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2 
Open a browser and navigate to http://192.168.1.1/set_en.html 
This is a separate page from the main WebUI. It provides the file upload interface. 

 

3 
Select Choose File and browse to your radio_channel.cfg file. 
Select the file you created. 

 

4 
Select Upload Radio Channel List. 
The new channels and frequencies are now available for selection in Module Settings > 
Radio Settings. 
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12  Configuring Spotman via iPoint 

If you have the iPoint survey application installed on an Android tablet (included with 2D Project and 3D 
systems), you can configure several Spotman settings directly from iPoint instead of using the WebUI. 
This is convenient when you are already connected to the Spotman through iPoint for survey work. 

NMEA Output via iPoint 
Navigate to Instrument > NMEA Output > Bluetooth. From this screen you can set the GPGGA and 
GPGST output rates to match the values required by iDig Connect (10 Hz and 1 Hz respectively). 

Radio Settings via iPoint 
Navigate to Instrument > GNSS Rover > New > Radio. From this screen you can configure the radio 
protocol, channel bandwidth, frequency, and baud rate to match your base station — the same 
parameters covered in Sections 09 and 10. 

NTRIP Settings via iPoint 
Navigate to Instrument > GNSS Rover > New > NTRIP via SIM. From this screen you can enter your 
NTRIP server credentials (Domain/IP, Port, Mount Point, Username, Password) — the same parameters 
covered in Section 05. 
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13  Pairing GNSS to the iDig Control Box 

With the Spotman's Bluetooth NMEA output configured and corrections flowing (either via NTRIP or 
radio), the receiver is ready to be paired to the iDig Control Box. 

Step-by-Step: Pair the Spotman to iDig Connect 

1 
On the iDig Control Box, navigate to Basic Settings > GNSS Receiver. 
The GNSS Receiver pairing screen opens. 

 

2 
Tap the Other tab. 
The system scans for available GNSS receivers over Bluetooth. 

 

3 
When your Spotman appears, tap it and select Connect as Main 
The receiver is now connected to the Control Box and saved as a known device. 

 

4 
On the Known GNSS tab, highlight your Spotman. 
The receiver row is highlighted blue. 

 

5 
Tap it again to choose to Disconnect or Forget this GNSS Receiver.  
The Control Box establishes a Bluetooth connection to the Spotman. 

 

6 
Verify the connection by tapping the GNSS Data tab. 
The Data tab should show RTK_Fix as the correction status, confirming the receiver is 
connected, receiving corrections, and delivering position data to the Control Box. 

 
 
 

If the Data Tab Does Not Show RTK_Fix 
Verify the Spotman is receiving corrections (NTRIP row green in WebUI, or radio receiving signal). 
Verify GPGGA is set to 10 Hz and GPGST is set to 1 Hz. Verify the BT/WiFi dongle is in the top-left 
USB port of the cradle. If all three are correct and the Data tab still does not show RTK_Fix, 
power-cycle the Spotman and retry the pairing. 
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14  Resolving Heading Accuracy 

After connecting the Spotman to the Control Box - and returning to the 2D or 3D Work Screen interface - 
iDig needs to determine the machine's heading. The Spotman is a single-antenna receiver, so heading is 
resolved by observing the change in position as the cab rotates. 

Step-by-Step: Resolve Heading 

1 
Confirm the correct Machine and Bucket are selected in iDig Connect. 
If the wrong machine profile is loaded, the heading computation will use incorrect geometry. 
Verify the machine name at the top of the screen. 

 

2 
Tap Apply. 
The system begins using the GNSS data with the selected machine profile. 

 

3 
Slowly rotate the cab. 
The heading accuracy indicator on the work screen will improve as you rotate. Continue 
rotating until the heading accuracy meets the threshold and the indicator turns green. 

 

4 
Begin normal operations. 
Once heading accuracy is resolved, the system is ready for 3D guidance. 

 
 
 

Heading Resolves Faster with Deliberate Rotation 
A slow, smooth rotation through at least 180° is the fastest way to resolve heading. Sitting stationary 
or making small cab movements will not provide enough position change for the system to compute 
heading. The first cab rotation after connecting the GNSS on each power-up is when this matters — 
once heading is resolved, it stays resolved for the remainder of the session. 
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15  Using Spotman as a Base Station 

The Spotman can operate as a base station, broadcasting corrections to other rovers on the jobsite over 
its internal UHF radio. This section will be expanded with the full base-station setup procedure in a future 
revision of this guide. 

[REVIEW: Base station setup procedure flagged for SME content. The Spotman supports base-station 
mode with correction broadcasting over UHF radio, but the detailed step-by-step procedure requires SME 
input before publication.] 
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16  Troubleshooting GNSS Connection Issues 

The most common GNSS issues fall into four categories: no RTK Fix, Bluetooth pairing failure, 
SIM/NTRIP not connecting, and radio not receiving corrections. The table below provides a starting point 
for each. For a comprehensive troubleshooting matrix, see Appendix A, Section 03. 

Symptom Likely Cause Action 

Data tab shows Float 
instead of Fix 

Weak satellite geometry, 
multipath from nearby structures, 
or corrections are intermittent 

Move to open sky. Verify base station 
or NTRIP is transmitting continuously. 
Wait for additional satellites. 

Data tab shows 
Autonomous (no 
corrections) 

Not receiving corrections — 
NTRIP not logged in, radio not 
connected, or base station is off 

Check NTRIP: RTK Client row should 
be green in the WebUI. Check radio: 
confirm protocol, frequency, and 
bandwidth match the base. Confirm 
base station is powered and 
transmitting. 

Bluetooth will not pair 
to the Control Box 

NMEA output not configured, 
BT/WiFi dongle missing or in 
wrong port, or PIN is set on the 
Spotman 

Verify GPGGA = 10 Hz, GPGST = 1 
Hz, no PIN. Verify the BT/WiFi dongle 
is in the top-left USB port of the cradle. 

SIM card shows 
Disconnected in 
WebUI 

Wrong APN, SIM not activated, 
no cellular coverage, or antenna 
issue 

Verify APN against the carrier 
reference in Sections 05–07. Confirm 
with the carrier that the SIM is 
provisioned for data. Test the SIM in a 
phone to confirm it is active. 

Radio shows no 
signal despite base 
transmitting 

Protocol, frequency, or 
bandwidth mismatch between 
the Spotman and the base 
station 

Match every radio parameter exactly. 
Use the protocol name mapping in 
Section 10 — TrimTalk Base = 
TT450S, Satel Base = Satel 3AS. 

Heading accuracy will 
not resolve 

Cab has not been rotated since 
power-on 

Slowly rotate the cab through at least 
180°. Confirm GNSS is in RTK Fix 
before attempting to resolve heading. 
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17  What's Next 

With Volume 3 complete, the Spotman GNSS receiver is configured, receiving corrections (via NTRIP or 
UHF radio), paired to the iDig Control Box, and showing RTK Fix on the Data tab. The system is ready for 
the full machine calibration in Volume 4. 

Volume 4: Machine Calibration 

Volume 4 covers the complete calibration sequence: cradle configuration, GNSS NMEA pairing, boom 
and stick wizard calibration, bucket calibration, swing boom (if licensed), chassis sensor calibration using 
the tilted method, GNSS 3D calibration, laser receiver calibration, and tiltrotator calibration if equipped. 
Volume 4 ends with backing up the completed machine calibration. 

Need Help? 

Contact your iDig dealer for assistance with Spotman configuration, NTRIP credentials, radio setup, or 
SIM card issues. For real-time support, use the Remote Access feature described in Volume 1 Section 
09.  
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01  Calibration Overview & Sequence 

Calibration teaches the iDig Connect system the geometry of the specific machine it is installed on — the 
lengths of the boom and stick, the position of the bucket relative to the stick, how the chassis is oriented, 
and where the GNSS receiver sits relative to the center of rotation. Without calibration, the system cannot 
convert raw sensor angles into accurate bucket-tip position. 

Calibration must be performed in a specific order. Each step builds on the results of the previous step, 
and errors in early steps compound through every subsequent step. A boom and stick calibration that is 
off by half an inch will produce a GNSS 3D calibration that is off by several inches at full reach. 

The Full 3D Calibration Sequence 

The following is the complete calibration sequence for a 3D-equipped system. Not every system requires 
every step — a 2D+ system without a Spotman GNSS receiver will skip Steps 2, 3, and 11. A machine 
without a swing boom will skip Step 8. The sequence below represents the full procedure. 

Step Procedure Covered In 

1 Cradle Configuration — power cable, BT/WiFi dongle, LED 
Bargraph connected 

Volume 1 §04 

2 Configure GNSS Receiver NMEA Outputs Volume 3 §04 

3 Pair GNSS Receiver to the Control Box Volume 3 §13 

4 Pair Boom and Stick Sensors to the Control Box This volume, §05 

5 Complete Boom and Stick Wizard Calibration This volume, §05 

6 Pair Bucket Sensor to the Control Box This volume, §05 

7 Complete Bucket Sensor Calibration This volume, §08 

8 Complete Swing Boom Calibration (if equipped) This volume, §11 

9 Pair Chassis Sensor to the Control Box This volume, §05 

10 Complete Chassis Sensor Calibration This volume, §11 

11 Complete GNSS 3D Calibration This volume, §13 

12 Complete Laser Receiver Calibration This volume, §15–16 

13 Backup the Machine Calibration This volume, §26 

 
Optional calibrations (performed after the main sequence if the machine is equipped): 

•​ Tilt Sensor Calibration — for machines with a tilt bucket (§17) 
•​ Tiltrotator Calibration — for machines with a rotator or tiltrotator (§18–22) 
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Critical: Follow the Sequence in Order 
Each calibration step depends on the accuracy of the steps before it. Do not skip ahead. Do not 
calibrate the GNSS before the boom and stick are calibrated. Do not calibrate the chassis before 
the swing boom (if equipped). The sequence exists because errors compound — a small error in 
boom calibration becomes a large error in GNSS calibration. 
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02  Site Requirements for Calibration 

Calibration requires specific site conditions. If these are not met, the calibration will either fail or produce 
results that degrade field accuracy. 

•​ Firm, level ground — a hard paved surface is strongly recommended. If calibrating on dirt or gravel, 
bring four flat cement pavers to mark bucket-tooth reference points during the GNSS 3D calibration. 

•​ The machine must be level side-to-side. A slight forward or backward tilt is acceptable. 
•​ Full 360° cab rotation clearance without obstruction. 
•​ Full boom, stick, and bucket extension clearance — no overhead wires, fences, or structures. 
•​ For the chassis sensor calibration (tilted method): the machine must be tilted at least 4°. Use the 

blade extended fully down, or position the machine on firm native ground that provides the tilt. 
•​ For the GNSS 3D calibration: the Spotman must be in RTK Fix mode via a local base station. Do 

not perform the GNSS calibration using a Network RTK (NTRIP) solution. 
 

Critical: GNSS Calibration Requires a Local Base Station 
The GNSS 3D calibration must be performed with the Spotman connected to a local base station — 
not an NTRIP network correction service. A local base provides the consistent, low-latency 
corrections required for the centimeter-level accuracy this calibration demands. If you do not have a 
local base station, contact your iDig dealer before attempting the GNSS calibration. 
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03  Creating a New Machine Profile 

Before any sensor pairing or calibration can begin, you must create a machine profile that tells iDig 
Connect what type of machine it is working with, what boom configuration it has, what bucket and coupler 
type are installed, and which optional features (chassis sensor, GNSS, swing boom) are enabled. 

Step-by-Step: Create a New Machine 

1 
From the Settings menu, tap System Settings. 
The System Settings screen opens. 

 

2 
Tap Select or Edit Machines. 
The Select machine/tool screen opens, showing any previously created machine profiles in 
the list. 

 

3 
Tap New Machine. 
The machine type selection screen opens. 

 

4 
Select the machine type: Excavator, Dozer, or Attachment. 
For standard excavator installations, select Excavator. This guide covers the excavator 
calibration workflow. Dozer and Attachment configurations follow a separate procedure. 

 

5 

Select the boom type that matches your machine. 
Choose Single Boom for a standard excavator. Choose 2nd Boom (Knuckle Boom) if the 
machine has a second articulation point on the boom. See Volume 2 Section 10 for how to 
identify which configuration your machine has. 

 

6 

Select the bucket type. 
Choose the type of bucket installed on the machine: standard bucket, tilt bucket, or tiltrotator. 
If selecting Tilt Bucket, you must have purchased and installed a tilt sensor kit. If selecting 
Tiltrotator, the CAN connection must be in place (see Volume 2 Section 09). 

 

7 
Select the coupler type. 
Choose the appropriate coupler for your machine — quick-disconnect, direct pin, or the 
specific coupler model. This selection determines how the bucket calibration is performed. 

 

8 

Select the options that apply to your machine. 
Enable Chassis if you have a BT476 chassis sensor installed. Enable GNSS if you have a 
Spotman receiver. Enable Swing if the machine has a swing boom and you have the CT145 
or BT248 license. Press Apply when all options are selected. 
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9 

The system creates the machine profile and opens the calibration wizard. 
The boom and stick calibration screen appears. Any sensors that are not yet paired will show 
as Missing — this is expected. You are now ready to begin pairing sensors (Section 04) and 
then calibrating (Section 05 onward). 

 
 
 

Critical: Select the Correct Configuration 
The machine profile drives the entire calibration sequence. Selecting the wrong boom type, bucket 
type, or coupler type will produce a calibration that does not match the machine's actual geometry, 
and the resulting guidance will be inaccurate. If you are unsure about any selection, consult your 
iDig dealer before proceeding. 
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04  Pairing Wireless Sensors 

Each wireless sensor (boom, stick, bucket, chassis) must be paired to the Control Box over Bluetooth 
before it can be calibrated. Pairing is done from the calibration screen — when the system shows a 
sensor as "Missing," it is prompting you to pair. 

Step-by-Step: Pair a Sensor 

1 
On the calibration screen, press and hold the Missing button for the sensor you want 
to pair. 
The Pairing Screen appears. 

 

2 
Remove the sensor from its mounting plate. 
Lift the sensor off the plate completely. 

 

3 
Wait 5 seconds. 
The sensor resets its Bluetooth connection during this pause. 

 

4 
Place the sensor back on the plate. 
The sensor re-establishes its Bluetooth connection. The Pairing Screen will show a 
successful pairing. 

 

5 

Review the Sensor Details. 
After pairing, iDig displays the Sensor Details menu where you can verify the sensor's 
battery level, turn the sensor's LED on for identification, and view its attributes. Press Exit 
when satisfied. 

 

6 
Repeat for each sensor that shows Missing. 
Pair the boom, stick, bucket, and chassis sensors in sequence as the calibration procedure 
requires them. 

 
 
 

If a Sensor Does Not Pair 
Verify the BT/WiFi dongle is in the top-left USB port of the cradle. Confirm the sensor has battery 
charge (leave it in direct sunlight for several hours if it has been stored indoors). Try removing and 
replacing the sensor a second time, waiting a full 5 seconds between removal and replacement. 
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05  Boom & Stick Wizard Calibration 

The boom and stick wizard is the core geometric calibration. It teaches the system the lengths and arc 
geometry of the boom and stick by measuring sensor angles at known positions, then verifying those 
measurements against a physical laser reference. This is the most involved step in the calibration 
sequence and typically takes 30 to 45 minutes. 

 
Critical: Do Not Rotate the Cab or Track the Machine 
Throughout the entire boom and stick wizard, only the boom, stick, and bucket may move. Do not 
rotate the cab, track the machine, or allow any ground movement. If the cab rotates or the machine 
moves at any point, the calibration must be restarted from the beginning. 

Prerequisites 

•​ Boom and stick sensors paired (Section 03). 
•​ Calibration toolkit ready: XB525 laser pointer, XD477 tribrach, XD478 laser adapter, XD470 

magnetic laser target, XD471 extension rods, and a tripod. 
•​ Machine RPMs set to maximum to minimize sensor vibration. 

Phase 1: Stick Range and Arc Measurement 

1 
Turn the machine RPMs to maximum. 
Higher RPMs generally produce less vibration on the boom and stick elements, which 
improves sensor readings during calibration. 

 

2 
Press Next. The software measures ambient vibration. 
Do not move the machine while the vibration measurement is being taken. 

 

3 
Gently and smoothly open the stick as far as it will go. Press Open. 
Do not bang the end of the hydraulic cylinder. Operate the stick smoothly. Do not move any 
other element, track the machine, or rotate the cab. 

 

4 
Gently and smoothly close the stick as far as it will go. Press Closed. 
Same caution — smooth operation, no other movement. 

 

5 

Press Click, then Move. Gently move the stick in and out until the progress bar 
completes. 
Do not go all the way open or all the way closed during this step. The software is measuring 
the arc created by the sensor as the stick moves through its range. 
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Phase 2: Boom Range and Arc Measurement 

1 
Press Next. The software measures ambient vibration on the boom sensor. 
Do not move the machine. 

 

2 
Gently raise the boom as far as it will go. Press Opened. 
Smooth operation. Do not bang the cylinder. 

 

3 
Gently lower the boom as far as the ground allows. Press Closed. 
The software takes a measurement at each position. 

 

4 
Press Click, then Move. Gently raise and lower the boom until the progress bar 
completes. 
Do not go to the full extremes during this step. The software is measuring the boom arc. 

 
 

Phase 3: Laser Pointer Measurements (6 Shots — Low Position) 
This phase uses the calibration toolkit to verify the boom and stick geometry against a physical laser 
reference. The laser pointer on the tripod shines a beam at a magnetic target attached to the bucket pin 
(or quick-link pin). 

1 

Attach the XD470 magnetic laser target to the center of the bucket pin (or quick-link 
pin). 
Curl the bucket in and out to identify which pin the bucket rotates around. Place the target on 
the center of that pin. 

 

2 
Set up the tripod under the boom, as close to the cab as possible. 
The tripod must be high enough for the laser beam to hit the target without the bucket hitting 
the ground. Level the tripod. 

 

3 

Screw the XD477 tribrach onto the tripod, then the XD478 laser adapter, then the 
XB525 laser pointer. 
Turn the laser on. Wait for the self-leveling routine to complete — the green light must be 
solid (not blinking) before proceeding. 

 

4 

Inside the cab, bring the stick in close to the cab and lower the boom until the laser 
beam hits the center of the target. Press Next. 
You may need to rotate the laser on the tripod to catch the target. Do not move any part of 
the machine while the software takes the measurement. 
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5 

Repeat for 5 more shots (6 total), extending the boom and stick incrementally. 
Space the 6 shots at approximately equal distances from fully closed to fully extended. The 
final shot (6 of 6) should be with the boom and stick fully extended. Rotate the laser on the 
tripod as needed to catch the target at each position. 

 
 

Phase 4: Laser Pointer Measurements (6 Shots — High Position) 

1 

Without moving the tripod, screw the two XD471 extension rods together and attach 
them between the tribrach and the laser pointer. 
This raises the laser to a higher position. Do not move the tripod — if it moves, the 
calibration must be restarted. 

 

2 
Repeat the same 6-shot procedure at the higher laser position. 
Bring the stick in close, lower the boom to catch the laser, take measurement 1. Then extend 
incrementally for shots 2 through 6, with shot 6 at full extension. 

 
 
After completing all 12 shots (6 low + 6 high), the boom and stick calibration is complete. Press Done to 
review the calibration results. See Section 06 for how to interpret the results. 

 
Rename the Machine Profile After Calibration 
After reviewing the calibration results, press Rename and enter a name that identifies the machine 
— the make, model, and unit number. This profile will be loaded every time the Control Box is used 
on this machine. 
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06  Boom & Stick Calibration — 2nd Boom 

Machines with a second boom (knuckle boom / double-deported arm) follow the same general wizard 
procedure as a standard boom, with two important differences. 

•​ 10/20 laser shots are required instead of 6/12. The additional shots are needed because the 
second boom adds a degree of freedom that must be resolved. 

•​ Significant angle changes between the main boom and the 2nd boom are required after each shot. 
Small angle changes (10–20°) between elements are not sufficient to produce accurate results. 

The goal is to produce significant angular variation across all elements — main boom, 2nd boom, and 
stick — throughout the 10/20 shots. If the calibration produces nonsensical element lengths, the most 
likely cause is insufficient angle variation between shots. 

 
Large Machines (2nd Boom Length 3.65–5.49 m) 
On very large machines, the included extension rods may not provide enough vertical laser height 
difference between the two sets of measurements. In this case, use the magnetic laser mount 
(included in the calibration toolkit) instead of the extension rods on the tripod. The greater the 
vertical difference between the low and high laser positions, the more accurate the results. 

[REVIEW: The detailed shot-by-shot procedure for 2nd boom machines — including recommended 
element positions for each of the 10/20 shots — requires SME input specific to machine size categories. 
The source material (iDig Connect Tutorial - Installation and 2D Calibration) provides guidance in 
Spanish; the English procedure should be confirmed before publication.] 
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07  Calibration Results & Quality Review 

After completing any calibration step, iDig displays the results for review. Press the Calibration Quality 
icon to see the calculated values and quality indicators for each attribute. 

What to Look For 

•​ Calculated element lengths should be within ±10 mm of the known physical measurements. Larger 
deviations indicate a problem with the calibration. 

•​ Each attribute shows a description and likely sources of error when tapped. Review any attribute 
that shows a warning. 

•​ If a result is unacceptable, do not proceed to the next calibration step. Repeat the calibration that 
produced the poor result. 

Laser Height Delta 

On machines where the extension rods were not used (or a custom laser mount was used), the physical 
height difference between the low and high laser positions must be entered manually. The system uses 
this delta to resolve the boom and stick geometry. If you used the standard extension rods, this value is 
calculated automatically. 
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08  Bucket Calibration — Quick Disconnect (Manual Method) 

The bucket calibration teaches the system the geometry of the bucket — how the sensor is oriented on 
the quick-link, and the physical dimensions of the bucket. This calibration is performed after the boom and 
stick calibration. 

Step-by-Step: Bucket Calibration (Quick-Link Sensor) 

1 
In System Settings, select the machine and choose the bucket to calibrate. Select On 
the QuickLink. 
This tells the system the bucket sensor is mounted on the quick-disconnect coupler. 

 

2 
Press Manual Calibration. Turn RPMs to maximum, then press Next. 
The software takes a vibration measurement. Do not move the machine. 

 

3 
Gently open the bucket fully. Press Open. 
Smooth operation. Do not bang the cylinder. Do not rotate the cab or track the machine. 

 

4 
Gently close the bucket fully. Press Closed. 
The software records the range of motion. 

 

5 
Press Click, then Move. Smoothly open and close the bucket until the progress bar 
completes. 
Do not go to the full extremes during this step. 

 

6 

Choose the sensor orientation method — Horizontal or Vertical. 
Horizontal: use the laser pointer on the tripod, place the beam on the center of the quick-link 
pin, then curl the bucket until the beam is on the center of the bucket tip. Vertical: use a 
plumb bob to plumb the center of the quick-link pin with the edge of the bucket. Select the 
method you used, then press Next. 

 

7 
Place the bucket flat on the ground in a floating position. Press Next. 
The bottom of the bucket must be flat on the ground surface. 

 

8 
Measure and enter the distance from the quick-link pin to the cutting edge of the 
bucket. 
Measure accurately and enter the value. Press the green check. 

 

9 
Measure and enter the width of the bucket at the cutting edge. 
Press the green check. The bucket calibration is complete. Press Done. 
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Press the Calibration Quality icon to review the results. When satisfied, press Rename and label the 
bucket by its width and purpose (e.g., "36in Grading" or "24in Trenching"). 
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09  Bucket Calibration — Dogbone (Automatic Method) 

When the bucket sensor is mounted on the dogbone linkage instead of the quick-disconnect, the 
automatic calibration method is required. The calibration routine is more elaborate because the sensor's 
relationship to the bucket cutting edge is more complex in a dogbone mount. 

[REVIEW: The detailed automatic (dogbone) bucket calibration procedure requires SME expansion. The 
source tutorial references the procedure but does not provide the full step-by-step. This section should be 
completed with dealer input before publication.] 
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10  Swing Boom Calibration 

The swing boom calibration teaches the system how the boom swings relative to the cab. This calibration 
must be completed before the chassis sensor calibration. The Swing Boom feature requires either a 
BT248 license or the CT145 license (Connect v5). 

 
Critical: Complete Swing Boom Before Chassis Calibration 
The chassis calibration routine uses data from the swing boom calibration to establish the 
relationship between the boom sensor and the chassis sensor. If you skip the swing boom 
calibration and proceed to chassis, the chassis calibration will not account for the swing and 
accuracy will be compromised. 

Step-by-Step: Swing Boom Calibration 

1 

Enter the AB Forward Shift value. 
Press the Legend button to visualize this measurement. The AB Forward Shift is the 
horizontal distance between the center of the boom pin and the center of the swing rotation. 
Plumb down from the boom pin and measure the horizontal distance from the plumb line to 
the center of the swing rotation. Enter the value and press Start. 

 

2 
Place the blade on the ground to stabilize the machine. 
The machine must not rock during the calibration. 

 

3 
Rotate the cab so it is perfectly square to the tracks with the boom pointing forward. 
Use the front blade as a reference, or a square portion of the cab. The cab must be precisely 
squared. 

 

4 
Bring all elements in close to the cab. Do not move the bucket, stick, or boom 
controls during the rest of the calibration. 
Also do not track the machine or rotate the cab from this point forward. 

 

5 

Align the swing boom perfectly perpendicular to the cab. Mark this position on the 
swing boom and the swing table. 
This mark is a reference for zeroing the swing boom when the feature is disabled. Press 
Next. 

 

6 
Swing the boom all the way to the left. Press Next. 
Be careful not to bang the boom at the end of travel — the force of swinging can cause the 
cab to rotate if you hit the stop too hard. Do not move any other elements. 
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7 
Swing the boom all the way to the right. Press Next. 
Same caution. Wait for the software to complete its measurement at each position. 

 

8 
Press Done to view the calibration results. 
The results show the Forward Shift value you entered, the maximum angle left of center, and 
the maximum angle right of center. 
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11  Chassis Sensor Calibration — Tilted Method 

The chassis calibration teaches the cab-mounted BT476 sensor how it is oriented relative to level. Once 
complete, the sensor continuously measures pitch, roll, and yaw of the machine body, enabling accurate 
guidance on uneven terrain and during cab rotation. 

 
Critical: Machine Must Be Tilted at Least 4° 
The tilted calibration method requires the machine to be tilted a minimum of 4° and remain 
completely stable throughout the procedure. The machine must not move or rock. Use the blade 
extended fully down or position the machine on firm native ground that meets the 4° requirement. 
Avoid relying on hydraulic blade lift alone, as hydraulics can settle over time and cause movement. 

Measurements Required 

Before starting, measure the AB Forward Shift and BC Right Shift of the boom elements relative to the 
center of rotation. You can select your make and model from the loaded machine library, but it is 
recommended to measure and enter the values manually to ensure accuracy. 

Measurement Definition 

AB Forward Shift Horizontal distance from the center of rotation to the center of the 
boom pin. 

BC Right Shift Horizontal distance from the center of rotation to the center of the 
boom, measured perpendicular to AB. 

 

Step-by-Step: Chassis Calibration (Tilted Method) 

1 
Enter the AB Forward Shift and BC Right Shift measurements. Press Start. 
Ensure the machine can rotate 360° without obstruction. 

 

2 
Orient the machine: boom raised, stick all the way in, bucket curled in. 
The center of gravity must be as close to the center of the machine and over the tracks as 
possible. 

 

3 
Rotate the cab so it is perfectly square to the tracks with the boom pointing forward. 
Sight through the front glass to the blade, or use a tape measure to confirm the cab is 
square. 

 

4 
Choose Tilted. Press Next. 
Confirm the machine is tilted at least 4° and is completely stable. 
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5 
Turn RPMs to maximum. Press Next. 
The software measures pitch, roll, yaw, and vibration on the chassis sensor. Do not move the 
machine. 

 

6 
If swing boom is enabled: gently swing the boom all the way to the left. Press Next. 
Do not move any other elements. Wait for the measurement to complete. (If swing boom is 
not enabled, this step is skipped automatically.) 

 

7 

Dynamic rotation — clockwise: press Next, then smoothly rotate the cab clockwise at 
full speed for 2 complete rotations. 
Continue rotating at full speed until the progress bar completes. Do not attempt to stop 
exactly where you started — rotate through the starting point. 

 

8 
Return the cab to perfectly square, boom forward. 
Then press Next for the counterclockwise rotation. 

 

9 
Dynamic rotation — counterclockwise: smoothly rotate the cab counterclockwise at 
full speed for 2 complete rotations. 
Continue until the progress bar completes. Return the cab to square, boom forward. 

 

10 

Static rotation — 6 positions at 60° intervals: press Next to begin. 
The software displays a target position. Rotate the cab clockwise until the silhouette of the 
boom, stick, and bucket is perfectly aligned on the target. The silhouette must be crisp, not 
blurry. Press Next and do not move until the measurement completes. Repeat for all 6 
positions (full 360°). 

 

11 
Press Done to view the calibration results. 
Press the Calibration Quality icon to review. When satisfied, press OK. 

 
 
 

Getting Clean Static-Rotation Readings 
The silhouette alignment is the most precision-critical step in the chassis calibration. Rotate slowly 
and stop precisely on the target. If the silhouette appears blurry, the cab needs to rotate slightly 
further. The silhouette must be perfectly crisp and centered on the target before pressing Next. 
Maximum RPMs reduce sensor vibration and produce cleaner silhouettes. 
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12  Chassis Sensor Calibration — Non-Tilted Method 

The non-tilted method is available only when the BT476 chassis sensor is installed flat with its arrows 
pointing forward, parallel to the boom. This method sacrifices accuracy compared to the tilted method and 
should only be used when the machine cannot be tilted at least 4° during calibration. 

The procedure is identical to the tilted method (Section 10) except that the tilt setup step is skipped — you 
select Non-Tilted instead of Tilted at the prompt. The dynamic rotation (2× clockwise, 2× 
counterclockwise) and static rotation (6 × 60° stops) steps are the same. 

[REVIEW: Confirm with SME that the only procedural difference between tilted and non-tilted is the skip of 
the tilt setup step, and that the remaining dynamic/static rotation procedure is identical.] 
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13  GNSS 3D Calibration 

The GNSS 3D calibration establishes the relationship between the Spotman receiver's position on the 
machine and the bucket tip. This calibration is required for 3D mode and for 2D+ mode when using the 
GNSS as the vertical reference. 

 
Prerequisites 
An accurate boom, stick, and bucket calibration must be completed first — any error in those 
calibrations will compound through the GNSS calibration. The Spotman must be in RTK Fix mode 
via a local base station. The bucket must have a straight cutting edge, and you must mark the exact 
center of the bucket with a marker. 

Step-by-Step: GNSS 3D Calibration 

1 

Select the receiver model: Bridgin, CT140T. The Internal Antenna Height populates 
automatically. 
This must be correct — the software uses the antenna height to offset from the receiver to 
the phase center. 

 

2 
Enter the rod length of your survey rod (e.g., 6.562' = 2 meters). Press Start. 
Confirm the correct machine and bucket are selected. 

 

3 
Rotate the cab perfectly square to the tracks. Boom forward. Press OK. 
Bring the boom, stick, and bucket in close to the machine so the center of gravity is over the 
center of rotation. 

 

4 
Screw the Spotman onto the mount on the machine. Confirm RTK Fix. Press Next. 
Turn RPMs to maximum. Press Next. The software takes a measurement — do not move. 

 

5 
If swing boom is enabled: swing the boom all the way to the left. Press Next. 
Do not move any other elements. Wait for the measurement. (Skipped if no swing boom.) 

 

6 
Static rotation — 6 positions at 60° intervals. 
Same procedure as the chassis calibration: rotate cab clockwise to align the silhouette on 
each target, press Next, do not move until measurement completes. 

 

7 
Mark the center of the bucket with a marker. 
If the bucket has teeth, use tape and a marker to find and mark the exact center. 
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8 

With the cab square to the tracks, fully extend the boom and stick and place the 
bucket on the pavement (or paver). Mark a crow's foot on the ground at the center of 
the bucket. Press Next. 
Accuracy is critical — you will measure this exact spot with the GNSS rod. Do not move any 
part of the machine while the software takes the measurement. 

 

9 
Repeat: bring the bucket in approximately 30% of total reach, place on the ground, 
mark a crow's foot. Press Next. 
Do not rotate the cab, track the machine, or swing the boom for the rest of the calibration. 

 

10 
Repeat: bring the bucket in another 30%. Mark and measure. Press Next. 
Continue the pattern — each position is progressively closer to the machine. 

 

11 
Bring the bucket in as close to the machine as possible. Mark the final crow's foot. 
Press Next. 
You now have 4 crow's-foot marks on the ground at different reaches. 

 

12 
Rotate the cab out of the way. Remove the Spotman from the machine and screw it 
onto the 2-meter survey rod. 
Attach bipod legs for stability. 

 

13 
Place the rod on the 1st crow's-foot mark (furthest from machine). Plumb the rod. 
Press Next. 
Do not let the rod move until the measurement completes. 

 

14 
Repeat for the 2nd, 3rd, and 4th marks. 
Plumb the rod perfectly on each mark. Press Next at each position and wait for the 
measurement. 

 

15 
Press Done to view the calibration results. 
Press the Calibration Quality icon to review. See Section 13 for the meaning of each quality 
indicator. 
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14  GNSS Calibration Report Explained 

The GNSS calibration report contains a number of quality indicators. Each measures a specific aspect of 
the calibration. The table below lists the indicators and what they measure. 

Indicator What It Measures 

alignmentImuGpsRms RMS error between the IMU (chassis sensor) and GPS 
measurements during calibration. 

armPRms RMS error in the arm (boom/stick) positioning during 
stretching. 

imuGyroRotationRms RMS error in the gyroscope rotation measurement during 
dynamic rotation. 

imuDt Time synchronization between IMU data packets. High values 
indicate Bluetooth data loss. 

imuLoss Percentage of IMU data packets lost during calibration. 
Should be near zero. 

gpsAfterStretching GPS position accuracy after the stretching 
(bucket-placement) step. High values indicate the machine 
moved during stretching. 

gpsPositionR2 R-squared fit of the GPS positions measured during 
calibration. Should be near 1.0. 

gpsRotationRms RMS error in GPS-measured heading during dynamic 
rotation. 

gpsDt Time synchronization between GPS data packets. 

gpsLoss Percentage of GPS data packets lost during calibration. 
Should be near zero. 

gpsAndBucketStretchingDiff Difference between GPS-computed and sensor-computed 
bucket positions. Should be small. 

 
Press on any indicator title in the software to see a detailed description and likely sources of error. If any 
indicator shows red, do not proceed — diagnose and repeat the calibration step that produced the error. 
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15  Laser Receiver Calibration — Manual Method 

The laser receiver calibration tells the system exactly where the combo sensor's built-in laser receiver is 
located relative to the stick. This is required for 2D elevation referencing using a rotating laser. 

Step-by-Step: Manual Laser Receiver Calibration 

1 
Go to Settings > System Settings > Select or Edit Machines. Highlight the machine 
and press Edit Machine Parameters. 
Press the Laser tab to access the laser receiver calibration values. 

 

2 
Ensure the Laser Receiver checkbox is activated. 
The checkbox must be checked for the laser receiver to be active. 

 

3 
Set up a string line between the bucket pin and the stick pin using magnetic hooks. 
The string must be taut. 

 

4 
Measure the AB value: the perpendicular distance from the taut string line to the 
center of the combo sensor's laser receiver. 
Enter this in the AB Length field. 

 

5 
Measure the AC value: the distance along the string line from the center of the stick 
pin to the point perpendicular to the sensor center. 
Enter this in the AC Length field. 

 

6 
Measure the Side Shift Laser value: standing underneath the boom with your back to 
the cab, measure from the center of the stick to the outside of the combo sensor. 
Enter this in the Side Shift Laser field. Press Apply. 

 
 
Note: the Side Shift Laser value is half of the thickness of the dipperstick plus the sensor thickness. 
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16  Laser Receiver Calibration — Wizard Method 

The wizard method automates the laser receiver calibration using a rotating laser transmitter. The rotating 
laser must be set to operate at a minimum of 600 RPMs. 

Step-by-Step: Wizard Laser Receiver Calibration 

1 
Go to Settings > System Settings > Laser > Calibrate. 
Acknowledge the instructions by pressing OK. 

 

2 
Choose iDig Combo Sensor as the sensor type. 
Unless you are using a third-party laser receiver. 

 

3 
Turn the excavator RPMs to maximum. 
Reduces vibration on the sensor during the procedure. 

 

4 
Bring the stick in close to the machine. Lower the boom until the laser receiver 
catches the rotating laser. Press Closed. 
The green indicator confirms a quality laser strike. 

 

5 

Without moving the boom, extend the stick away from the machine until the laser 
receiver catches the laser again. Press Opened. 
The boom angle indicator must stay green. If it turns red, adjust the boom angle to green 
before moving the stick. 

 

6 
Place the rotating laser beam on the exact center of the bucket pin. Press Laser. 
You need the rotating laser's own receiver to place the beam precisely on the pin center. 

 

7 
Press Done. 
The wizard calibration values are now computed. 

 

8 
Measure and enter the Side Shift Laser value. 
Standing underneath the boom with your back to the cab, measure from the center of the 
stick to the outside of the combo sensor. Enter the value and press OK. 
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17  Tilt Bucket Calibration 

Machines equipped with a tilt bucket require a separate tilt sensor calibration after the standard bucket 
calibration is complete. The tilt sensor (an additional BT144 Mini Sensor mounted on the tilt bucket) must 
be paired and calibrated so the system can track the tilt angle independently. 

[REVIEW: The detailed tilt bucket calibration procedure requires SME content. This section is a 
placeholder and should be completed before publication.] 
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18  Tiltrotator Calibration — Universal Procedure 

This calibration procedure applies to all supported rotator and tiltrotator brands (Engcon, Kinshofer NOX, 
Rototilt, Steelwrist). Before running this procedure, the CAN cable must be connected between the 
rotator's cabin module and the iDig cradle's CAN port, and CAN data must be confirmed flowing in Basic 
Settings > Wired Sensors > CAN. 

Step-by-Step: Tiltrotator Calibration in iDig 

1 
Confirm CAN data is being received. 
Navigate to Basic Settings > Wired Sensors > CAN. You should see live rotation data from 
the rotator. If not, troubleshoot the CAN connection (see Volume 2 Section 09). 

 

2 
Navigate to System Settings > Rototilt > Calibrate. 
The tiltrotator calibration screen opens. 

 

3 
Leave the type set to Custom. 
This applies to all supported brands. 

 

4 
Enter the AC measurement. 
Measure from the rotator's center of rotation to the center of the pin on the rotator's quick 
attachment. Enter the value. 

 

5 
Set the Sensor Gain to 1. 
The default gain of 1 is correct for initial calibration. If drift is observed after field use, see 
Section 22 for how to calculate and correct the gain. 

 

6 
Set the zero values for tilt and rotation. 
Follow the on-screen prompts to establish the zero reference for both axes. 

 
 

 

iDig North America  |  Page 109 



iDig Connect User Guide 

19  Brand-Specific Tiltrotator Setup — Engcon 

Engcon tiltrotators require specific CAN configuration depending on the ePS version. The Engcon 
CAN-2-CAN cable connects the Engcon cabin module to the iDig cradle. The CAN-2-CAN firmware must 
be current — update it using the Engcon MSU software if needed. 

•​ ePS Version 1: standard CAN output. Connect the CAN-2-CAN cable and verify data in Wired 
Sensors > CAN. 

•​ ePS Version 2: requires Legacy Mode to be enabled in the Engcon ePS Micro Conf configuration 
before CAN output is available to iDig. 

•​ On EPS2-equipped machines, iDig reads both rotation and tilt data from the CAN bus. 
After the CAN connection is confirmed, proceed with the universal tiltrotator calibration in Section 17. 
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20  Brand-Specific Tiltrotator Setup — Kinshofer NOX 

Kinshofer NOX tiltrotators require a Grade Control License purchased from Kinshofer and installed on the 
NOX Cabin Module before the module will output rotation data via CAN. This is a separate license from 
any iDig license. 

•​ Install the Grade Control License by inserting the Mini-to-USB adapter (provided by Kinshofer) into 
the back of the NOX Cabin Module and running the license installer. 

•​ In the NOX Cabin Module settings (accessed via the hidden button in Settings > Info for Advanced 
Settings), set Grade Control to the "Leica" protocol. 

After the Grade Control License is installed and the protocol is set, connect the CAN cable from the NOX 
Cabin Module to the iDig cradle, verify data in Wired Sensors > CAN, and proceed with the universal 
calibration in Section 17. 
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21  Brand-Specific Tiltrotator Setup — Rototilt 

[REVIEW: Rototilt brand-specific CAN configuration and wiring prerequisites require SME input. The 
iDig-side calibration is covered in Section 17.] 
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22  Brand-Specific Tiltrotator Setup — Steelwrist 

[REVIEW: Steelwrist brand-specific CAN configuration and wiring prerequisites require SME input. The 
iDig-side calibration is covered in Section 17.] 
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23  Sensor Gain Explained 

Rotation sensor gain compensates for small mechanical inaccuracies in the rotator's CAN output. Over 
many rotations, a gain error causes the displayed rotation angle to drift away from the actual rotation 
angle. 

How to Detect Drift 
Mark a reference point on the rotator and the machine frame. Rotate the rotator exactly 10 full turns 
(3,600°). If the mark is off by 1° after 10 rotations, the drift rate is 0.1° per turn. 

How to Calculate the Correction 

Divide the drift per turn by 360° to get the gain offset. For 0.1° per turn: 0.1 / 360 = 0.000277. If the rotator 
drifted past the reference (over-rotated), subtract: gain = 1.0 − 0.000277 = 0.99972. If the rotator fell short 
(under-rotated), add: gain = 1.0 + 0.000277 = 1.00028. Enter the corrected gain in the tiltrotator 
calibration screen. 
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24  Post-Calibration Accuracy Checks — 2D 

After completing the boom, stick, and bucket calibration, verify the system's accuracy before proceeding 
to the GNSS 3D calibration. The 2D calibration must be accurate to within ±3/8" (±1 cm) before the 3D 
calibration is performed — errors in 2D compound through 3D. 

Checks to Perform 

•​ Place the bucket on a reference point with the bucket fully open. Note the displayed depth. Then 
curl the bucket closed and check the depth again — both readings should match within ±3/8". 

•​ Measure the height of the bucket cutting edge with a tape measure and compare to the iDig display. 
•​ Measure the distance between two ground points with a tape measure and compare to the iDig 

Smart Tape measurement. 
 

Do Not Proceed to 3D Calibration Until 2D Accuracy Is Confirmed 
If the 2D accuracy check shows errors greater than ±3/8", the boom and stick or bucket calibration 
must be repeated. Proceeding to the GNSS 3D calibration with a poor 2D calibration will produce 
poor 3D results that are difficult to diagnose. 
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25  Post-Calibration Accuracy Checks — 3D 

After completing the GNSS 3D calibration, verify the system's 3D accuracy before putting the machine 
into production. 

Checks to Perform 

•​ Rotate the machine 360° and place the bucket on the ground at several headings. Measure each 
point with the Spotman on the survey rod and compare the coordinates to the iDig-displayed 
coordinates. 

•​ Create a surface by measuring points at full reach, mid reach, and close reach at multiple headings. 
Compare the resulting surface elevations to independent survey measurements. 

•​ Place the bucket on a known survey control point. Enter the control point's coordinates in iDig and 
use the stakeout function — the displayed cut/fill should be near zero. 
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26  Backing Up the Machine Calibration 

After completing calibration, back up the machine's calibration data to a USB stick. This backup is 
essential — if the Control Box is damaged, lost, or needs to be swapped, the calibration can be loaded 
onto a replacement Control Box without recalibrating the machine. 

Step-by-Step: Export Calibration to USB 

1 
Plug a USB stick into one of the available USB ports on the cradle. 
The BT/WiFi dongle remains in the top-left port. 

 

2 
In the Settings menu, select System Settings. 
Then press Select or Edit Machines. 

 

3 
Press Edit Machine Parameters. 
Ensure the correct machine is selected (shown at the top of the screen). 

 

4 
Press Export, then Export this Machine. 
The system writes a .json file to the USB stick. 

 

5 
Verify the export. 
The USB stick now contains a folder named CBXXXXXX iDig Connect Data (where XXXXXX 
is your Control Box serial number). Inside is a .json file for each machine you exported. 

 
 

Alternative: Export as QR Code 

Press Export, then Export as QR Code. The Control Box displays a QR code that you can scan with your 
phone to download the .json calibration file directly. This is a fast way to get a backup onto your phone 
without a USB stick. 

 
Back Up After Every Calibration 
Make it a habit to export the calibration to USB and to your phone (via QR code) immediately after 
completing any calibration. A calibration backup takes 30 seconds and can save hours of 
re-calibration if the Control Box is ever damaged or replaced. 
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27  What's Next 

With Volume 4 complete, the machine is fully calibrated — boom, stick, bucket, chassis sensor, GNSS 
receiver, laser receiver, and any tiltrotator. The calibration is backed up to USB and phone. The machine 
is ready for field operations. 

Volume 5: Settings & Configuration 

Volume 5 covers all Settings menu options — language, units, sound, sensors, GNSS, Restrictive Mode, 
display, storage, LED Bargraph configuration, audible alerts, joystick buttons, and import/export. 

Volume 8: Field Operations 

Volume 8 covers daily operating procedures for 2D, 2D+, 2D Project, and 3D modes — including 
Dynamic Laser Catch, Swing Boom operation, Smart Tape, Height Alarm, surface creation, and the daily 
3D workflow. 

Need Help? 

Contact your iDig dealer for assistance with calibration, accuracy issues, or any step in this volume. For 
real-time support, use the Remote Access feature described in Volume 1 Section 09.  
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01  Navigating the Settings Menu 

The Settings menu is accessed from the work screen by tapping anywhere on the screen to reveal the 
toolbars, then tapping the Settings icon. The Settings menu contains four top-level categories. 

Category What It Contains 

Basic Settings Language, units, time zone, wireless sensor management, GNSS receiver, 
Restrictive Mode, display brightness, idle time, and storage management. 

System Settings Machine profiles, calibration data, and machine-level configuration. This is 
where you create new machines, edit calibration parameters, and export 
calibration files. 

Work Settings LED Bargraph configuration, audible alerts, and bucket logger settings. 
These control how the system communicates guidance to the operator 
during fieldwork. 

Remote Access Wi-Fi connection, remote support sessions, and the Get Support function 
for dealer assistance. Covered in detail in Volume 1 Section 09. 

 
This volume covers Basic Settings and Work Settings in detail. System Settings (machine profiles and 
calibration) are covered in Volume 4. Remote Access is covered in Volume 1. 
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02  Language & Units Configuration 

Language and units are set during initial power-on (Volume 1 Section 05) and persist across reboots. 
They can be changed at any time from Basic Settings, but changing units after calibration does not 
invalidate the calibration — it changes how the values are displayed, not the underlying data. 

Settings 

Setting Options Guidance 

Language English, French, 
Spanish, German, 
and others 

Select the operator's preferred language. All menus, 
prompts, and on-screen text change immediately. 

Time Zone System time zones 
(e.g., 
America/Denver, 
America/Chicago) 

Match the time zone to the machine's operating 
location. Affects timestamps on data exports and 
calibration logs. 

Length Units US Survey Feet, 
International Feet 
(Imperial), Meters 

Must match the project coordinate system. US 
Survey Feet is standard for most US state plane 
projects. International Feet (decimal feet) is used on 
some projects — confirm with your project engineer. 
Metric is also available. 

Slope Units Percent (%), 
Degrees, Per-mille 

Percent is standard for US construction. Some 
highway and rail projects use degrees or per-mille — 
match your design documents. 

Heading 
Convention 

Degrees Degrees is standard for US construction. 

Coordinate 
Convention 

North / East / 
Elevation 

For US construction work, set to North / East / 
Elevation. This matches the convention used by 
surveyors and most civil engineering output, 
including iPoint. 

 
 

Critical: Match Length Units to Your Project Before Calibrating 
Length Units affect every measurement the system displays — depth, reach, slope distance, 
coordinates, and calibration values. If you calibrate in meters and then switch to US Survey Feet, 
the on-screen values change but the underlying calibration data is unchanged. The unit setting 
drives how the data is interpreted, not the data itself. Set units correctly before beginning calibration 
in Volume 4. 
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03  Sound Settings 

Sound settings control the system's global volume level and tone for all audible alerts. The settings are 
accessed from Basic Settings. 

•​ Volume level — adjustable from off to maximum. Set the volume high enough to hear over engine 
noise and cab vibration. 

•​ Tone — adjustable pitch. Some operators prefer a lower tone that is less fatiguing over a full shift; 
others prefer a higher tone that cuts through cab noise more effectively. 

•​ Disable sound — turns off all audible feedback. The LED Bargraph and on-screen indicators 
continue to function normally. Use this when the operator relies entirely on visual guidance. 

Individual alert sounds (depth alarm, reach alarm, laser catch, sensor loss) are configured separately in 
Work Settings > Audible Alerts (Section 10 of this volume). 

 

iDig North America  |  Page 122 



iDig Connect User Guide 

04  Wireless Sensor Management 

The Wireless Sensor Management screen shows every sensor currently paired to the Control Box. It is 
accessed from Basic Settings > Wireless Sensors. 

Information Displayed 

Field Description 

Sensor Name The sensor type and location (e.g., Boom, Stick, Bucket, Chassis). 

Battery Level Current battery charge. Sensors with low battery should be left in direct 
sunlight to charge via the built-in solar cell. 

Bluetooth Signal Strength The strength of the Bluetooth connection between the sensor and the 
Control Box. 

Angle Data The current angle reading from the sensor. 

Vibration Range The allowable vibration range for the sensor. This can be adjusted 
from this screen if the sensor is producing vibration warnings during 
operation. 

 

Pairing a Sensor 

To pair a sensor, enter the pairing screen for the desired sensor slot, remove the sensor from its mounting 
plate, wait 5 seconds, and place it back on the plate. The system detects the sensor and completes the 
pairing. For the full pairing procedure, see Volume 4 Section 04. 

Sensor Information 

Press the ? icon next to any sensor to view its detailed attributes — firmware version, serial number, 
hardware revision, and other diagnostic information. This information is useful when contacting your iDig 
dealer for support or warranty service. 
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05  GNSS Receiver Settings 

The GNSS Receiver settings screen is accessed from Basic Settings > GNSS Receiver. This is where the 
Spotman receiver is paired to the Control Box and where the connection status is monitored. 

Connecting a GNSS Receiver 

The pairing process uses two tabs: the Other tab (which scans for available receivers) and the Known 
GNSS tab (which stores previously paired receivers). Once a receiver appears in the Other tab, tap it to 
move it to the Known GNSS tab. Then highlight it, tap the ! icon, and select Connect. The full pairing 
procedure is covered in Volume 3 Section 13. 

Verifying the Connection 

After connecting, tap the Data tab. The Correction field should show RTK_Fix, confirming the receiver is 
connected, receiving corrections, and delivering position data to the Control Box. If it shows Float, 
Autonomous, or no data, troubleshoot the GNSS connection per Volume 3 Section 16. 
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06  Restrictive Mode (Password Protection) 

Restrictive Mode protects the machine calibration data and system configuration from accidental 
modification. When enabled, a password is required to access machine parameters, calibration data, and 
certain system settings. Day-to-day operating functions remain accessible without the password. 

What Restrictive Mode Protects 

•​ Machine calibration data — prevents accidental deletion or modification of calibrated machine 
profiles. 

•​ System Settings — machine profiles, sensor configuration, and calibration parameters become 
read-only. 

•​ Certain Basic Settings — settings that would affect calibration or system behavior are locked. 

What Remains Accessible 

•​ All work-screen functions — the operator can dig, grade, measure, and use all field tools normally. 
•​ Work Settings — LED Bargraph, audible alerts, and display preferences can still be adjusted. 
•​ Project loading and switching — operators can load projects, import files, and switch between 

machines and buckets. 

Setting the Password 

Navigate to Basic Settings > Restrictive Mode. Enter a password and confirm it. The password takes 
effect immediately. Share the password only with personnel who need to modify calibration data or 
system configuration. 

 
Critical: Record the Password 
If the Restrictive Mode password is lost, contact your iDig dealer for the recovery procedure. Do not 
attempt to reset the Control Box to bypass the password — this will erase calibration data. 
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07  Display Settings 

Display settings control the screen brightness and idle behavior. These are accessed from Basic Settings. 

Setting Description 

Screen Brightness Adjustable from low to maximum. Increase brightness for direct 
sunlight; decrease for night or covered-cab work to reduce glare. 

Idle Time / Sleep Mode Sets the duration of inactivity before the screen dims or enters sleep 
mode. A shorter idle time saves battery on bench-powered systems. A 
longer idle time keeps the screen visible during breaks without 
requiring the operator to touch the screen. 
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08  Storage Management 

The Storage screen is accessed from Basic Settings > Storage. It provides three functions. 

•​ View disk space — see how much storage is available on the Control Box for projects, designs, and 
calibration data. 

•​ Erase files — remove individual files or clear storage to free space. Use caution — deleted files 
cannot be recovered from the Control Box. 

•​ Cloud File Access — configure and verify the cloud connection for accessing files from Google 
Drive, Dropbox, or OneDrive. The initial cloud setup (using RCX Clone) is covered in Volume 1 
Section 10. 

The Internet Connection Status indicator at the bottom-left of the Storage screen shows a green 
checkmark when the Control Box has an active cloud connection. 
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09  Work Settings — LED Bargraph Configuration 

The LED Bargraph configuration is accessed from Settings > Work Settings. This screen controls how the 
in-cab LED bar displays guidance information to the operator. 

Setting Description 

LED Resolution The distance each LED represents. For example, a resolution of 10 cm 
means each LED corresponds to 10 cm of depth. Tighter resolution (e.g., 5 
cm) is appropriate for finish grading; wider resolution (e.g., 20 cm) is 
appropriate for bulk excavation. 

Deadband The tolerance zone around the target where the LEDs turn green. Options: 
Off, 0.5 cm, 1.0 cm, 2.5 cm. When the bucket focus point is within the 
deadband distance of the target depth, the LEDs are green — the operator 
is on grade. 

Vertical LEDs Represent Depth by default. Each vertical LED corresponds to one 
increment of the configured resolution above or below the target. 

Horizontal LEDs Represent Reach by default. Configured independently from the vertical 
LEDs. 

Time Filtering Smooths the LED display to reduce flicker from vibration. Disabled by 
default. 

 
 

Real-World Example: Configuring for Foundation Work 
For a residential foundation at a target depth of 4 feet, set the LED Resolution to 10 cm (about 4 
inches per LED) and the Deadband to 2.5 cm (about 1 inch). This gives the operator a clear visual 
reference — one LED per 4 inches of depth — and a green zone within an inch of grade. The 
operator digs until the LEDs are green and holds there. 
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10  Work Settings — Audible Alerts 

Audible alerts are configured from Settings > Work Settings > Audible Alarm. Each alert type can be 
configured independently — the operator selects the tone, loudness, and the distance range at which the 
sound changes. 

Alert Types 

Alert What It Indicates 

Depth Alarm Sounds as the bucket approaches the target depth. The tone and volume 
change as the bucket gets closer, providing audio-only guidance without 
looking at the screen. 

Reach Alarm Sounds as the bucket approaches the maximum configured reach distance. 

Laser Catch Sounds when the combo sensor on the stick catches the rotating laser 
beam, confirming the system has an elevation reference. 

Elevation Alarm Sounds when the bucket reaches a user-defined elevation. Used for utility 
avoidance or depth limits. 

Sensor Loss Sounds when a sensor loses its Bluetooth connection to the Control Box. 

Collision Sounds when the bucket approaches an avoidance zone boundary. 

 
For each alert, the operator configures which tone to use, the loudness level, and the distance ranges at 
which the tone changes. This allows the operator to distinguish between different alerts by sound alone — 
a lower tone for depth, a higher tone for reach, a distinctive chirp for laser catch. 

 
Real-World Example: Audio-Only Guidance for Trenching 
An experienced operator trenching a storm sewer at −3% slope may configure the depth alarm to 
change pitch at 6 inches above grade, 3 inches above grade, and on grade. The operator can hold 
the trench bottom within tolerance by sound alone — eyes on the trench, not the screen. 
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11  Joystick Button Configuration 

With the BT248 license or the CT145 license (Connect v5), iDig Connect can integrate with the machine's 
joystick buttons. This allows the operator to toggle the Swing Boom function, adjust bench height, and 
trigger Set Benchmark directly from the joystick — without reaching for the touch screen. 

License Activation 

The joystick button feature requires a license. Activate it from Settings > Import/Export > License 
Manager, using the same procedure as any other feature license (see Volume 1 Section 06). 

Button Mapping 

The specific joystick buttons that map to iDig functions depend on the machine's make and model. iDig 
Connect detects the available buttons and presents the mapping options in the configuration screen. 
Contact your iDig dealer for the button mapping specific to your machine. 

[REVIEW: Joystick button configuration screens and specific button-to-function mappings require SME 
input for each machine make/model. The feature is confirmed; detailed setup screens should be 
documented before publication.] 
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12  Import/Export Settings 

The Import/Export menu is accessed from Settings > Import/Export. It provides access to license 
management, machine calibration import/export, project import/export, language import, manufacturer 
import, and boot screen customization. 

Key Functions 

Function Description 

License Manager Activate 120-day trial licenses, import purchased .lic files from USB. See 
Volume 1 Section 06. 

Machine Import / 
Export 

Import a machine calibration .json file from USB (to load a calibration from 
another Control Box) or export the current machine calibration to USB for 
backup. See Volume 4 Section 26. 

Project Import / 
Export 

Import or export complete projects including coordinate systems, layers, 
and design data. See Volume 7 Section 10. 

Language Import Import additional language packs from USB if needed. 

Manufacturer Import Import manufacturer-specific machine templates or configurations from 
USB. 

Boot Screen Customize the boot screen image displayed when the Control Box starts 
up. 
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13  What's Next 

With Volume 5 complete, the operator understands every setting available in iDig Connect — from 
language and units through LED Bargraph configuration and audible alerts. The system is configured for 
the operator's preferences and ready for daily use. 

Volume 6: Settings & Configuration 

Volume 6 covers the work screen interface for both 2D and 3D operation — screen layouts, toolbars, icon 
reference, guidance modes, surface offset, and zoom controls. 

Volume 7: Projects, Coordinate Systems & Data Management 
Volume 7 covers creating projects, loading coordinate systems and geoids, importing design files, 
managing layers, and the Coordinate Shift tool. 

Need Help? 

Contact your iDig dealer for assistance with any setting or configuration. For real-time support, use the 
Remote Access feature described in Volume 1 Section 09.  
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01  2D Work Screen Overview 

The 2D work screen is the operating interface for iDig Connect 2D+ and 2D Project systems. It provides 
depth, reach, and slope guidance using either a rotating laser or the Spotman GNSS receiver as the 
elevation reference. The 2D work screen is simpler than the 3D interface — it uses a single Side View by 
default and a focused set of tools for bench-based excavation work. 

Key Elements on the 2D Work Screen 

Element Description 

Machine Visualization A side-view profile of the machine showing the boom, stick, and bucket 
against the target depth. The visualization updates in real time as the 
operator moves the machine. 

Depth Display The vertical distance between the bucket's focus point and the current 
bench or target surface. This is the primary guidance value in 2D 
mode. 

Reach Display The horizontal distance from the machine's center of rotation to the 
bucket tip. 

Slope Display The current slope of the bucket's cutting edge, displayed as a 
percentage. 

LED Bargraph The in-cab LED bar corresponds to the depth display. Each LED 
represents a configurable distance increment (e.g., 10 cm per LED). 
The LEDs turn green when the bucket focus point is within the 
deadband — the tolerance zone around the target depth (e.g., ±2.5 
cm). 

Bench Method Icon Toggles between Laser and GNSS as the elevation reference source. 
In Laser mode, the system uses the rotating laser beam caught by the 
combo sensor on the stick. In GNSS mode, the system uses the 
Spotman receiver for elevation. 

2D / 3D Toggle Switches between 2D operating mode and 3D mode (if the system is 
licensed for 3D). Located at the bottom-left of the work screen. 

 
 

iDig North America  |  Page 134 



iDig Connect User Guide 

02  Bench Method — Laser vs. GNSS 

In 2D mode, the system needs an elevation reference — a known height to measure depth from. iDig 
Connect supports two bench methods. 

Laser Reference 

The system uses the rotating laser beam caught by the combo sensor (BT145 or BT147) on the stick. The 
operator sets up a rotating laser on a tripod, catches the beam, and the system uses that laser height as 
the elevation reference. This is the traditional method for 2D excavation — no GNSS required. 

GNSS Reference (2D+ and 2D Project) 
With a Spotman GNSS receiver connected and in RTK Fix, the operator can use the GNSS position as 
the elevation reference instead of a laser. The advantage is that the operator can track the machine 
across the site without re-benching — the GNSS provides a continuous elevation reference wherever the 
machine moves. To set the bench elevation, place the bucket focus point on a project benchmark, enter 
the known elevation, and press Apply. 

 
When to Use Each Method 
Use Laser reference when working on a site with a rotating laser already set up — foundation work, 
utility trenching near a benchmark, or any confined area where the laser covers the work zone. 
Switch to GNSS reference when tracking across a larger site, when the laser cannot cover the full 
work area, or when working in 2D+ mode with the Spotman providing continuous elevation. 
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03  2D Tool Reference 

The 2D work screen toolbar provides a focused set of tools for bench-based excavation. The toolbar is 
accessed by tapping the work screen, the same as in 3D mode. 

Tool Function 

Bench Method (Laser / 
GNSS) 

Toggle the elevation reference between the rotating laser and the 
GNSS receiver. 

Set Depth Set a target depth for level grading. Place the bucket on a known 
reference point, enter the desired cut depth, and apply. The system 
creates a flat target surface at that depth. 

Set Depth & Slope Set a target depth and slope for graded work such as utility trenching 
or drainage. Enter the slope as a percentage (negative = downward 
from the bucket toward the cab). Choose the slope direction: along the 
boom axis, by measuring two points, or by entering an azimuth or 
bearing. 

Smart Tape Measure the horizontal distance, slope distance, and elevation 
difference between two points. Tap the field once to reset the digital 
tape measure, then move the bucket to the second point. 

Elevation Alert Set an alarm at a defined elevation to prevent over-digging or to warn 
near buried utilities. 

Sensor Info View sensor battery level, angle data, and vibration range. 

Attachment List Switch between calibrated buckets. 

Bucket Focus Point Toggle between closest-edge-to-design guidance (default) and 
three-point (left/center/right) guidance. 

2D / 3D Toggle Switch to 3D mode if the system is licensed and calibrated for 3D. 

Settings Access Open the Settings menu from the work screen. 
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04  LED Bargraph Configuration 

The LED Bargraph is the primary visual guidance tool in 2D mode. Each LED represents a configurable 
distance increment, and the color-coded display tells the operator at a glance whether the bucket is 
above, below, or on grade. 

Configuring the Bargraph 

Navigate to Settings > Work Settings. The LED Display configuration screen provides the following 
settings. 

Setting Description 

LED Resolution The distance each LED represents. For example, 10 cm per LED means 
each LED on the bargraph corresponds to 10 cm of depth. Adjust this 
based on the precision required — tighter resolution for finish grading, 
wider resolution for bulk excavation. 

Deadband The tolerance zone around the target depth where the LEDs turn green. 
Options: Off, 0.5 cm, 1.0 cm, 2.5 cm. A 2.5 cm deadband means the LEDs 
are green when the bucket is within ±2.5 cm of the target. For finish 
grading, use a tighter deadband. 

Mode Request mode (Depth, Reach, etc.) and Current mode. The vertical LEDs 
typically represent Depth; horizontal LEDs represent Reach. 

Time Filtering Smooths the LED display to reduce flicker caused by vibration. Disabled by 
default. Enable if the LEDs are jumping rapidly during operation. 

 
 

Real-World Example: Setting Up for Utility Trenching 
For a storm sewer trench at −3% slope to a depth of 4 feet, set the LED Resolution to 5 cm (about 2 
inches per LED) and the Deadband to 1.0 cm. This gives the operator enough resolution to hold the 
trench bottom within half an inch of design while keeping the LED display stable enough to read 
during continuous digging. 
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05  2D Project Mode — Limitations 

2D Project mode allows operators to import a design file and work from it in 2D — a significant step up 
from bench-only 2D+ operation. However, 2D Project has specific limitations compared to full 3D mode. 

Limitation Detail 

DXF Import Only 1 DXF file can be imported per project. 

Maximum DXF Size 150 m × 150 m (approximately 500 ft × 500 ft). 

Maximum Projects 5 projects can be stored on the Control Box. 

3D View Not available. 2D Project provides Side View, Front View, and Map 
View only. 

Work Tool Settings Limited compared to full 3D mode. 

 
For operators who need unlimited DXF imports, larger design files, unlimited projects, or the full 3D View, 
the system can be upgraded to Connect 3D with a CT151 license. 
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06  3D Work Screen Overview 

The 3D work screen builds on the 2D interface covered in Sections 01–05. In 3D mode, the operator 
works against imported design surfaces rather than simple bench references, and the interface adds 
multiple view types, surface display tools, and coordinate information that are not present in 2D mode. 
This section and the sections that follow cover the elements that are unique to 3D operation. 

Key Elements on the Work Screen 

Element Description 

Coordinate Display Shows the current bucket-tip or GNSS receiver coordinates (Northing, 
Easting, Elevation) in the active coordinate system. Tap the coordinate 
area to toggle between bucket coordinates and GNSS coordinates. 

Heading / Accuracy 
Indicators 

Displayed in the upper portion of the screen. Shows the current 
heading, vertical accuracy, and horizontal accuracy of the GNSS 
position. These values update in real time. 

Bucket / GNSS Toggle Tap to switch the coordinate display between the bucket-tip position 
(computed from the sensor geometry) and the raw GNSS receiver 
position. Useful for comparing machine-computed position against the 
GNSS reference. 

Layer Icon Provides access to the Layer Manager, Project Manager, and Import 
menu. This is where you load projects, import design files, manage 
layers, and configure coordinate systems (covered in Volume 7). 

Machine Visualization The graphical representation of the machine — boom, stick, bucket, 
and cab — shown in the active view (Side, Front, 3D, or Map). The 
visualization updates in real time as the operator moves the machine. 

Cut/Fill Indicator Displays the vertical distance between the bucket tip and the design 
surface. Negative values indicate the bucket is above grade (fill 
needed); positive values indicate the bucket is below grade (cut 
remaining). The LED Bargraph mirrors this value. 
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07  Screen Layout Options 

iDig Connect offers three screen layout options and four view types. The layout determines how many 
views are displayed simultaneously; the view type determines what each panel shows. 

Layouts 

Layout Description 

Single One full-screen view. Provides the maximum display area for a single view type. 
Most operators use Single layout with the Side View during standard excavation 
work. 

Split Two views displayed side by side. Common combinations: Side View + Map View 
(for operators working from a design and needing to see their position on the 
plan), or Side View + Front View (for operators who need both profile and 
cross-section simultaneously). 

Triple Three views displayed simultaneously. Provides the most information at once but 
reduces the size of each individual panel. Used primarily by operators working in 
3D mode who need Side, Front, and Map views visible at all times. 

 

View Types 

View What It Shows 

Side View (Profile) The machine viewed from the side, showing the boom, stick, and bucket 
in profile against the design surface. This is the primary digging view — it 
shows depth, reach, and the relationship between the bucket and the 
surface at a glance. 

Front View 
(Cross-Section) 

The machine viewed from the front, showing the bucket's left-right 
position relative to the cross-section of the design surface. Essential for 
grading work where the operator needs to see the cross-slope. 

3D View A three-dimensional perspective of the machine and the design surface. 
Provides spatial context that the profile and cross-section views cannot. 
Useful for understanding how the current cut relates to the overall 
surface. 

Map View A plan view (top-down) showing the machine's position on the project 
map. Displays design lines, points, surfaces, and the machine's heading. 
Useful for navigating to specific locations on the project and for seeing 
where the machine has already worked. 

 
To change the layout or view type, tap the Screen Layout icon on the side toolbar (Section 03). The layout 
and view selections persist across power cycles. 

 

iDig North America  |  Page 140 



iDig Connect User Guide 

08  Side Toolbars — Left & Right 

The work screen toolbars are hidden by default to maximize the display area. To access them, tap 
anywhere on the work screen. The left and right toolbars appear along the edges of the screen. 

Each toolbar initially shows a compact set of the most commonly used tools. Press the expand button on 
either toolbar to reveal the full set of tools. The expanded toolbars show every tool available in the current 
operating mode. 

 
Accessing All Tools 
After tapping the work screen to reveal the toolbars, press the expand icon on both the left and right 
toolbars. This displays every available tool in the software. The expand state resets each time the 
toolbars are dismissed — the next time you tap the screen, the toolbars return to their compact 
state. 
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09  Tool Icon Quick Reference 

The following table defines every tool icon available on the iDig Connect work screen toolbars. Icons are 
grouped by function. 

Design & Measurement Tools 

Tool Function 

Create CAD Create points, lines, and surfaces directly on the work screen. 

Create Points Create points using the bucket-tip position or the GNSS receiver on a 
survey rod. 

Create Polyline / Polygon Create a polyline or polygon using the bucket or GNSS receiver to 
define each vertex. 

Coordinate Shift Shift the coordinate system by comparing the bucket or GNSS 
coordinates against a known control point and adjusting the Northing, 
Easting, and Elevation to match. See Volume 7 Section 08. 

Smart Tape Measure the distance, slope distance, and elevation difference 
between two points. Works with both the bucket tip and the GNSS 
receiver on a rod. 

Profile Editor Create field designs by drawing a cross-section shape and applying it 
along a 3D line. Used for creating slopes, benches, and custom 
profiles without importing a design file. 

Elevation Alert Set an alarm that triggers when the machine reaches a defined 
elevation. Useful for utility avoidance or depth limits. 

 

Mode & Display Controls 

Tool Function 

2D / 3D Toggle Switch between 2D operating mode (laser or benchmark reference) 
and 3D operating mode (GNSS-referenced surface guidance). 

Screen Layout Select from Single, Split, or Triple screen layouts. Choose which view 
type (3D, Side, Front, or Map) appears in each panel. 

Attachment List Switch between calibrated attachments (buckets) without leaving the 
work screen. Each bucket has its own calibration profile. 

Bucket Focus Point Toggle between single-point guidance from the center of the bucket 
and three-point guidance showing left, center, and right of the cutting 
edge. See Section 05. 

Guidance Mode (Distance) Switch the guidance distance display between Vertical (distance 
measured straight down to the surface) and Perpendicular (distance 
measured at 90° to the surface slope). See Section 06. 

Guidance Mode (Surface 
Offset) 

Switch the surface offset between Vertical and Perpendicular. See 
Section 06. 
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Tool Function 

Surface Offset Tool Apply a constant offset above or below the design surface. See 
Section 07. 

 

View & Sensor Tools 

Tool Function 

Sensor Info View sensor information including battery level, angle data, and 
allowable vibration range. The vibration range can be adjusted from 
this screen. 

Zoom Controls Switch between Auto and Manual bucket zoom. In Auto mode, the 
view follows the bucket. In Manual mode, you set the zoom level. Edit 
zoom levels independently per view panel. See Section 10. 

Reach Radius Display the machine's reach radius as a circle on the screen, showing 
the maximum and current reach of the bucket. 

3D Perspective Toggle a 3D perspective overlay on the cross-section (Front) view for 
enhanced spatial context. 

Point ID Display Show or hide point identification labels on the Map View. 

Focus (Bucket / Design) Toggle the view focus between following the bucket tip and centering 
on the design surface. See Section 10. 

 

Surface & Status Tools 

Tool Function 

Status Bar Display the status bar showing bucket/GNSS coordinates, heading, 
horizontal accuracy, and vertical accuracy. See Section 08. 

Surface Display Toggle between triangle mesh and solid surface rendering. 

Surface Shadows Change the surface shading to enhance depth perception in the 3D 
View. 

Grid Overlay Overlay a grid on the surface to enhance spatial reference in the 3D 
View. 

Settings Access Open the Settings menu (Basic Settings, System Settings, Work 
Settings, Remote Access) from the work screen. 
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10  Bucket Focus Point 

iDig Connect provides guidance from the side of the bucket's cutting edge that is closest to the design 
surface. This default behavior prevents over-digging — the system always references the edge that would 
contact the design first, so the operator knows when to stop before cutting past grade. 

The operator can toggle the bucket focus point to display guidance from the center of the bucket or from 
all three points (left, center, right) simultaneously. 

Default — Closest Edge to Design 

In the default mode, the system automatically selects whichever side of the bucket is nearest to the 
design surface and references guidance from that edge. As the operator repositions the bucket relative to 
the surface, the reference edge updates automatically. This is the safest mode for production digging 
because it ensures the cut/fill value and the LED Bargraph always reflect the part of the bucket that is 
closest to the finished surface. 

Three-Point (Left / Center / Right) 
Three-point mode shows independent cut/fill values for the left edge, center, and right edge of the cutting 
edge simultaneously. This is useful for finish grading — the operator can see whether the left side of the 
bucket is on grade even if the right side is still high, and adjust the bucket tilt or machine position 
accordingly. 

Toggle between guidance modes by tapping the Bucket Focus Point icon on the toolbar. 
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11  Guidance Modes 

iDig Connect offers two guidance modes that affect how the distance between the bucket and the design 
surface is measured. The choice between them depends on the work being done. 

Vertical Guidance 

The distance between the bucket and the surface is measured straight down — a vertical line from the 
bucket tip to the surface directly below it. This is the standard mode for flat or nearly flat surfaces. When 
the operator sees a cut/fill value of −0.10', it means the bucket tip is 0.10' above the surface directly below 
the bucket. 

Perpendicular Guidance 

The distance is measured at 90° to the surface slope — perpendicular to the surface rather than straight 
down. This is the correct mode for working on slopes. On a steep slope, vertical guidance understates the 
actual distance between the bucket and the surface because it measures straight down rather than along 
the shortest path to the surface. Perpendicular guidance measures the true distance. 

 
When to Use Each Mode 
Use Vertical guidance for flat pads, level bottoms, and any work where the surface is approximately 
horizontal. Switch to Perpendicular guidance when grading slopes, embankments, or any surface 
that is significantly off-horizontal. Perpendicular guidance on a flat surface produces the same result 
as vertical — the difference only becomes meaningful on slopes. 

The same Vertical / Perpendicular toggle exists for the Surface Offset tool. If you are using a surface 
offset on a slope, set both the guidance mode and the offset mode to Perpendicular for consistent results. 
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12  Surface Offset Tool 
The Surface Offset tool applies a constant vertical or perpendicular offset above or below the design 
surface. The offset creates a virtual working surface that the operator grades to instead of the original 
design surface. 

When an offset is active, the work screen displays the original design surface as a dashed line and the 
offset surface as a solid line. The cut/fill guidance references the offset surface, not the original. 

Common Uses 

•​ Subgrade preparation — offset below the finished surface by the pavement or base-course 
thickness to grade the subgrade. 

•​ Over-excavation — offset below the design to remove a defined depth of unsuitable material before 
placing fill. 

•​ Form-grade — offset above the design by the form height to set forms at the correct elevation. 
Enter the offset as a positive value (above the surface) or negative value (below the surface). The offset 
applies globally to the active surface until it is cleared or changed. 

 
Real-World Example: Grading Subgrade for a Parking Lot 
Your design surface is the finished asphalt elevation. The paving spec calls for 6 inches of 
aggregate base and 4 inches of asphalt — 10 inches total below finished grade. Set the surface 
offset to −0.833' (−10 inches). The work screen now shows the original design as a dashed line and 
guides the operator to the subgrade elevation 10 inches below it. When the LED Bargraph shows 
on-grade, the operator is at the correct subgrade depth. When paving is complete and the offset is 
cleared, the same design surface is ready for finish-grade verification without reloading anything. 
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13  Status Bar 

The Status Bar is an optional display element that shows detailed position and accuracy information at 
the bottom or top of the work screen. Tap the Status Bar icon on the toolbar to toggle it on or off. 

Information Displayed 

Field What It Shows 

Bucket Coordinates The computed Northing, Easting, and Elevation of the bucket tip in the 
active coordinate system. 

GNSS Coordinates The raw Northing, Easting, and Elevation reported by the Spotman 
receiver. 

Heading The current heading of the machine in degrees. 

Horizontal Accuracy The horizontal position accuracy of the GNSS fix, in the current length 
units. 

Vertical Accuracy The vertical position accuracy of the GNSS fix, in the current length 
units. 

 
The accuracy values reflect the quality of the current GNSS fix. During an RTK Fix, horizontal accuracy is 
typically 0.03' or better and vertical accuracy is typically 0.05' or better. If the fix degrades (Float or 
Autonomous), the accuracy values increase and the system should not be used for precision grading. 
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14  Surface Display Options 

The work screen provides several options for how the design surface is rendered. These do not change 
the surface data — they change how it appears on screen to improve readability in different conditions. 

Option Effect 

Triangle Mesh / Solid 
Surface 

Toggle between displaying the surface as a wireframe triangle mesh 
(showing the individual triangles that make up the TIN surface) and a 
solid shaded surface. Triangle mesh is useful for verifying surface data 
quality; solid is easier to read during production work. 

Surface Shadows Adjust the shading applied to the surface to enhance depth perception. 
Stronger shadows make elevation changes more visible in the 3D 
View. 

Grid Overlay Overlay a reference grid on the surface in the 3D View. The grid 
provides spatial scale and makes it easier to judge distances and 
slopes visually. 
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15  Zoom & Focus Controls 

The zoom and focus controls determine how the view follows the machine and at what magnification the 
work is displayed. 

Auto Zoom vs. Manual Zoom 

Mode Behavior 

Auto Zoom The view automatically follows the bucket tip and adjusts the zoom level to 
keep the bucket and the nearby design surface in frame. This is the default 
mode and works well for most excavation tasks. 

Manual Zoom The operator sets the zoom level and the view does not auto-adjust. Use 
Manual zoom when you need a fixed field of view — for example, when 
monitoring a specific area of the surface while the bucket moves in and out of 
frame. 

 
Zoom levels can be edited independently for each view panel in a Split or Triple layout. This allows the 
operator to have a tight zoom on the Side View for precision grading while maintaining a wide zoom on 
the Map View for overall position context. 

Focus: Bucket vs. Design 

The Focus toggle determines what the view centers on. In Bucket focus, the view follows the bucket tip as 
it moves. In Design focus, the view centers on the design surface and the machine moves through the 
frame. Bucket focus is standard for active digging. Design focus is useful when reviewing a surface or 
checking grades at a location the bucket has not yet reached. 
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16  What's Next 

With Volume 6 complete, the operator understands the work screen layout, how to access and use every 
toolbar icon, how to configure screen layouts and view types, and how to set guidance modes and 
surface display options for different types of work. 

Volume 7: Projects, Coordinate Systems & Data Management 
Volume 7 covers creating projects, loading coordinate systems and geoids, importing design files (DXF 
and LandXML), managing layers, using the Coordinate Shift tool, and exporting project data. 

Volume 8: Field Operations 

Volume 8 covers daily field operations — 2D, 2D+, 2D Project, and 3D workflows, Dynamic Laser Catch, 
Swing Boom operation, Smart Tape measurements, surface creation, and the daily startup-to-shutdown 
routine. 

Need Help? 

Contact your iDig dealer for assistance with interface configuration or work screen setup. For real-time 
support, use the Remote Access feature described in Volume 1 Section 09.  
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01  What Is a Project? 

A project in iDig Connect is a container that organizes all the data for a specific job. Each project holds a 
coordinate system (or site calibration), imported design files, layers, surfaces, and any points or lines the 
operator creates during fieldwork. When an operator switches between projects, the entire data context 
changes — the coordinate system, the design surfaces, and the layer visibility all update to reflect the 
selected project. 

Projects allow an operator to work on multiple jobs from the same Control Box without data from one job 
interfering with another. A residential foundation project and a commercial site-grading project can coexist 
on the same Control Box, each with its own coordinate system, design files, and field-created data. 
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02  Creating a New Project 

Projects are created from the Layer menu, which is accessed from the work screen. 

Step-by-Step: Create a New Project 

1 
Tap anywhere on the work screen to reveal the toolbars. 
The left and right toolbars appear. 

 

2 
Tap the Layer icon. 
The Layer menu opens, showing the current project's layers and the project selection 
dropdown. 

 

3 
Select Start a New Project. 
A dialog prompts for the project name. 

 

4 
Enter a name for the project and confirm. 
Use a descriptive name that identifies the job — for example, the project name, lot number, 
or address. The project is created and becomes the active project. 

 

5 

Configure the coordinate system. 
iDig automatically loads the last-used coordinate system into the new project. If this project 
uses a different coordinate system, load the correct one now (see Section 03). If this project 
uses a site calibration, load it instead (see Section 05). 

 
 
 

Real-World Example: Starting a New Subdivision Lot 
An operator finishing a foundation on Lot 12 needs to move to Lot 13, which uses the same 
coordinate system but a different design file. The operator creates a new project named "Lot 13 — 
Foundation", and iDig carries the coordinate system forward from Lot 12 automatically. The operator 
then imports the Lot 13 DXF (Section 06) and begins work. The Lot 12 project and its data remain 
intact and can be recalled at any time from the project dropdown. 
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03  Coordinate Systems Explained 

GNSS receivers measure locations on Earth using latitude and longitude, but construction projects work 
in northing, easting, and elevation coordinates expressed in feet or meters. A coordinate system is the 
mathematical definition that converts between GNSS latitude/longitude/height and the project's local 
northing/easting/elevation. 

There are hundreds of predefined coordinate systems available in iDig Connect. Most US construction 
projects use an NAD83 State Plane coordinate system — each state (and some states are divided into 
zones) has its own projection that minimizes distortion for that geographic area. 

Step-by-Step: Select a Coordinate System 

1 
From the Layer menu, tap the Settings icon. 
The project settings screen opens. 

 

2 
Select Coordinate System. 
The Correction Method screen opens, showing three options: Code EPSG, Site Calibration, 
and Custom. 

 

3 
Select Custom. 
The custom coordinate system configuration screen opens. 

 

4 

Choose USA_NAD83-2011 and check the box for Nearby. 
This filters the available state plane zones to those near the machine's current GNSS 
position. The system displays only the coordinate systems that apply to your geographic 
area, making it easy to find the correct zone without searching by name or EPSG code. 

 

5 

Select the correct state plane zone from the filtered list. 
Verify the zone name matches your project. Your project engineer or surveyor can confirm 
the correct zone. The geoid is loaded automatically based on the coordinate system 
selected. 

 

6 
Tap Apply. 
The coordinate system and geoid are now active for this project. The bucket and GNSS 
coordinates displayed on the work screen reflect the selected coordinate system. 
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Critical: Use the Correct Coordinate System 
Loading the wrong coordinate system will cause every coordinate displayed by iDig to be offset from 
the project's control. The design files will not align with the ground, and the machine's position will 
not match the surveyor's stakeout. Confirm the coordinate system with your project engineer or 
surveyor before loading it. 
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04  Understanding the Geoid 

A geoid is a model of the Earth's gravitational surface. It converts the GNSS receiver's ellipsoidal height 
(a mathematical height above the reference ellipsoid) into an orthometric elevation (the elevation used on 
construction plans — height above mean sea level). Without a geoid, the elevations displayed by iDig 
would not match the project's survey elevations — the difference can be 50 feet or more depending on 
location. 

When you select a coordinate system using the Custom method (Section 03), iDig automatically loads the 
correct geoid for that coordinate system. There is no separate step to load the geoid — it is handled as 
part of the coordinate system selection. 

Geoid files are downloaded to the Control Box via Settings > Software Update > Coordinate Systems (see 
Volume 1 Section 07). If the required geoid is not available on the Control Box, download it through the 
Software Update before selecting the coordinate system. 
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05  Loading a Site Calibration (Localization) File 

A site calibration (also called a localization) is an alternative to loading a predefined coordinate system 
and geoid. Instead of using a published state plane projection, a site calibration compares known survey 
control points on the ground with their GNSS-measured positions and computes a custom transformation 
that aligns the two. This is common on projects that use a local coordinate system or assumed 
coordinates rather than state plane. 

Site calibration files are created in iPoint (using the Site Calibration workflow) and exported as a file that 
can be loaded into iDig Connect via USB. A separate iPoint tutorial covers how to perform the site 
calibration and export the file. 

Step-by-Step: Load a Site Calibration 

1 
From the Coordinate System screen, select Site Calibration. 
The Site Calibration import screen opens. 

 

2 
Insert the USB stick that contains the site calibration file. 
The file was exported from iPoint during the site calibration process. 

 

3 
Select Import. 
The system reads the USB and lists available site calibration files. 

 

4 
Select the site calibration file and tap Open. 
The calibration details appear, showing the accuracy of each control point used in the 
calibration. 

 

5 
Review the point accuracy. Toggle individual points on or off if needed. 
If a point has poor accuracy (a high residual), you can toggle it off to exclude it from the 
calibration. The system recomputes the calibration with the remaining points. 

 

6 
When satisfied, tap Load. 
The site calibration is now active for this project. The system uses the custom transformation 
instead of a predefined coordinate system and geoid. 

 
 
 

When to Use a Site Calibration vs. a Coordinate System 
Use a predefined coordinate system (NAD83 State Plane) when the project plans are in state plane 
coordinates and the surveyor's control is tied to the published datum. Use a site calibration when 
the project uses local or assumed coordinates, when the surveyor has established project-specific 
control points, or when the project requires a higher degree of local accuracy than the published 
state plane projection provides. 
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06  Importing Design Files (DXF & LandXML) 

Design files provide the surfaces, lines, and points that define the project's grading plan. iDig Connect 
imports DXF and LandXML file formats — the two most common design file formats used in civil 
construction. 

Step-by-Step: Import a Design File 

1 
From the Layer menu, tap the Settings icon. 
The project settings screen opens. 

 

2 
Select Input File > Import File. 
The file browser opens, showing available sources (USB and Cloud). 

 

3 
Browse to the design file on USB or Cloud and select it. 
Navigate to the folder containing the DXF or LandXML file. If using Cloud, the cloud folders 
configured in Volume 1 Section 10 appear alongside USB storage. 

 

4 

Set the units to match the design file. 
If the design file was created in US Survey Feet, set the import units to US Survey Feet. A 
unit mismatch will cause the design to import at the wrong scale — a common and 
difficult-to-diagnose problem. 

 

5 
Select the layers to import. 
The file may contain many layers. Select only the layers needed for the current work — 
importing unnecessary layers clutters the display and slows the system. 

 

6 
Set the Axis setting. 
The default is Auto: East-North, which is correct for most US civil design files. Change this 
only if the design file uses a non-standard axis convention. 

 

7 
Confirm the import. 
The design file is imported into the active project. The imported layers appear in the Layer 
menu and the design surfaces appear on the work screen. 
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Critical: Match the Import Units to the File 
If the design file was created in US Survey Feet and you import it in Meters (or vice versa), every 
dimension in the design will be wrong by a factor of roughly 3. The design will appear impossibly 
large or impossibly small on the work screen. If the imported design does not align with the 
machine's position or appears at the wrong scale, the first thing to check is the import unit setting. 
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07  Layer Management 

Layers organize the data within a project. Each imported design file creates one or more layers, and the 
operator can create additional layers during fieldwork. Understanding layers is essential for working 
efficiently with complex designs. 

2D Layers vs. 3D Layers 

Layer Type Description 

2D Layers Contain location data only — lines, points, and boundaries without elevation 
information. 2D layers are useful for plan-view reference (property lines, building 
outlines, utility locations) but cannot be used for depth guidance because they 
have no elevation. 

3D Layers Contain location and elevation data — surfaces, contours, and design grades 
with full northing/easting/elevation information. 3D layers are required for cut/fill 
guidance. When you select a surface for guidance, it must be on a 3D layer. 

 

Layer Controls 

The Layer menu is accessed by tapping the Layer icon on the work screen. Tap the arrow next to 2D 
Layers or 3D Layers to expand each category and see the individual layers. 

Control Function 

Toggle Visibility Turn the layer on or off in the work screen display. Toggle on only the layers 
you need to see — hiding unnecessary layers reduces screen clutter and 
improves performance. 

Layer Options Opens a menu to delete the layer, change the layer's display color, or edit 
data on the layer. 

Locked Layer Imported layers (from DXF or LandXML files) are automatically locked. 
Locked layers cannot be edited — they can only be toggled on or off. This 
prevents accidental modification of the design. 

View Entities Lists all the individual entities (points, lines, surfaces) on the selected layer. 

Select for Guiding Selects a 3D surface on the layer as the active guidance surface. The 
cut/fill display references this surface. 

Discard Removes the layer from the project. This cannot be undone. 
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08  Coordinate Shift Tool 
The Coordinate Shift tool adjusts the coordinate system by comparing the machine's current position 
against a known control point. If the bucket coordinates do not match the control point's published 
coordinates, the operator enters the correct values and the system applies a shift to align the two. 

This is used when the machine arrives on site and needs to verify its position against existing survey 
control before beginning work. It is also used when the coordinate system is close but has a small offset 
— common after loading a new site calibration or when the NTRIP corrections introduce a slight shift 
compared to the project's local control. 

Step-by-Step: Apply a Coordinate Shift 

1 
Place the bucket focus point precisely on a known control point. 
The control point must have published Northing, Easting, and Elevation values. 

 

2 
Tap the Coordinate Shift icon on the toolbar. 
The current bucket coordinates are displayed. 

 

3 
Compare the displayed coordinates against the control point's published values. 
Note the difference in Northing, Easting, and Elevation. 

 

4 
Edit the Easting to match the control point. 
Tap the Easting field, enter the control point's published Easting value, and confirm. 

 

5 
Edit the Northing to match the control point. 
Tap the Northing field, enter the control point's published Northing value, and confirm. 

 

6 
Edit the Elevation to match the control point. 
Tap the Elevation field, enter the control point's published Elevation value, and confirm. 

 

7 
Verify the shift. 
The displayed coordinates should now match the control point. Move the bucket to a second 
control point to verify the shift is consistent across the site. 
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Real-World Example: Checking In on a Subdivision 
An operator arrives on a new subdivision lot. The surveyor has set a control point (a nail in the curb) 
at N 51,604.00, E 964,357.35, Elev 5,280.12. The operator places the bucket on the nail, opens the 
Coordinate Shift tool, and sees the system reads N 51,604.03, E 964,357.31, Elev 5,280.08. The 
operator enters the published values, and the system applies a shift of −0.03 in Northing, +0.04 in 
Easting, and +0.04 in Elevation. The machine is now aligned to the project control. 
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09  Switching Between Projects 

The active project is shown in the project dropdown at the top of the Layer menu. To switch to a different 
project, tap the dropdown and select the project you want to work on. The coordinate system, design files, 
layers, and all project-specific data update immediately. 

Switching projects does not delete or modify the previous project. All data in the previous project is 
preserved and can be recalled at any time. 
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10  Import/Export Projects 

Complete projects — including coordinate systems, layers, design files, and field-created data — can be 
exported to USB and imported onto other Control Boxes. This is how project data is transferred between 
machines in a fleet or backed up for safekeeping. 

Exporting a Project 

1 
From the Layer menu, tap the Settings icon. 
The project settings screen opens. 

 

2 
Select Export. 
The export dialog opens. 

 

3 
Name the export file and choose the destination (USB). 
Use a descriptive filename that includes the project name and date. 

 

4 
Confirm the export. 
The project is exported to the USB stick as a complete package. 

 
 

Importing a Project 

1 
Insert the USB stick containing the exported project. 
Or navigate to the project file on Cloud storage. 

 

2 
From the Layer menu, tap the Settings icon and select Import. 
The file browser opens. 

 

3 
Select the project file and confirm. 
If a project with the same name already exists, the system prompts to resolve the name 
conflict — rename the incoming project or overwrite the existing one. 

 

4 

Verify the coordinate system after import. 
Confirm the imported project's coordinate system matches the expected system for this 
jobsite. If the exporting machine was using a different coordinate system or site calibration, 
the design data may not align correctly with the new machine's position. 
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Transferring Projects Across a Fleet 
On a multi-machine job, one machine can be set up with the correct coordinate system and design 
file, then export the complete project to USB. Each additional machine imports the same project file 
and is immediately working from the same data. This eliminates the need to configure coordinate 
systems and import design files on every machine individually. 
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11  What's Next 

With Volume 7 complete, the operator understands how to create projects, load coordinate systems and 
geoids, import site calibrations, import design files, manage layers, apply coordinate shifts, and transfer 
projects between machines. 

Volume 8: Field Operations 

Volume 8 covers daily field operations — 2D, 2D+, 2D Project, and 3D workflows, Dynamic Laser Catch, 
Swing Boom operation, Smart Tape measurements, surface creation, and the daily startup-to-shutdown 
routine. 

Need Help? 

Contact your iDig dealer for assistance with coordinate systems, design file imports, or project 
configuration. For real-time support, use the Remote Access feature described in Volume 1 Section 09.
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01  Working in 2D Mode — Overview 

2D mode provides depth, distance, and slope guidance using wireless angle sensors on the boom, stick, 
bucket and chassis. The system measures the bucket tip's position relative to a bench reference — either 
a grade stake, a rotating laser beam or the GNSS receiver — and displays the cut/fill to the operator 
through the LED Bargraph and the on-screen display. 

2D mode is the foundation of iDig Connect. Every system ships with 2D capability, and the 2D+ and 3D 
modes build on the same sensor geometry. Understanding 2D operation is essential even if your system 
is licensed for 3D, because 2D mode remains the right tool for certain tasks — working on digging flat 
pads where you know the extents of the excavation, digging sloped trenches that you know where they 
go, and more.   
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02  Dynamic Laser Catch — Operation 

Dynamic Laser Catch allows the excavator to capture a reference elevation from a rotating laser beam 
while the machine is moving. The operator sweeps the boom through the laser beam, and the system 
sets the grade reference automatically — no need to stop inside the beam and hold position. 

Establishing the 1st Laser Strike 

The 1st Laser Strike tells the system what the laser height is relative to grade. There are two methods. 

Method When to Use Procedure 

Reference 
Stake 

You have a stake or 
reference point at the 
proposed grade on your 
project. 

Place the center of the bucket on the reference point. 
Tap the benchmark icon and enter the cut/fill to grade 
(enter 0 if the bucket tip is on the proposed grade). 
Then position the laser receiver to catch the rotating 
laser. 

Known Laser 
Height 

You have measured the 
laser height above 
grade using a grade 
rod. 

Enter the laser height value directly. The system 
computes the grade reference from the entered laser 
height. 

 
After establishing the reference, position the laser receiver to catch the rotating laser beam. The system 
shows a Laser Catch countdown. The laser receiver indicator must show a green check (stable signal) 
before the countdown completes. 

Working After the 1st Strike 

Once the 1st Laser Strike is established, the system provides cut/fill guidance. Two options for adjusting 
the reference: 

•​ Laser Height icon — change the laser height above the proposed surface. 
•​ Change Target icon — enter a surface offset to shift the guidance surface up or down from the 

current reference. 

Re-Benching After Moving the Machine 

When the machine tracks to a new position, re-bench by passing the stick combo sensor through the 
rotating laser beam. The system catches the beam and re-establishes the grade reference at the new 
location. The 1st Laser Strike remains intact — re-benching simply updates the laser catch at the 
machine's current position. 

The only time you delete the 1st Laser Strike is when you need to change the laser reference-to-grade 
value — for example, if the laser transmitter has been moved to a different height or a different 
benchmark. In that case, tap the delete icon to clear the 1st Laser Strike and re-establish it with the new 
reference value. 
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Real-World Example: Foundation Footing with a Laser 
An operator is digging a foundation footing at a depth of 4 feet below the laser reference. The laser 
is set on a tripod at a known height above the proposed finished floor. The operator enters the laser 
height, catches the beam, and iDig provides continuous depth guidance as the operator works 
around the perimeter. Each time the machine tracks to a new position along the footing, the 
operator re-catches the laser and continues. 
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03  Swing Boom — Operation 

The Swing Boom feature uses internal gyroscopes to track the boom's horizontal swing angle. This allows 
the system to provide accurate grade guidance when the boom is swung off-center — essential for 
working in tight areas, around utilities, or along walls where the cab cannot rotate. 

Initialize on Startup 

Each time the system is powered on, the swing boom must be initialized. Swing the boom fully to the right 
or fully to the left, then press the green check on the swing boom icon. The system calibrates its zero 
point from this initialization. 

The 5-Minute Drift Timer 

Because gyroscopes naturally drift over time, the swing boom function maintains accuracy for 
approximately 5 minutes after the feature is enabled. A timer on the work screen shows the remaining 
time. To manage drift effectively: 

•​ Initialize the swing boom on startup. 
•​ Swing the boom to the desired working angle. 
•​ Turn the swing feature off (press the icon to remove the green check). This pauses the 5-minute 

timer and preserves the remaining time. 
•​ When you need to reposition the boom, turn the feature back on, swing to the new angle, and turn it 

off again. 
 

Critical: Do Not Swing the Boom with the Feature Disabled 
When the swing boom feature is off, the system does not track the boom's horizontal position. If the 
operator physically swings the boom while the feature is disabled, iDig will provide inaccurate 
guidance because the system does not know the boom has moved. Only swing the boom when the 
feature is enabled (green check visible). 

 

iDig North America  |  Page 172 



iDig Connect User Guide 

04  Introduction to 2D+ 

2D+ adds GNSS elevation reference and machine positioning to the 2D sensor-based guidance. With a 
Spotman receiver connected and in RTK Fix, the operator can track the machine across the site without 
re-benching — the GNSS provides a continuous elevation reference wherever the machine moves. 

2D+ requires a Spotman GNSS receiver, RTK corrections (via NTRIP or a local base station), and a 
completed GNSS 3D calibration (Volume 4). All tiers of Connect license support 2D+ mode — no 
additional license is required. 
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05  Switching Between Laser and GNSS Reference 

The work screen provides a toggle icon to switch between Laser reference and GNSS reference. In Laser 
mode, the system uses the rotating laser beam caught by the combo sensor. In GNSS mode, the system 
uses the Spotman receiver for elevation. The operator can switch between the two at any time during 
operation. 
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06  Setting a Benchmark Elevation in 2D+ 

In 2D+ mode with GNSS reference, the operator sets a benchmark elevation by placing the bucket focus 
point on a known project benchmark and entering the published elevation. 

1 
Place the bucket focus point precisely on a project benchmark. 
The benchmark must have a known published elevation. 

 

2 
Tap the benchmark elevation icon on the work screen. 
The elevation entry dialog opens. 

 

3 
Enter the benchmark's published elevation and press Apply. 
The system adjusts the GNSS-derived elevation to match the benchmark. The bucket 
elevation now reads the correct value wherever the machine moves on site. 
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07  Smart Tape Tool 
The Smart Tape tool measures the distance between two points using the bucket tip or the GNSS 
receiver on a rod. It displays horizontal distance, slope distance, vertical distance, and slope percentage 
in real time as the operator moves from the first point to the second. 

1 
Tap the Smart Tape icon on the toolbar. 
The Smart Tape display activates. 

 

2 
Tap the reset field once to zero the digital tape measure. 
The first point is set at the current bucket or GNSS position. 

 

3 
Move the bucket or GNSS rod to the second point. 
The display updates in real time showing horizontal distance, slope distance, elevation 
difference, and slope percentage as you move. 

 
 
 

Real-World Example: Checking a Pipe Run Between Two Structures 
The superintendent asks you to verify the distance and fall between two manholes before the pipe 
crew arrives. Place the bucket tip on the rim of the first manhole and reset the Smart Tape. Track 
the machine to the second manhole and place the bucket on that rim. The Smart Tape reads 187.3 
feet horizontal, 2.8 feet of fall, and −1.5% slope. The plan calls for 185 feet at −1.5% — the distance 
is slightly long but the slope is correct. The superintendent has what he needs to approve the pipe 
run without waiting for the surveyor. 
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08  Height Alarm (Elevation Alert) 

The Height Alarm provides an audible and visual warning when the bucket tip reaches a user-defined 
elevation. Common uses include guarding against over-digging into a utility zone, preventing the bucket 
from striking an overhead obstruction, and alerting the operator when reaching a hard-bottom design 
grade. 
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09  Setting Depth for Level Grading 

For a level grading project — digging a flat bottom at a uniform depth — the operator sets a target depth 
from a known reference point. 

1 
Tap the Set Depth icon on the toolbar. 
The depth entry screen opens. 

 

2 
Place the bucket on a known reference point. 
This is typically a grade stake or a surveyed benchmark. 

 

3 
Enter the desired cut depth and press Apply. 
The system creates a flat target surface at the entered depth below the reference point. The 
LED Bargraph and on-screen cut/fill display now guide the operator to that target. 
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10  Setting Depth & Slope for Utility Trenching 

For utility trenching, the operator sets both a depth and a slope. The system creates a sloped target 
surface that the operator follows along the trench alignment. 

1 
Tap the Set Depth & Slope icon on the toolbar. 
The depth and slope entry screen opens. 

 

2 
Enter the trench depth from the reference stake. 
This is the depth of the trench bottom at the starting point. 

 

3 

Enter the slope value. 
Slope sign convention: negative values slope downward from the bucket toward the cab. For 
example, a storm sewer at −3% slopes downward at 3% in the direction away from the 
operator. 

 

4 

Choose the slope direction. 
Three options: Along Boom Axis (slope follows the boom direction), Two-Point Measurement 
(the operator measures the bucket position at two points to define the slope direction), or 
Azimuth/Bearing (the operator enters a compass bearing for the slope direction). 

 

5 
Press Apply. 
The system creates the sloped target surface. The LED Bargraph guides the operator along 
the slope as the trench progresses. 

 
 
 

Real-World Example: Storm Sewer Trench at −3% 
A 36-inch storm sewer runs 200 feet at −3% from an inlet structure to a manhole. The operator 
positions the machine so the boom is aligned with the direction of the trench — this is critical, 
because Along Boom Axis uses the boom's current orientation to define the slope direction. The 
operator places the bucket on the invert stake at the inlet, enters the starting depth (6.5 feet from 
the top of the stake to the pipe invert), enters −3% slope, confirms the boom is pointing down the 
trench alignment, selects Along Boom Axis, and presses Apply. As the operator trenches toward the 
manhole, the LED Bargraph shows on-grade as long as the trench bottom follows the −3% slope. At 
the manhole, the operator checks the invert elevation against the plan — if it matches, the slope 
was held correctly over the full 200-foot run. 
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11  Working in 3D Mode — Overview 

3D mode provides full machine guidance using the GNSS receiver for positioning and imported or 
field-created design surfaces for cut/fill reference. The machine's bucket-tip position is displayed in all four 
view types (Side, Front, Map, 3D) against the design surface, and the operator sees continuous cut/fill 
values as the bucket moves. 

3D mode requires a Spotman GNSS receiver in RTK Fix, a 3D license (CT151), a completed GNSS 3D 
calibration, and a project with a design surface loaded and selected for guidance. 
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12  Your Daily 3D Workflow 

This is the shift-to-shift routine for a 3D operator on every project day. It covers startup, verification, 
production work, and shutdown. 

Pre-Shift — Before Climbing In 

•​ Walk the machine. Inspect every sensor plate for damage, loose adhesive, or hydraulic fluid. 
Confirm sensors are clipped in and the GNSS receiver is seated on its mount. 

•​ Verify the GNSS has a clear sky view. 
•​ Confirm sensor charge. Wireless sensors should show adequate battery in Settings > Wireless 

Sensors. 

Startup — First 5 Minutes in the Cab 

•​ Power on the Control Box. Let the system boot fully. 
•​ Confirm the correct machine profile and bucket are loaded. 
•​ Connect to the GNSS receiver. Basic Settings > GNSS Receiver. Verify RTK Fix on the Data tab. 
•​ Resolve heading accuracy. Rotate the cab slowly until the heading indicator turns green. 
•​ Open the correct project. Confirm the coordinate system, geoid or site calibration, and design layers 

all display correctly. 

First-Dig Verification 

•​ Place the bucket on a known survey control point. Verify the displayed coordinates match the 
published values within tolerance. 

•​ If the coordinates do not match the control point within tolerance, do not proceed. Troubleshoot the 
cause — the most likely issue is a base station setup or configuration problem. Verify the base 
station is on the correct benchmark, that the correction format is correct, and that the coordinate 
system in iDig matches the project. Do not dig until the coordinates agree with the control. 

•​ Select the target design surface for guidance. Confirm it displays correctly in the work views. 

Working the Shift 
•​ Dig to the design surface. Use the LED Bargraph as peripheral reference and keep eyes on the 

work. 
•​ With 3D GNSS, guidance stays accurate when the machine tracks. Re-benching is not required 

after each move. 
•​ Periodically check accuracy by placing the bucket on a known point and comparing coordinates. 
•​ As-built important features. Use Create CAD > Create Points to record installed inverts, pipe 

centerlines, manhole rims, and any unexpected conditions. 

Swapping Buckets or Changing Tasks 

•​ Use the Attachment List icon to switch to a different bucket calibration. Verify on a control point after 
switching. 

•​ For finish grading, tighten the LED Deadband in Work Settings or enable the Surface Offset Tool for 
a thin pass. 

•​ Working under obstructions with no sky view? Switch to 2D+ mode and bench off a known point 
until clear. 
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End of Shift 
•​ Back up any new data. Export the project to USB or cloud (Volume 7 Section 10). 
•​ Park with the GNSS receiver in clear sky for faster RTK acquisition the next morning. 

 

iDig North America  |  Page 182 



iDig Connect User Guide 

13  2D Project Mode — Limitations 

2D Project mode provides design-file-based guidance in 2D — a step up from bench-only 2D+ operation 
but with specific limitations compared to full 3D mode. 

Limitation Detail 

DXF Import Only 1 DXF file can be imported per project. 

Maximum DXF Size 150 m × 150 m (approximately 500 ft × 500 ft). 

Maximum Projects 5 projects can be stored on the Control Box. 

3D View Not available. 2D Project provides Side View, Front View, and Map 
View only. 

Work Tool Settings Limited compared to full 3D mode. 
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14  Creating a Flat Surface 

The flat surface creation tool builds a level surface on the Control Box without importing a design file. This 
is the simplest surface type — a horizontal plane at a specified elevation. 

1 
Tap the Surface Creation icon on the work screen toolbar. 
The surface creation wizard opens. 

 

2 
Choose the reference point: bucket focus point or GNSS on a rod. 
The surface elevation is set relative to this reference. 

 

3 
Enter the side length of the surface (e.g., 100 feet). 
This creates a square surface centered on the reference point. 

 

4 
Enter an elevation offset if needed. 
A negative offset places the surface below the reference point. Zero creates the surface at 
the reference elevation. 

 

5 
Set Select for Guidance to Yes. 
The surface is immediately active for cut/fill guidance. 

 

6 
Confirm. 
The flat surface is created and displayed on the work screen. 
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15  Creating a Single-Slope Surface 

The single-slope surface tool creates a surface that slopes in one direction — useful for drainage pads, 
leach fields, and any work requiring a consistent grade in one axis. 

1 
Tap the Surface Creation icon and select the slope surface option. 
The slope surface wizard opens. 

 

2 
Choose the reference point: bucket center or GNSS on a rod. 
The surface slope originates from this reference. 

 

3 
Enter the side length and elevation offset. 
Same as the flat surface — defines the size and vertical offset from the reference. 

 

4 
Enter the longitudinal slope as a percentage. 
Slope sign convention: negative values slope downward from the bucket toward the cab. 
Positive values slope upward. 

 

5 
Choose the slope direction. 
Along Boom Axis, Two-Point Measurement, or Azimuth/Bearing — same options as the 
depth and slope trenching tool (Section 10). 

 

6 
Set Select for Guidance to Yes and confirm. 
The sloped surface is created and active for guidance. 

 
 
 

Real-World Example: Septic Leach Field at 2% 
A septic system requires a leach field graded at 2% over an 80-foot run. The operator places the 
bucket at the high end of the field, enters an 80-foot side length, −4 feet elevation offset (depth 
below the reference), and a 2% slope along the boom axis. The surface is created instantly and the 
operator grades the field using the LED Bargraph for continuous feedback. 
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16  Creating a Dual-Slope Surface 

The dual-slope surface tool creates a surface that slopes in two directions simultaneously — a 
longitudinal slope and a cross slope. This is used for retention basins, parking lots, and any pad that 
requires drainage in two axes. 

The procedure is the same as a single-slope surface (Section 15) with the addition of a cross-slope entry. 
Enter both the longitudinal slope and the cross slope as percentages, using the same sign convention 
(negative = downward from bucket toward cab for longitudinal; negative = downward to the right for cross 
slope). 

 

iDig North America  |  Page 186 



iDig Connect User Guide 

17  Creating a Custom Surface 

Custom surfaces are created by measuring points and lines in the field and building a surface from the 
measured geometry - all done directly on the Control Box. The operator measures points using the bucket 
tip or the GNSS receiver on a rod, edits elevations to achieve design grade, creates polygons (closed 
shapes) or polylines (open lines), and then generates a surface from the linework. 

This is the most flexible surface creation method — it can produce any shape, including irregular 
boundaries and slopes.. It is also the most involved, because the operator must measure enough points 
to define the surface accurately. 
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18  Profile Templates — Cross-Section Design 

Profile Templates allow the operator to design a cross-section shape and extrude it along a 3D line to 
create a surface. This is how roads, ditches, channels, and other linear features are built in iDig Connect 
without importing a design file. 

Building a Cross-Section Template 

A cross-section template is built element by element. Each element is defined by either Delta X/Y 
coordinates or Slope and Length. Elements are added sequentially from left to right (or center to edge), 
and the Mirror function creates a symmetric opposite side automatically. 

Applying the Template to a 3D Line 

Once the cross-section template is complete, it is extruded along a 3D line (imported from a DXF file or 
measured in the field). The resulting surface follows the 3D line's horizontal and vertical alignment with 
the cross-section shape applied at every point along the line. Name the surface, assign it to a 3D layer, 
and select it for guidance. 

 
Real-World Example: Rural Road with Ditches 
A rural road design calls for two 12-foot travel lanes at −2% crown, 4-foot shoulders at −4%, and 
V-ditches at 3:1 slopes with a 5-foot flat bottom. The operator creates the cross-section using 
Slope/Length elements: 12 feet at −2% (travel lane), 4 feet at −4% (shoulder), then the ditch profile. 
The Mirror function creates the opposite side. The template is applied along the road centerline 
(imported as a 3D polyline), producing a complete road surface ready for grading guidance. 
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19  Measuring Points 

Points are measured using Create CAD > Create Points. The operator creates a storage layer, selects the 
measurement source (bucket focus point or GNSS receiver on a rod with height entry), and saves each 
point with a name. Measured points can be used for as-built documentation, stakeout reference, or 
surface creation. 
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20  Measuring Lines 

Lines are measured using Create CAD > Create Line. The operator chooses Polygon (closed shape) or 
Polyline (open line), then measures sequential points using the + icon. Each point is added to the line in 
sequence. Save the line and view the results in Map View. 
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21  Navigate to Points 

To navigate to a point, open the Layer Manager, select the layer containing the point, open Menu > Edit 
Entities, highlight the point, and select Open Actions > Add to Guiding. The work screen displays 
horizontal and vertical guidance directing the operator to the point. A shortcut is available: tap the point 
directly in Map View to add it to guidance. 
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22  Using Lines for Guidance 

To use a line for guidance, tap the line in Map View and select Add to Guiding. The work screen displays 
horizontal guidance (distance and direction to the line) and vertical guidance (cut/fill to the line's elevation) 
as the operator moves the bucket toward the line. 
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23  Staking Surfaces 

To stake to a surface, open the Layer Manager, select the layer containing the surface, and choose Select 
for Guiding. The work screen displays cut/fill guidance to the surface at every bucket position. For 
combined horizontal and vertical guidance, add a centerline node (a 3D line on the surface) to provide the 
system with a reference line for horizontal offset guidance in addition to the cut/fill. 
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24  Guide Complete 

This concludes the iDig Connect User Guide series. Volumes 1 through 8 cover the complete lifecycle of 
an iDig Connect system — from unboxing and licensing through hardware installation, GNSS 
configuration, machine calibration, system settings, the user interface, project management, and daily 
field operations. 

Appendices 

Two appendices are planned for addition to the guide series: Appendix A (Troubleshooting) and Appendix 
B (Reference Tables). These will be published as separate documents and cross-referenced throughout 
the main volumes. 

Need Help? 

Contact your iDig dealer for assistance with any aspect of the iDig Connect system. For real-time support, 
use the Remote Access feature described in Volume 1 Section 09.  
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Appendix A 

Troubleshooting 
iDig Connect systems — diagnostic guidance and common-issue resolution 
 
[Content to be provided.] 
This appendix is reserved for troubleshooting procedures covering the iDig Connect Control 
Box, Bluetooth sensors, Spotman GNSS receiver, iPoint, calibration, and field-operation issues 
referenced throughout Volumes 1–8. Content will be added in a future revision.  
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Appendix B 

Parts & Accessories 

iDig Connect systems, components, Spotman GNSS, iPoint, and accessories · 2026 part 
number reference 

Contents 

B.1  How to Use This Appendix 
B.2  Complete Connect Systems 
B.3  Software Licenses 
B.4  Bluetooth Sensor Kits 
B.5  Plate Kits 
B.6  Extra Machine Kits 
B.7  GNSS & iPoint 
B.8  Cables 
B.9  Calibration Tools 
B.10  Other Accessories 
B.11  Replacement Parts (Sold Individually) 
B.12  Dealer Demo & Mounting Hardware 
B.13  Extended Warranty 
B.14  Warranty & Returns 
B.15  Part Number Quick Index 
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B.1   How to Use This Appendix 

This appendix is the authoritative parts reference for the iDig Connect product line. It lists every 
component that ships with or can be added to a Connect system — the Control Box, the 
sensors, the plates, the Spotman GNSS receiver, iPoint, cables, calibration tools, and the 
accessories and spare parts that complete a full installation. 

This is a part number reference, not a price list. For current pricing, availability, and order 
placement, contact your iDig dealer. 

iDig Touch parts and Touch-only accessories are not included here. This appendix covers only 
the Connect line, the Spotman GNSS receiver, iPoint, and their shared accessories. 

The Three Ways to Use This Appendix 

•​ By system. If a customer is buying or specifying a complete Connect system, start with 
§B.2. Each complete system listing details what's inside the bundle, so an estimator can 
confirm at a glance what's included before adding extras. 

•​ By component. If you need a single component — a replacement bucket sensor, an 
extra plate kit, a Big Combo sensor for a machine already in service — §B.4 through 
§B.12 are organized in the order the component appears during a typical installation: 
sensor kits, then plates, then extra machine kits, then GNSS, cables, calibration tools, 
and accessories. 

•​ By part number. If you already know the part number and want to look it up, §B.15 is an 
alphabetical index of every part in this appendix. The index lists each part with its name 
and the section it appears in. 

CONFIRM BEFORE YOU ORDER 
Confirm with your iDig dealer that the part numbers shown here reflect current inventory 
before placing a purchase order. Part numbers are stable but occasionally change between 
annual catalogs — particularly when a component is superseded by a newer generation. 
The dealer can also confirm current lead times, which vary by component and by time of 
year. 
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B.2   Complete Connect Systems 

Every Connect system shipping in 2026. Systems are ordered from lowest tier to highest; Big 
Combo variants sit next to their standard counterparts. System bundles include everything 
required to install on one machine, and the 2D Project and 3D bundles add the Spotman GNSS 
receiver and the iPoint software. 

Part 
Number 

Description 

CT740 iDig CONNECT 2D+ System 
Complete 2D+ system. Includes the BT142 Control Box, BT445 LED Bargraph, two 
BT407 Bluetooth Mini Sensor Kits (boom and bucket), one BT411 Bluetooth Combo 
Sensor Kit (stick), one BT408 2D/3D Mini Chassis Sensor Kit (BT476 chassis sensor + 
plate), cradles, cabling, and the BT485 transport bag. 

CT741 iDig CONNECT 2D+ Big Combo System 
Identical to CT740 but substitutes the BT437 Bluetooth Big Combo Sensor Kit (BT147 
+ XD436 plate) for the stick position. Preferred for machines that work regularly off a 
rotating laser reference — the Big Combo's larger laser capture window speeds up 
daily re-benching. 

CT745-K iDig CONNECT 2D Project System 
2D Project tier bundle. Includes one CT740 2D+ system, the CT150 3D Lite software 
license (required for 2D Project-level functionality), one CT140T Spotman GNSS 
receiver with tilt, and the CT141 iPoint software license. 

CT746-K iDig CONNECT 2D Project Big Combo System 
Same as CT745-K but built on the CT741 Big Combo base system. 

CT750-K iDig CONNECT 3D System 
Full 3D tier bundle. Includes one CT740 2D+ system, the CT151 3D software license, 
one CT140T Spotman GNSS receiver with tilt, and the CT141 iPoint software license. 

CT751-K iDig CONNECT 3D Big Combo System 
Same as CT750-K but built on the CT741 Big Combo base system. This is the 
highest-specification single-machine Connect configuration. 

 

REAL-WORLD TIP 
The Big Combo configurations (CT741, CT746-K, CT751-K) are worth specifying for any 
crew that sets up a rotating laser at the start of every shift — the BT147 Big Combo's larger 
laser-capture window saves meaningful time on daily re-benching. For crews that operate 
predominantly in GNSS mode, the standard BT145 Combo is the better match. When in 
doubt, ask the dealer how the crew actually works before specifying. 
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B.3   Software Licenses 

Software licenses are independent of the hardware and can be purchased at any time to 
upgrade a system in the field. Feature licenses (Swing Boom, Dynamic Laser Catch) do not 
require a tier upgrade and are added à la carte. 

Part 
Number 

Description 

CT150 3D Lite Software License 
Software upgrade from 2D+ to 3D Lite (the 2D Project tier). Unlocks single-DXF design 
work up to 150 m × 150 m. 

CT137 3D Lite → 3D Upgrade License 
Software upgrade from 3D Lite to full 3D. Unlocks unlimited design size, multi-DXF 
handling, and the full 3D viewer. Use this when a customer originally bought 2D 
Project and needs to step up to 3D. 

CT151 3D Software License 
Full 3D software license for CT740 and CT741 systems. This is the direct 2D+ to 3D 
license (as opposed to going via 3D Lite). 

CT145 Swing Boom Assistance License 
Feature license for Swing Boom Assistance. Connect v5 software only. 

CT155 Dynamic Laser Catch License 
Feature license for Dynamic Laser Catch. Connect v5 software only. 

— Skidsteer Attachments Software 
Feature license for skidsteer attachment workflows. Connect v5 software only. Part 
number pending release. 

 

LICENSE UPGRADE PATHS 
There are two paths from 2D+ to full 3D. The first is a direct CT151 3D license. The second 
is an intermediate CT150 (3D Lite) license — which enables 2D Project-tier work with a 
single DXF — followed later by a CT137 upgrade to full 3D. The intermediate path lets the 
customer validate the workflow at the 2D Project tier before committing to full 3D. Your 
dealer can walk through which path makes sense for the customer's current and future 
work. 
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B.4   Bluetooth Sensor Kits 

Sensor kits bundle the sensor with its matching plate kit (plate, adhesives, cleaning wipes). For 
a replacement where the plate is still on the machine and serviceable, see §B.10 for bare 
sensor part numbers. 

Part 
Number 

Description 

BT407 Bluetooth Mini Sensor Kit 
One BT144 Bluetooth Mini Sensor plus one XD422 Mini Plate Kit (plate, 2 small-format 
adhesives, 2 cleaning wipes). Used for boom and bucket positions. 

BT411 Bluetooth Combo Sensor Kit 
One BT145 Bluetooth Combo Sensor plus one XD412 Combo Plate Kit. The 
stick-position kit that ships with the standard CT740 system — includes the built-in 
laser receiver. 

BT437 Bluetooth Big Combo Sensor Kit 
One BT147 Bluetooth Big Combo Sensor plus one XD436 Big Combo Plate Kit. The 
larger-capture-window alternative to BT411 — ships with the CT741 system. 

BT408 2D/3D Mini Chassis Sensor Kit 
One BT476 Bluetooth Mini 2D/3D Chassis Sensor plus one XD422 Mini Plate Kit. The 
chassis sensor used on all current Connect installations. Wired for power via CT425C 
to the cradle; communicates with the Control Box over Bluetooth. 

 

KIT VS. BARE PART 
Each sensor kit in this section bundles the sensor with its matching plate kit. If a plate is 
already installed on the machine and in good condition, order the bare sensor from §B.11 
instead — the plate is permanent and almost always outlasts the sensor. Ordering the full 
kit when only the sensor is needed means an unused plate kit and a set of adhesives. 
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B.5   Plate Kits 

Plate kits attach to the machine with permanent 3M adhesive. Each kit ships with the plate, the 
correct adhesive size, and cleaning wipes. 

Part 
Number 

Description 

XD412 Combo Plate Kit 
One Combo plate, two XD416 large-format adhesives, two XD417 cleaning wipes. For 
the stick-mounted BT145 Combo Sensor. 

XD422 Mini Plate Kit 
One Mini plate, two XD416MS small-format adhesives, two XD417 cleaning wipes. For 
BT144 Mini Sensors (boom, bucket) and the BT476 chassis sensor. 

XD436 Big Combo Plate Kit 
One Big Combo plate, four XD416 large-format adhesives, four XD417 cleaning wipes. 
For the BT147 Big Combo Sensor. 

 

CRITICAL 
Plate kits use permanent 3M adhesive. Once a plate is installed on a machine, it does not 
come off cleanly. Always confirm sensor position and machine geometry before committing 
to the adhesive — see Volume 2 for the installation procedure and Volume 4 for the 
calibration flow that follows. 
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B.6   Extra Machine Kits 

An extra machine kit is what you order when an existing Connect customer adds a second (or 
third) machine and wants to use the same Control Box. The kit includes a cradle set, plate kits, 
and the cables and adhesives to complete the second installation. 

Part 
Number 

Description 

BT527 Extra Machine Kit — CT740 with XD476 chassis 
For adding a CT740 system to a second machine where the chassis is the XD476 2D 
sensor. Includes BT447 Control Box Cradle, CT149 LED Display Cradle, plate kits (2× 
XD412, 2× XD422), CT425C Y-shielded power cable, XD440 suction cup and arm, 
CT135 double suction cup and arm, adhesives, and cleaning wipes. 

BT528 Extra Machine Kit — CT741 with XD476 chassis 
Same as BT527 but with one XD412 Combo and one XD436 Big Combo plate kit, for a 
CT741-based second machine using the XD476 chassis sensor. 

BT531 Extra Machine Kit — CT740 with BT476 chassis 
For adding a CT740 system to a second machine where the chassis is the BT476 
Bluetooth 2D/3D sensor (current standard). Includes BT447, CT149, 1× XD412, 3× 
XD422, CT425C, XD440, CT135, adhesives, and cleaning wipes. 

BT532 Extra Machine Kit — CT741 with BT476 chassis 
Same as BT531 but with an XD436 Big Combo plate kit added, for a CT741-based 
second machine using the BT476 chassis sensor. 

 

WHICH EXTRA MACHINE KIT? 
The four BT5xx extra machine kits differ on two dimensions: stick size (CT740 base = 
BT527/BT531, CT741 Big Combo base = BT528/BT532) and chassis sensor generation 
(XD476 = BT527/BT528, current-standard BT476 = BT531/BT532). Confirm the second 
machine's chassis sensor before ordering. All current commissions on new machines use 
the BT476, so BT531 and BT532 are the right defaults. 
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B.7   GNSS & iPoint 

All parts related to the Spotman GNSS receiver — the machine-mounted receiver, the rover kit, 
the off-machine survey hardware, and the iPoint software license. 

Part 
Number 

Description 

CT140T-K Spotman Rover Kit 
Full off-machine rover bundle. Includes one CT140T Spotman GNSS with tilt, CT141 
iPoint software license, CT133 8-inch tablet data collector, CT146 tablet holder, CT148 
2m rover pole, CT152 quick-release male/female connector, and BT486 transport 
backpack. Use when the contractor surveys points away from the machine. 

CT140T Spotman GNSS Receiver (with Tilt) 
The GNSS receiver that mounts on the cab roof for 2D Project and 3D tiers. Integrated 
tilt sensor. Ships standard with every CT745-K / CT746-K / CT750-K / CT751-K 
system. 

CT141 iPoint Software License 
Software license for the iPoint application — the off-machine survey and stakeout app 
that runs on the CT133 tablet and pairs with the Spotman. Ships with every 2D Project 
and 3D bundle. 

CT133 Tablet Data Collector 
Eight-inch tablet that runs the iPoint application. Sold separately or as part of the 
CT140T-K rover kit. 

CT146 Tablet Holder 
Mounting holder for the CT133 tablet. Ships with the CT140T-K rover kit. 

CT139 Small GNSS Machine Support 
6.3-inch INOX stainless steel GNSS mounting pole. Used when the machine's cab 
geometry allows the shorter mount while still achieving the required 1 m offset from the 
center of rotation. 

CT139-L Big GNSS Machine Support 
15.75-inch carbon fiber GNSS mounting pole. Used when additional offset is required 
to meet the 1 m minimum distance from the center of rotation. 

CT152 GNSS Quick Release — Male/Female Pair 
Quick-release connector pair for switching the Spotman between the machine mount 
and the rover pole. One male and one female. Ships with the CT140T-K rover kit. 

CT153 GNSS Quick Release — Female Only 
Additional female quick-release connector. Used when a customer needs a second 
machine mount point and already has a CT152 pair. 

BT486 Rover Transport Backpack 
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Part 
Number 

Description 

Padded transport backpack sized for the CT140T Spotman and its accessories. Ships 
with the CT140T-K rover kit. 

CT148 2m Rover Pole 
Four-piece 2-meter rover pole for off-machine survey. Breaks down for transport in the 
BT486 backpack. Ships with the CT140T-K rover kit. 

BT248 Bluetooth Button 
Wireless pushbutton paired to the Control Box over Bluetooth. When activated, it 
triggers Swing Boom Assistance, Dynamic Laser Catch, and setting a benchmark — 
shortcuts for operations the operator otherwise reaches through the on-screen menu. 

 

1-METER OFFSET REQUIREMENT 
The Spotman GNSS receiver must be mounted at least 1 meter from the machine's center 
of rotation for correct heading resolution. This is what drives the two mount options — 
CT139 (6.3 inches, stainless) for machines where cab geometry allows, and CT139-L 
(15.75 inches, carbon) when additional offset is required. Confirm the geometry before 
ordering; an undersized mount is the most common reason a GNSS installation has to be 
re-done. 
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B.8   Cables 

Cables specific to Connect systems. The CT425C is the standard chassis-sensor cable for 
every current installation. XD448 and XD449 are tiltrotator integration cables. 

Part 
Number 

Description 

CT425C Armored Y Power Cable (4-pin) 
Shielded Y-cable from the BT142 Control Box cradle to the BT476 2D/3D Bluetooth 
Mini Chassis Sensor. Standard chassis-sensor power cable for all current Connect 
installations. 

CT242 Spotman Power Cable 
12 V power cable with battery connectors, for powering the CT140T Spotman from the 
machine's electrical system when the rover is in off-machine use. 

XD448 Steelwrist Cable (6 ft., shielded) 
Sensor cable for CAN integration with Steelwrist tiltrotators. 

XD449 ENGCON Cable (15 ft.) 
Sensor cable for CAN integration with ENGCON tiltrotators. The longer length 
accommodates ENGCON's typical stick routing. 
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B.9   Calibration Tools 

The calibration toolkit ships in a dedicated black soft roll-up case with every new Connect 
system. These items are used during the boom and stick wizard calibration in Volume 4 and are 
reused across every machine you install on. 

Part 
Number 

Description 

XB525 Laser Pointer 
Laser pointer with L-bar and 5/8-inch to 1/4-inch connector. Provides the laser line 
used during the boom and stick wizard calibration. 

XD477 5/8-inch Adapter 
Fits the XB525 laser pointer to non-elevating tripods. 

XD478 Adapter 5/8-inch to 1/4-inch 
Fits the XB525 laser pointer to the tripod setup. 

XD470 Magnetic Target Tube 
Mounts magnetically to the bucket teeth or stick to provide a target for initial sensor 
alignment and laser calibration. 

XD471 Extension Poles (2 pieces) 
Two extension poles for use during initial setup and laser calibration. 

 

iDig North America  |  Page 206 



iDig Connect User Guide 

B.10   Other Accessories 

Consumables, dongles, transport cases, and the small items that get misplaced during an 
install. The XD416, XD416MS, and XD417 are replacements for the adhesives and wipes 
bundled with plate kits. 

Part 
Number 

Description 

BT244 WiFi & Bluetooth Dongle 
The standard BT/WiFi dongle that installs in the Control Box cradle's top-left USB port. 
Ships with every Connect system. 

BT249 WiFi & Bluetooth Dongle with External Antenna 
Long-range version of BT244, with external antenna. Use when the standard dongle's 
range is insufficient for a given cab or shop environment. 

BT485 Transport Case — CONNECT 
Rugged foam-lined case sized for all iDig Connect systems. Ships as the outer case 
with every Connect system. 

XD416 Adhesive Tape — Size L 
Large-format 3M adhesive tape. For XD412 Combo and XD436 Big Combo plates. 
Sold individually. 

XD416MS Adhesive Tape — Size S 
Small-format 3M adhesive tape. For XD422 Mini plates. Sold individually. 

XD417 Cleaning Pad 
Surface-prep cleaning wipe, used to prepare the machine surface before applying a 
plate adhesive. Sold in minimum quantities of 2. 
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B.11   Replacement Parts (Sold Individually) 

Major components sold as bare parts — without plate kits, cradles, or cables — for replacement. 
Use these part numbers when a sensor or display needs swapping but the rest of the 
installation is still good. 

Part 
Number 

Description 

BT142 Series 74 Control Box 
The Control Box used by all Connect systems. Sold separately for replacement or 
expansion. 

CT149 Control Box Cradle (for BT142) 
Suction-cup cab cradle for the BT142 Control Box. Sold separately for replacement or 
additional machines. 

BT445 LED Bargraph (Bluetooth) 
The LED Bargraph display that mounts on the front window of the cab. Sold separately 
for replacement. 

BT447 LED Bargraph Cradle 
Suction-cup cradle for the BT445 LED Bargraph. Sold separately for replacement. 

BT144 Bluetooth Mini Sensor (no plate) 
Bare BT144 sensor without plate kit. For replacement when the plate is still 
serviceable. 

BT145 Bluetooth Combo Sensor (no plate) 
Bare BT145 Combo Sensor without plate kit. Includes the integrated laser receiver. 

BT147 Bluetooth Big Combo Sensor (no plate) 
Bare BT147 Big Combo Sensor without plate kit. Larger laser-capture window than the 
BT145. 

BT476 2D/3D Bluetooth Mini Chassis Sensor (no plate) 
Bare chassis sensor without plate kit. The current standard chassis sensor for Connect 
installations. 
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B.12   Dealer Demo & Mounting Hardware 

Dealer-facing items: non-permanent magnetic demo plates (for showing an iDig system on a 
customer's machine without committing to adhesive), the desktop demo excavator, and 
alternative RAM-style mounts for cabs where the standard suction cup does not hold. 

Part 
Number 

Description 

XD424 Magnetic Plate — for XD412 and XD422 
Magnetic demo plate that mimics the XD412 Combo and XD422 Mini plates. Allows a 
dealer to demonstrate an iDig system on a customer's machine without applying 
permanent adhesive. 

XD438 Magnetic Plate — for XD436 
Magnetic demo plate for the XD436 Big Combo plate. Same purpose as XD424. 

XD455 Demo Trolley — Excavator 
Desktop demo excavator model with trolley carrying case, four plates, and power 
supply. Used by dealers to demonstrate the system without a real machine. 

XD440 Suction Cup & Mount (Size B) 
RAM-style suction cup mount for either the LED Bargraph (BT445) or the BT142 
Control Box. 

XD441 Clamp (Size B) 
RAM-style clamp mount for the LED Bargraph or Control Box, as an alternative to the 
suction-cup mount. 

CT135 Double Suction Cup (Size C) and Arm 
Double suction-cup mount sized for the BT142 Connect Control Box. Used in cabs 
where the standard cradle suction cup does not hold reliably. 

 

iDig North America  |  Page 209 



iDig Connect User Guide 

B.13   Extended Warranty 

The Connect system ships with a standard warranty of 12 months from the date of sale to the 
end user, or 15 months from the date of sale to the dealer, whichever comes first. Extended 
warranty extends coverage to 24 months and includes software upgrades during the warranty 
period. 

Part 
Number 

Description 

CT492 Extended Warranty — 24 months (Connect) 
Extends warranty coverage on a Connect system from the standard 12 months to 24 
months. Includes software upgrades during the warranty period. 

 

iDig North America  |  Page 210 



iDig Connect User Guide 

B.14   Warranty & Returns 

The terms below apply to iDig Connect parts and systems in North America. For ordering, lead 
times, shipping terms, and current pricing, contact your iDig dealer. 

Standard Warranty 

Bridgin, the parent company of iDig, provides a one-year warranty on its systems and 
components. The warranty period begins on the date of sale to the end user by the dealer, or 
fifteen months from the date of sale to the dealer, whichever comes first. 

The warranty does not apply under the following conditions: the serial number is unreadable or 
has been removed; the item has been modified or repaired by an unauthorized person; or the 
defect was caused by improper use. 

The extended warranty (CT492, §B.13) extends coverage to 24 months and includes software 
upgrades during the warranty period. 

INSPECTION ON DELIVERY 
All products must be inspected upon delivery. Any shipping damage must be documented 
with the carrier and communicated to iDig within 24 hours of receipt. Catching a damaged 
shipment on day one is the difference between a straightforward replacement and a 
contested claim. 

Returns 

Goods in their original delivered condition may be returned to iDig within 14 days of the invoice 
date. After inspection, iDig will process the return through your dealer. 

Goods returned after 14 days are subject to a depreciation deduction, calculated from the 
invoice date to the date of arrival and inspection by iDig. Before any return, a Return 
Merchandise Authorization (RMA) must be requested — returns without an RMA cannot be 
processed. 

RMA Contact 
Send RMA requests and return-related correspondence to: 

iDig Inc. 
c/o Mr. Oliver Woolley 

2201 Statham Blvd., #114 

Oxnard, CA 93033 
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o.woolley@idig-system.com 

805-320-4738 
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B.15   Part Number Quick Index 

Every part in this appendix, alphabetically by part number. Use this index to look up a part when 
you already know the number — for example, from an existing quote, a prior order, or a sensor 
label in the field. 

Part # Name Part # Name 

BT142 Series 74 Control Box CT150 3D Lite Software License 

BT144 Bluetooth Mini Sensor (no plate) CT151 3D Software License 

BT145 Bluetooth Combo Sensor (no plate) CT152 GNSS Quick Release — 
Male/Female Pair 

BT147 Bluetooth Big Combo Sensor (no 
plate) 

CT153 GNSS Quick Release — Female 
Only 

BT244 WiFi & Bluetooth Dongle CT155 Dynamic Laser Catch License 

BT248 Bluetooth Button CT242 Spotman Power Cable 

BT249 WiFi & Bluetooth Dongle with 
External Antenna 

CT425C Armored Y Power Cable (4-pin) 

BT407 Bluetooth Mini Sensor Kit CT492 Extended Warranty — 24 months 
(Connect) 

BT408 2D/3D Mini Chassis Sensor Kit CT740 iDig CONNECT 2D+ System 

BT411 Bluetooth Combo Sensor Kit CT741 iDig CONNECT 2D+ Big Combo 
System 

BT437 Bluetooth Big Combo Sensor Kit CT745-K iDig CONNECT 2D Project System 

BT445 LED Bargraph (Bluetooth) CT746-K iDig CONNECT 2D Project Big 
Combo System 

BT447 LED Bargraph Cradle CT750-K iDig CONNECT 3D System 

BT476 2D/3D Bluetooth Mini Chassis 
Sensor (no plate) 

CT751-K iDig CONNECT 3D Big Combo 
System 

BT485 Transport Case — CONNECT XB525 Laser Pointer 

BT486 Rover Transport Backpack XD412 Combo Plate Kit 

BT527 Extra Machine Kit — CT740 with 
XD476 chassis 

XD416 Adhesive Tape — Size L 

BT528 Extra Machine Kit — CT741 with 
XD476 chassis 

XD416MS Adhesive Tape — Size S 

BT531 Extra Machine Kit — CT740 with 
BT476 chassis 

XD417 Cleaning Pad 

BT532 Extra Machine Kit — CT741 with 
BT476 chassis 

XD422 Mini Plate Kit 

CT133 Tablet Data Collector XD424 Magnetic Plate — for XD412 and 
XD422 

CT135 Double Suction Cup (Size C) and 
Arm 

XD436 Big Combo Plate Kit 
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Part # Name Part # Name 

CT137 3D Lite → 3D Upgrade License XD438 Magnetic Plate — for XD436 

CT139 Small GNSS Machine Support XD440 Suction Cup & Mount (Size B) 

CT139-L Big GNSS Machine Support XD441 Clamp (Size B) 

CT140T Spotman GNSS Receiver (with Tilt) XD448 Steelwrist Cable (6 ft., shielded) 

CT140T-K Spotman Rover Kit XD449 ENGCON Cable (15 ft.) 

CT141 iPoint Software License XD455 Demo Trolley — Excavator 

CT145 Swing Boom Assistance License XD470 Magnetic Target Tube 

CT146 Tablet Holder XD471 Extension Poles (2 pieces) 

CT148 2m Rover Pole XD477 5/8-inch Adapter 

CT149 Control Box Cradle (for BT142) XD478 Adapter 5/8-inch to 1/4-inch 
 

 

End of Appendix B — Parts & Accessories.  
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Appendix C 

Release History 

Every documented iDig Connect firmware release, from v4.14.0 through v5.3.4 · Version 
lineage, feature timeline, and release-by-release detail 

Contents 

C.1  How to Use This Appendix 
C.2  Release Timeline at a Glance 
C.3  The v4 → v5 Transition — What Changed and Why 
C.4  Feature Lineage — When Each Major Feature Arrived 
C.5  v5.x Release Detail 
C.6  v4.x Legacy Release Summary 
C.7  How to Read a Release Note 
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C.1   How to Use This Appendix 

This appendix documents every iDig Connect firmware release from v4.14.0 through v5.3.4 — 
sixty releases spanning roughly three years of continuous development. It is intended as a 
reference, not a narrative: find the version the Control Box is running, look up what changed in 
that release, and move on. 

The material is organized to answer the three questions that come up most often in the field. 
What version am I on, and is that the right one for this machine? What was added, fixed, or 
removed between my version and the current release? When did a specific feature — Smart 
Tape, tiltrotator CAN support, dual-GNSS on attachments — first ship? 

The Four Ways Into This Appendix 

•​ By version. If you know the version number, go to §C.5 for v5.x releases or §C.6 for 
v4.x legacy releases. Every v5.x version has its own entry. v4.x versions are grouped 
into a summary table. 

•​ By date. The timeline in §C.2 lists every release in order, newest first, with a one-line 
headline for each. Scan it to find the release that matches when a machine was 
commissioned or last updated. 

•​ By feature. §C.4 is a feature lineage — the list of major features in alphabetical order, 
each tagged with the version it first appeared in. Use this when a dealer asks "what's the 
oldest version that supports X?" 

•​ By reading the whole thing. §C.3 tells the story of the v4-to-v5 architectural rewrite, 
which is the single most important thing to understand if you support machines in the 
field. Everything else in this appendix makes more sense once §C.3 is read. 

BEFORE YOU START 
The Control Box displays its current firmware version at the bottom of the main Settings 
screen, near the serial number. If a machine is on site and something isn't behaving the way 
this guide describes, check the firmware version first — a subtle UI difference or a missing 
feature is almost always a version mismatch, not a fault. 
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C.2   Release Timeline at a Glance 

Every release from v4.14.0 through the current v5.3.4, newest first. The one-line headline 
captures the release's headline change — the full detail is in §C.5 (v5.x) and §C.6 (v4.x). 

Rows tagged "current" mark the release shipping at the time this volume went to press. Rows 
tagged "v5 start" and "v4 legacy" mark the boundary between the v5 platform rewrite and the v4 
line that preceded it. The row tagged "hardware break" marks v4.15.0, which dropped 
compatibility with the legacy XD466 chassis sensor — a machine still running the XD466 cannot 
move past v4.14.15 until the chassis sensor is upgraded. 

Version Headline Tag 

v5.3.4 Attachment & skidsteer refinements; simulator-over-ethernet 
detection 

current 

v5.3.3 Stability pass for the 3D engine introduced in v5.3.0  

v5.3.0 Major expansion: dozer blades, skidsteers, backhoes, 
attachments, Machine Control Ready 

 

v5.2.9 Wireless range and connection stability improvements  

v5.2.8 Fixes for tilt-sensor calibration and GNSS loss recovery  

v5.2.7 Tiltrotator encoder support; surface wizard refinements  

v5.2.5 Profile wizard polish; additional CAN tiltrotator models  

v5.2.4 Site calibration quality-of-life and crash fixes  

v5.2.3 Layer panel and project import improvements  

v5.2.2 Tiltrotator CAN support and additional localization formats  

v5.2.1 Early-v5.2 stability and translation sweep  

v5.2.0 Rotators (wired tilt), telescopic dippers, Profile Wizard, 
large-area site calibration 

 

v5.1.7 Minor fixes on the v5.1 branch  

v5.1.6 Bluetooth pairing, import/export, and 3D view fixes  

v5.1.5 3D depth-guiding polish and additional tiltrotator options  

v5.1.4 Wireless sensor behaviour and calibration fixes  

v5.1.3 Front/Side view improvements; cloud sync fixes  

v5.1.2 Sensor diagnostics and crash fixes  

v5.1.1 Follow-up fixes to the v5.1.0 3D engine  

v5.1.0 3D feature restored; new 3D algorithm; 2D+; Bluetooth 
double-click; manual bucket calibration 

 

v5.0.2 Stability fixes on the post-rewrite platform  
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Version Headline Tag 

v5.0.1 Follow-up fixes to v5.0.0 with Dynamic Guiding and Swing  

v5.0.0 Platform rewrite: new calibration, Dynamic Guiding, Swing 
feature, Remote button 

v5 start 

v4.16.5 Smart Tape direction prompt fix; surface guiding fix v4 legacy 

v4.16.4 Bug-fix release  

v4.16.3 Bug-fix release  

v4.16.2 Bug-fix release  

v4.16.1 Bug-fix release  

v4.16.0 Late-v4 feature additions  

v4.15.13 Maintenance release  

v4.15.12 Maintenance release  

v4.15.11 SmartTape 2D→3D view fix; guiding-line extension  

v4.15.10 Maintenance release  

v4.15.9 Maintenance release  

v4.15.8 Maintenance release  

v4.15.7 Maintenance release  

v4.15.6 Maintenance release  

v4.15.5 Maintenance release  

v4.15.4 Smart Tape feature introduced; 3D improvements  

v4.15.3 Maintenance release  

v4.15.2 Maintenance release  

v4.15.1 Maintenance release  

v4.15.0 NOT compatible with legacy XD466 chassis sensor — 
transition point 

hardware break 

v4.14.15 Last-generation XD466-compatible maintenance  

v4.14.14 Maintenance release  

v4.14.13 Maintenance release  

v4.14.12 Maintenance release  

v4.14.11 Maintenance release  

v4.14.10 Maintenance release  

v4.14.9 Maintenance release  

v4.14.8 Maintenance release  
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Version Headline Tag 

v4.14.7 Maintenance release  

v4.14.6 Maintenance release  

v4.14.5 Maintenance release  

v4.14.4 Maintenance release  

v4.14.3 Maintenance release  

v4.14.2 Maintenance release  

v4.14.1 Maintenance release  

v4.14.0 Remote Software Update; 3D Auger/Clamshell; NEKR Roto; 
WiFi recovery 

oldest 
documented 

 

REAL-WORLD TIP 
When a machine comes in from the field on an older firmware, it almost never makes sense 
to jump it straight to the newest release. Read the headline for the current version, then 
step back through the timeline until you find the version the machine is on. The entries in 
between tell you what the operator will see that's different — which menus moved, which 
features appeared, and which calibrations need to be redone. Jumping versions without 
reading the intermediate entries is how small surprises become field support calls. 
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C.3   The v4 → v5 Transition — What Changed and 
Why 

v5.0.0 was not a normal release. It was a platform rewrite. The Control Box software was rebuilt 
from the ground up on a new architecture, and several features that had been in the v4 line 
were temporarily removed so that the new platform could ship on a clean, stable base. Those 
features returned progressively through the v5.1, v5.2, and v5.3 lines — but understanding 
which features left and when they came back is the single most important piece of knowledge 
for anyone supporting machines across the transition. 

What Was Removed at v5.0.0 

The v5.0.0 release shipped as a Pure 2D System. The following were not available in v5.0.0, 
regardless of what had been working on the same machine under v4: 

•​ 3D guidance and 3D project viewing. 
•​ Auger work tool support. 
•​ Roto work tool support. 
•​ Dozer blade support. 
•​ Clamshell support. 

In addition, v5.0.0 required a full new calibration — the calibration data from a v4 machine could 
not be carried forward — and all wireless sensors had to be re-paired to the Control Box after 
the update. 

What Was Added at v5.0.0 

•​ Dynamic Guiding and Dynamic Laser Catch. The guidance updates continuously as 
the machine moves, rather than only at discrete checkpoints. This is the change 
operators notice first when moving from v4 to v5. 

•​ Swing Boom Assistance. A dedicated feature for machines with swing-boom geometry. 
•​ The Remote button. A dedicated on-screen entry point for remote support sessions, 

which previously lived several menus deep. 

When Removed Features Returned 

The features removed at v5.0.0 came back in this order: 

Feature Returned in 

3D feature v5.1.0 — with an entirely new 3D algorithm 

Tiltrotator CAN support v5.2.2 — CAN bus reading, eliminating separate wired 
sensors on CAN-equipped machines 
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Feature Returned in 

Rotator (as wired tilt) v5.2.0 — ePS2 platform only 

Telescopic dipperstick v5.2.0 — via the Baumer R600V radar 

Dozer blade (excavator) v5.3.0 — simple and double-offset 

Skidsteer v5.3.0 — radial lift, 2D+ and 3D with one GNSS 

Backhoe (swing-sensor 
configuration) 

v5.3.0 

Attachment mode v5.3.0 — two-laser in 2D, two-GNSS in 2D+ and 3D 

Auger Still not supported in v5.3.4 as of press time 

Clamshell Still not supported in v5.3.4 as of press time 

 

What This Means for Upgrades 

The practical implications of the transition fall on three groups, and the right answer is different 
for each. 

FOR DEALERS SUPPORTING V4 MACHINES 
A machine running v4 firmware that is working correctly is not a candidate for forced 
upgrade. The v5 line required a full recalibration and sensor re-pairing, and the features the 
operator relies on may not have returned to v5 yet. Before upgrading, look up the features 
currently in use on the machine and confirm they are all supported in the target v5 release. 
The one hard forcing function is hardware: v4.15.0 and later are not compatible with the 
legacy XD466 chassis sensor, and v5 does not recognize v4-calibrated machines at all. If 
the XD466 is still on the machine and the operator is happy, leave the firmware alone. 

FOR DEALERS COMMISSIONING NEW MACHINES 
Any machine commissioned in 2025 or later should be on the v5 line. The 
current-generation BT476 chassis sensor is the standard, the calibration flow is cleaner, 
and Dynamic Guiding is a clear operator upgrade. Start at the highest v5.3.x release that 
supports the work tools the customer runs. See the feature lineage in §C.4 for the specific 
cutoffs. 

FOR OPERATORS ASKING "WHY IS MY MENU DIFFERENT?" 
The v4-to-v5 transition reorganized several menus and changed the calibration flow. If an 
operator who has been running an iDig system for years gets in a cab with v5 for the first 
time, they will notice the difference within a minute. The most visible change is Dynamic 
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Guiding — the values on the bargraph update continuously rather than stepping. The next 
most visible is the Remote button, which is now a single on-screen tap instead of a path 
through Settings. Orient new-to-v5 operators on these two points first; the rest of the 
transition goes smoothly from there. 
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C.4   Feature Lineage — When Each Major Feature 
Arrived 

The major features of iDig Connect, listed alphabetically, each tagged with the release in which 
it first shipped. Use this table to answer "what's the oldest version that supports X?" without 
reading the full timeline. 

A feature shown against a v5.x version was either new in v5 or was the re-introduction of a v4 
feature after the platform rewrite. In the latter case, the v4 origin of the feature is not repeated 
here — see §C.6 for the v4 lineage. 

Feature First shipped in 

Attachment mode (two lasers or two GNSS) v5.3.0 

Backhoe with swing sensor v5.3.0 

Bluetooth double-click button v5.1.0 

Customizable 3D map background v5.3.4 

Dozer blade (excavator, simple/double offset) v5.3.0 

Dual-GNSS on attachments v5.3.4 

Dynamic Laser Catch v5.0.0 

Ethernet Cbox detection (Simulator scan) v5.3.4 

Large-area site calibration (>50m × 50m, left-handed) v5.2.0 

Machine Control Ready v5.3.0 

Manual bucket calibration with laser pointer v5.1.0 

New 3D algorithm v5.1.0 

Profile Wizard v5.2.0 

Remote button v5.0.0 

Remote Software Update (OTA) v4.14.0 

Rotators (wired tilt, ePS2) v5.2.0 

Skidsteer (radial lift, 2D+ and 3D) v5.3.0 

Smart Tape measurement v4.15.4 

Swing Boom feature v5.0.0 
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Feature First shipped in 

Telescopic dippersticks (Baumer R600V radar) v5.2.0 

Tiltrotator CAN support v5.2.2 

Tunable GNSS thresholds (Fine/Medium/Coarse) v4.14.0 
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C.5   v5.x Release Detail 

Every v5.x release in reverse chronological order, newest first. Each entry gives a short 
headline, any context that matters for the release, and then the changes grouped as Added 
(new capabilities), Improved (existing capabilities made better), Fixed (bugs corrected), and 
Limitations (known restrictions called out by the release). 

Not every category appears in every release. A maintenance-only release may have only a 
Fixed list; a major release may have all four. 

v5.3.4 — Attachment and skidsteer calibration polish 

The current shipping release at the time this volume went to press. The focus was on 
refinements to the attachment and skidsteer workflows introduced in v5.3.0 and on streamlining 
how multiple GNSS receivers behave together. 

Added 

•​ Automatic detection of the Control Box over Ethernet — used by the Simulator scan. 
•​ An AB length parameter during skidsteer calibration. 
•​ Attachment and excavator demo licenses that were previously missing. 
•​ Support for two different GNSS receivers on an attachment, with improved handling 

when multiple receivers are live during guiding. 
•​ Virtual joystick in the Simulator tool. 
•​ Customizable background color for the 3D Map view. 
•​ Additional 3D chassis models for attachments and skidsteers. 

Improved 

•​ Chassis calibration for attachments. 
•​ The Wizard calibration setup for excavators. 
•​ The UI of the laser calibration step for attachments. 
•​ Quick customization of the bargraph from inside the guiding views. 
•​ Editable text-box behaviour throughout the interface. 
•​ The bargraph now lights up automatically during brightness tuning. 
•​ Annotations stay visible at all zoom levels in the 3D view. 
•​ Clickable zones are now visible in 2D view so the operator can see what is tappable. 
•​ A three-second wait is now enforced before a new sensor threshold can be confirmed, to 

prevent accidental commits. 

Fixed 

•​ Various UI text and translation corrections. 
•​ Bargraph state is now properly restored after the bargraph is unplugged and replugged. 
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•​ Screensaver exit no longer shows NaN (not a number) on guiding values. 
•​ Excavator dozer blade calibration no longer misbehaves when an offset or double-offset 

is calibrated. 
•​ Several stability fixes in 3D views when switching between projects. 
•​ Zoom on the attachment blade in 3D view. 
•​ Incorrect error messages about machine compatibility. 
•​ Loading a machine that has no tool defined. 
•​ Flat-angle display of the bucket in 3D view. 
•​ Shortest-distance calculation between the bucket and a surface when the bucket is 

outside the surface. 
•​ Skidsteer GNSS calibration and heading system. 
•​ Import of v4 machines is now blocked, and v4 machines already on the SD card cannot 

be edited — this prevents mixing incompatible calibration data. 

Limitations 

•​ Auger and clamshell work tools are still not supported in the v5.3 line. 

v5.3.3 — Stability pass for the v5.3.0 3D engine 

A focused follow-up to v5.3.0 addressing crashes and edge cases in the rewritten 3D pipeline. 
No new features. 

Fixed 

•​ Numerous issues and crashes in the 3D engine. 
•​ Stability fixes across calibration and project workflows. 

Limitations 

•​ No auger or clamshell support. 

v5.3.0 — Major feature expansion across new machine classes 

The v5.3.0 release opened up several new machine classes and work-tool configurations. If the 
dealer is selling into contractors who run anything other than a standard excavator, v5.3.0 is the 
baseline to be on. 

Added 

•​ Simple and double-offset dozer blade for excavators in 2D. 
•​ Skidsteer with radial lift, in 2D+ and 3D with one GNSS. 
•​ Backhoe configuration using a swing sensor instead of a chassis sensor. 
•​ Attachment mode — 2D with two lasers, 2D+ and 3D with two GNSS. 
•​ Machine Control Ready, which increases the computation rate of the system. 
•​ Teeth count handling in 2D. 

iDig North America  |  Page 226 



iDig Connect User Guide 

•​ Rework of the CAN logger with a variable data rate and the ability to log to file. 
•​ The ability to enable or disable the open/close and left/right error indicators via a touch 

area. 

Improved 

•​ Bucket calibration quality indicator. 
•​ Chassis calibration automatically bypasses tilt-specific steps if the machine is detected 

to be flat. 

Fixed 

•​ License warning message sizing. 
•​ Sensor ID saved during tilt calibration. 
•​ TRS encoder support. 
•​ Several additional stability items addressed during the beta cycle. 

Limitations 

•​ No auger, clamshell, double-offset, or dozer features. 

v5.2.9 — Wireless range and connection stability 

Improved 

•​ Wireless sensor connection stability under weak-signal conditions. 
•​ Recovery behaviour when a sensor briefly drops out of range. 

Fixed 

•​ Intermittent disconnects on certain sensor firmware combinations. 

v5.2.8 — Tilt calibration and GNSS recovery fixes 

Fixed 

•​ Tilt-sensor calibration edge cases. 
•​ GNSS loss-of-fix recovery behaviour during an active guiding session. 

v5.2.7 — Tiltrotator encoder support and surface wizard refinements 

Improved 

•​ Tiltrotator encoder integration — wider range of encoder models accepted. 
•​ Surface wizard flow, with clearer prompts during point selection. 

v5.2.5 — Profile wizard polish; additional CAN tiltrotator models 

Added 

•​ Additional CAN tiltrotator models recognized out of the box. 
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Improved 

•​ Profile wizard usability. 
•​ Tiltrotator configuration flow. 

v5.2.4 — Site calibration quality-of-life and crash fixes 

Improved 

•​ Site calibration flow, particularly around point selection on large surfaces. 

Fixed 

•​ Several crashes during long calibration sessions. 

v5.2.3 — Layer panel and project import improvements 

Improved 

•​ Layer panel UI — clearer layer switching and visibility control. 
•​ Project import handling from USB and cloud sources. 

v5.2.2 — Tiltrotator CAN support and additional localization formats 

Added 

•​ CAN tiltrotator support — the system can now read tiltrotator rotation and tilt directly over 
CAN bus, eliminating the need for separate wired sensors on CAN-equipped machines. 

•​ Additional site-calibration file formats accepted. 

v5.2.1 — Early-v5.2 stability and translation sweep 

Fixed 

•​ A range of stability fixes following the v5.2.0 feature release. 
•​ Translation and UI-text adjustments across multiple languages. 

v5.2.0 — Rotators, telescopic dippers, Profile Wizard, large-area site 
calibration 

A feature-heavy release on the v5.2 line. Of particular note: support for rotators as wired tilt 
sensors, support for telescopic dippersticks (via the Baumer R600V radar), and the removal of 
the 50m × 50m size limit on site calibration surfaces. 

Added 

•​ Rotators as wired tilt sensors, on the ePS2 platform only. 
•​ Telescopic dippersticks, using the Baumer R600V radar. 
•​ A Profile Wizard, added to the wizard list. 
•​ Left-handed site calibration on surfaces larger than 50 m × 50 m. 
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•​ A download link for the Android App used in Cloud configuration, shown directly in the 
setup flow. 

•​ A surface-wizard point-elevation picker. 
•​ A project creation/import prompt when the Control Box is empty — previously only 

creation was offered. 

Improved 

•​ Reach and Transversal can now be used without setting a depth. 
•​ 3D view reduced on-screen information, with a priority order of SmartTape → Entity → 

Depth. 
•​ Changed highlight colour in 3D view. 
•​ Picking-list entity filters are now saved. 

Fixed 

•​ Refresh of H/V GNSS accuracy status during calibration. 
•​ Most cases of bucket and entity disappearances in 3D view. 
•​ Side Layer panel button state refresh. 
•​ Several crashes. 
•​ Layer name no longer changes when the edit is validated without modifications. 
•​ Negative numbers can now be entered in object creation. 
•​ Loss of custom noise threshold. 
•​ Object tracker behaviour. 
•​ Issue where losing RTK fix before the machine was loaded caused problems. 

Limitations 

•​ No auger, clamshell, double-offset, or dozer features. 

v5.1.7 — Minor fixes on the v5.1 branch 

Fixed 

•​ A set of small stability fixes on the v5.1 line before feature work moved to v5.2. 

v5.1.6 — Bluetooth pairing, import/export, and 3D view fixes 

Improved 

•​ Bluetooth sensor pairing flow. 
•​ Import and export of machine and project files. 

Fixed 

•​ Several issues in the 3D view related to layer rendering and picking. 
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v5.1.5 — 3D depth-guiding polish and additional tiltrotator options 

Improved 

•​ Depth-guiding behaviour in 3D view. 
•​ Tiltrotator configuration — additional options exposed for advanced setups. 

v5.1.4 — Wireless sensor behaviour and calibration fixes 

Fixed 

•​ Wireless sensor battery reporting. 
•​ A calibration edge case affecting boom-and-stick machines with unusual geometry. 

v5.1.3 — Front/Side view improvements; cloud sync fixes 

Improved 

•​ Front and Side view rendering and information density. 

Fixed 

•​ Cloud folder synchronization issues affecting a subset of users. 

v5.1.2 — Sensor diagnostics and crash fixes 

Improved 

•​ Sensor diagnostics panel — clearer indication of battery, signal, and pairing state. 

Fixed 

•​ Several crashes during long guiding sessions. 

v5.1.1 — Follow-up fixes to the v5.1.0 3D engine 

Fixed 

•​ Crashes and rendering issues in the new 3D engine introduced in v5.1.0. 

v5.1.0 — 3D feature restored with a new algorithm 

The 3D feature, which had been temporarily removed in v5.0.0 during the platform rewrite, was 
reintroduced in v5.1.0 with an entirely new underlying algorithm. This is the release most v5-era 
3D customers first landed on. 

Added 

•​ 2D+ and 3D feature tiers restored. 
•​ Double-click support on the Bluetooth button — gives the operator a second 

programmable action from the BT remote. 
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•​ Manual bucket calibration using the laser pointer. 
•​ The ability to retrieve a machine file without using a USB key. 

Limitations 

•​ Same limitations as v5.0.0, except that 3D is once again available. 

v5.0.2 — Stability fixes on the post-rewrite platform 

Fixed 

•​ Several crash and stability items that surfaced on v5.0.0 and v5.0.1 in the field. 

v5.0.1 — Follow-up fixes to v5.0.0 

Improved 

•​ Dynamic Guiding and Laser Catch refinements. 
•​ Swing feature polish. 

Fixed 

•​ A set of early-v5 field issues. 

v5.0.0 — Platform rewrite — pure 2D baseline 

v5.0.0 was an architectural reset. The platform was rewritten from the ground up, and several 
features from the v4 line were temporarily removed so that the new platform could ship on a 
clean, stable base. 3D returned in v5.1.0, and the other removed features returned 
progressively through the v5.2 and v5.3 lines. See §C.3 in this appendix for a full explanation of 
the transition and what it means for upgrades. 

Added 

•​ Dynamic Guiding and Dynamic Laser Catch — the guidance now updates continuously 
as the machine moves instead of only at discrete checkpoints. 

•​ Swing Boom Assistance feature. 
•​ The Remote button, a dedicated on-screen entry point for remote support sessions. 

Limitations 

•​ Pure 2D system — no 3D feature in this release. 
•​ No auger, roto, dozer, or clamshell work tools. 
•​ A new calibration is required when upgrading from v4. 
•​ Wireless sensors must be re-paired to the Control Box. 
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C.6   v4.x Legacy Release Summary 

The v4 line preceded the v5 platform rewrite. It is documented here at summary level rather 
than per-release: most v4 customers have either upgraded to v5 or are pinned to a v4 version 
because of a specific hardware consideration (typically the XD466 chassis sensor). 
Release-by-release v4 detail is preserved in the original iDig release notes document — this 
appendix captures the milestones that matter in the field. 

v4 Milestones 

Release / branch What matters about it 

v4.16.x line Late-v4 feature additions and bug-fix cycle. v4.16.5 was the last v4 
release before the v5 rewrite. 

v4.15.0 Hardware break point — this release and everything after is NOT 
compatible with the legacy XD466 chassis sensor. Machines still 
running the XD466 must remain on v4.14.15 or earlier until the chassis 
sensor is upgraded. 

v4.15.4 Smart Tape measurement feature first introduced. 

v4.14.0 Earliest release documented in this appendix. Introduced Remote 
Software Update (over-the-air installs), 3D support for Auger (with 
bubble) and Clamshell, site-calibration file parsing from Hemisphere 
receivers, named points on the Map view, the NEKR brand of rotator, 
and WiFi improvements including recovery from wrong passwords and 
support for multiple access points. Compatible with the XD466 chassis 
sensor. 

 

The XD466 Chassis Sensor — Why v4.15.0 Is a Hardware Line 

The earliest iDig Connect systems used the XD466 big chassis sensor. Starting with v4.15.0, 
the firmware dropped support for the XD466 in favour of the BT476 — the chassis sensor that 
ships with every current system. This is a hardware change, not a software one: a machine still 
running an XD466 cannot simply update to v4.15.0 or later, because the firmware will not 
recognize the sensor. 

If a machine comes into the shop running v4.14.x and the chassis sensor part number begins 
with XD466, the correct action depends on the customer. If they are happy with the system 
as-is, leave it on the latest v4.14.x release (v4.14.15). If they want access to newer features, the 
chassis sensor must be replaced with a BT476 before the firmware can be moved forward, and 
the machine will need a full recalibration afterward. 
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REAL-WORLD TIP 
There is no v4.14-to-v5 upgrade path that preserves the XD466. A full chassis sensor 
replacement is required, followed by a v5 installation and full recalibration. This is a full 
bench-and-cab day — scope it accordingly. Most dealers schedule XD466 replacements as 
part of a broader machine service rather than standalone. 
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C.7   How to Read a Release Note 

The release entries in §C.5 follow a standard structure. The four categories — Added, 
Improved, Fixed, and Limitations — are used consistently across every release. 

Added 

Describes a new capability that did not exist in the previous release. A feature in Added requires 
the user to know it exists in order to use it — the system behaviour has not changed unless the 
user invokes the new feature. 

Improved 

Describes a change to an existing capability that is automatically applied. The user does not 
have to enable anything; the improvement is in effect the moment the firmware is installed. 
Improved items are where to look when an operator says "this menu used to behave differently." 

Fixed 

Describes a bug that was present in the previous release and is no longer present in this one. If 
a dealer is troubleshooting a specific problem, searching the Fixed lists for a keyword match — 
"drift", "bargraph", "calibration" — is often the fastest way to determine which release resolves 
the issue. 

Limitations 

Describes capabilities that are known to be missing or not yet supported in this release. The 
most important use of Limitations is cross-checking against a customer's workflow before 
committing to an upgrade — if the customer's job relies on a feature listed in Limitations for the 
target version, the upgrade is not ready for that machine. 

BEFORE YOU UPGRADE A MACHINE 
Before updating the firmware on any in-service machine, read the Limitations section of the 
target release and of every release between the machine's current version and the target. A 
feature listed in Limitations in any intermediate release may have returned by the target 
release — but if it has not, and the customer depends on it, the upgrade needs to wait. This 
check takes two minutes on the bench and saves a field callback. 

 

End of Appendix C — Release History. 
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Comprehensive subject index. Page numbers in 
orange; ranges indicate consecutive pages. 

Numerals 

 

2D Mode  134, 135, 137, 139, 169 
2D+ Mode  61, 101, 135, 173, 175, 181 
3D Mode  101, 134, 136, 138-140, 180, 183 
3D Workflow  4, 118, 150, 167, 168, 181 

A 

 

Accessories  8, 9, 12, 13, 36, 51, 196, 197, 204, 
207, 214 

Accuracy checks  4, 33, 115, 116 
Activation  9, 16, 17, 33, 38, 39, 41, 48, 52, 68, 

79, 105, 130, 131, 176, 204 
Alerts, audible  4, 14, 118-120, 122, 125, 129, 

132 
Alerts, height  4, 118, 136, 142, 177 
Antenna  9, 77, 79, 101, 207, 213 
AT&T  68 
Attachment types  56 
Automatic bucket calibration  95 

B 

 

Backup, calibration  4, 32, 82, 117 
Base station  61, 70-73, 75, 78, 79, 84, 101, 173, 

181 
Benchmark elevation  42, 130, 135, 142, 170, 

175, 178, 181, 204 
Bluetooth NMEA  59, 60, 63, 64, 76 
Boom & stick calibration  9, 10, 33, 35, 36, 59, 

80, 82, 86, 88, 90, 91, 93, 206 
Boom sensor plate  41 
Boom types  55, 85, 86 
Box, package contents  8 
Bucket calibration  33, 35, 56, 59, 80, 85, 93-95, 

101, 108, 115, 181, 217, 223, 227, 231 

Bucket focus point  128, 134-136, 142, 144, 
149, 162, 175, 184, 189 

Bucket sensor plate  44 
Buttons, joystick  4, 118, 130 

C 

 

Cables  6, 8, 9, 11-13, 25, 33, 46, 47, 50-53, 57, 
58, 82, 109-111, 196, 197, 202, 205, 208, 213, 
214 

Calibration report  104 
Calibration — backup  4, 14, 19, 32, 33, 59, 

80-82, 117, 131 
Calibration — boom & stick  4, 9, 10, 33, 35, 36, 

59, 80, 82, 83, 86, 88, 90, 91, 93, 102, 115, 206 
Calibration — bucket  33, 35, 56, 59, 80, 85, 

93-95, 101, 108, 115, 181, 217, 223, 227, 231 
Calibration — chassis  4, 9, 19, 25, 33, 37, 46, 

59, 80, 82-87, 96, 98-101, 104, 118, 201, 217, 
221, 225, 227, 232, 233 

Calibration — GNSS 3D  33, 35, 36, 59, 80, 82, 
84, 101, 115, 116, 173, 180 

Calibration — laser receiver  33, 59, 80, 82, 
105, 106 

Calibration — overview  4, 33, 59, 80, 82, 86, 88 
Calibration — swing boom  82, 96 
Calibration — tilt bucket  108 
Calibration — tiltrotator  33, 59, 80, 82, 109, 

110, 114 
CAN bus  35, 52, 56, 59, 110, 220, 228 
Catch, laser  4, 7, 9, 14, 16, 17, 118, 122, 129, 

150, 167, 168, 170, 199, 204, 213, 220, 223, 
231 

Chassis sensor — calibration  4, 9, 19, 25, 33, 
37, 46, 59, 80, 82-87, 96, 98-101, 104, 118, 
201, 217, 221, 225, 227, 232, 233 

Chassis sensor — installation  46 
Chassis sensor — transition  19, 25 
Cloud file access  2, 29, 127 
Configuration, machine  55 
Control Box setup  8, 11, 50, 59, 202, 205, 207, 

208, 214 
Coordinate shift  132, 142, 150, 151, 162, 163, 

167 
Coordinate systems  3, 4, 19, 21-24, 121, 131, 

132, 139, 142, 147, 150-158, 162, 164-167, 
181 

Cradle positioning  8, 50, 59, 202, 205, 207, 
208, 214 

Cross-section design  140, 142, 143, 188 
CT140T  6, 9, 48, 62, 101, 198, 203-205, 214 
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D 

 

Data management  132, 150, 151 
Depth for level grading  136, 178 
Design files  3, 4, 7, 32, 132, 138, 139, 142, 150, 

152, 153, 155, 159-161, 164-167, 184, 188 
Dipper (stick) sensor  42 
Display settings  126 
Dogbone bucket calibration  95 
Dual-slope surface  186 
DXF  3, 4, 7, 29, 32, 138, 150, 153, 159, 161, 183, 

188, 199 
Dynamic Laser Catch  4, 7, 9, 14, 16, 17, 118, 

122, 129, 150, 167, 168, 170, 199, 204, 213, 
220, 223, 231 

E 

 

Elevation alarm  4, 118, 136, 142, 177 
Engcon  52, 56, 109, 110, 205, 214 
Export — projects  4, 14, 16, 32, 118, 131, 150, 

157, 165, 166, 229 
Export — settings  14, 16, 29, 31, 131, 165 
Extended warranty  196, 210, 211, 213 

F 

 

Feature lineage  215, 216, 221, 223 
Field operations  3, 4, 118, 150, 167, 168, 194 
Firmware  3, 12, 14, 19-23, 110, 123, 215, 216, 

219, 221, 227, 232, 234 
First power-on  2-4, 14 
Flat surface, creating  145, 184, 185 
Focus point, bucket  128, 134-136, 142, 144, 

149, 162, 175, 184, 189 
Frequency files, radio  73 

G 

 

Gain, sensor  54, 109, 114 
Geoid  154, 156, 157, 181 
GNSS — 3D calibration  33, 35, 36, 59, 80, 82, 

84, 101, 115, 116, 173, 180 
GNSS — pairing  4, 14, 33, 57, 59, 60, 76, 79-82, 

85, 86, 124, 203, 204, 213, 217, 221, 229 

GNSS — receiver mounting  3, 6, 9, 33, 48, 
57-59, 75, 101, 181, 196, 203, 204, 214 

GNSS — receiver settings  124 
GNSS — troubleshooting  58, 61, 79, 124, 181, 

194, 195 
Guidance modes  132, 133, 142, 144, 145, 150 
Guide complete  194 

H 

 

Hardware installation  3, 33, 34, 194 
Heading accuracy  77, 79, 181 
Height alarm  4, 118, 177 

I 
 

Import — design files  132, 139, 150, 152, 159, 
161, 166, 167 

Import — projects  4, 14, 16, 32, 118, 131, 150, 
157, 165, 166, 229 

Import — settings  14, 16, 29, 31, 131, 165 
Installation — hardware  3, 13, 24, 33, 34, 36, 

38, 39, 41, 47, 48, 56, 194 
Installation — pre-install checklist  33, 35 
Installation — sensor plate  13, 37, 38, 41 
Installation — walkthrough  57 
Introduction  2-4, 173, 223 
iPoint  4, 7, 15, 62, 75, 121, 157, 195-198, 203, 

214 

J 

 

Joystick buttons  4, 118, 130, 225 

K 

 

Kinshofer NOX  52-54, 109, 111 

L 

 

Language & units  121, 132 
Laser catch, dynamic  4, 7, 9, 14, 16, 17, 118, 

122, 129, 150, 167, 168, 170, 199, 204, 213, 
220, 223, 231 
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Laser receiver calibration  33, 59, 80, 82, 105, 
106 

Layer management  4, 161 
Level grading, depth for  136, 178 
Lines for guidance  192 
Lines, measuring  190 
Localization file  4, 151-154, 157, 158, 162, 166, 

167, 181, 217, 223, 228 

M 

 

Machine configurations  55, 85, 86 
Machine profile  14, 77, 85, 86, 90, 120, 125, 181 
Measuring — lines  190 
Measuring — points  116, 187, 189 
Menu, settings  4, 14-16, 18, 22, 26, 31, 53, 85, 

117, 118, 120, 136, 143 

N 

 

Navigate to points  191 
NMEA  4, 33, 59, 60, 63, 64, 75, 76, 79, 80, 82 
NOX (Kinshofer)  52-54, 109, 111 
NTRIP corrections  4, 33, 59-63, 69, 75, 76, 79, 

80, 84, 162, 173 

O 

 

Offset, surface  132, 142, 143, 145, 146, 170, 
181 

Overview, system  2, 4, 6 

P 

 

Package contents  8 
Pairing — GNSS  4, 14, 33, 57, 59, 60, 76, 79-82, 

85, 86, 124, 203, 204, 213, 217, 221, 229 
Pairing — wireless sensors  25, 87, 123, 204, 

217, 220, 230, 231 
Part numbers  10, 25, 52, 196, 197, 199, 200, 

208, 213, 232 
Parts & accessories  196, 214 
Password protection  4, 14, 118, 120, 125 
Plates, sensor  7, 8, 13, 33-39, 41, 42, 44, 46, 

48, 50, 56, 58, 59, 181 
Points, measuring  116, 187, 189 

Powering on  3, 14 
Pre-installation checklist  33, 35 
Product tiers  6 
Profile templates  168, 188 
Projects — creating  23, 153 
Projects — import/export  165 
Projects — overview  152 
Projects — switching  152, 164, 226 

Q 

 

Quick disconnect bucket  44, 93 

R 

 

Radio corrections — UHF  4, 59-61, 70, 78, 80 
Radio frequency files  73 
Radio protocols  33, 59, 72, 75 
Receiver   see GNSS Receiver 
Release history  215, 234 
Release notes  22, 215, 232, 234 
Remote access  4, 6, 12, 14, 21, 26-28, 31, 33, 

59, 80, 118, 120, 132, 143, 150, 167, 194 
Remote update  6, 14, 19, 21, 26 
Replacement parts  196, 208 
Restrictive mode  4, 14, 118, 120, 125 
Rototilt  56, 109, 112 
RTK GNSS  6, 33, 59, 61, 62, 76, 124 

S 

 

Screen, work  4, 14, 77, 120, 132-134, 136, 139, 
141-143, 146-148, 150, 153, 154, 159-161, 
172, 174, 175, 184, 191-193 

Sensor — boom  41, 42, 55, 57, 89, 96 
Sensor — bucket  44 
Sensor — gain  54, 109, 114 
Sensor — pairing (wireless)  25, 87, 123, 217, 

220, 230, 231 
Sensor — stick (dipper)  8, 35, 42, 55, 57, 58, 

82, 88 
Settings — display  126 
Settings — GNSS receiver  124 
Settings — language & units  121, 132 
Settings — sound  122 
Settings — storage  120, 127 
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Settings — work  14, 63, 65, 68, 120, 122, 125, 
128, 129, 137, 143, 181 

Side toolbars  14, 140, 141 
SIM card setup  4, 33, 59-62, 65-69, 79, 80 
SIM card — AT&T  68 
SIM card — T-Mobile  65-68 
SIM card — Verizon  67, 68 
Single-slope surface  185, 186 
Site calibration (localization)  4, 151-154, 157, 

158, 162, 166, 167, 181, 217, 223, 228 
Site requirements  33, 36, 84 
Slope surfaces  185, 186 
Smart tape tool  3, 4, 115, 118, 136, 142, 150, 

167, 176, 216, 218, 223, 232 
Software updates  4, 5, 12, 14, 19, 22-24, 156, 

219, 223, 232 
Sound settings  122 
Staking surfaces  193 
Status bar  143, 147 
Steelwrist  52, 109, 113, 205, 214 
Stick sensor plate  42 
Storage management  120, 127 
Support, remote  3, 4, 6, 12, 14, 18, 19, 21, 

26-28, 31, 33, 59, 80, 118, 120, 132, 143, 150, 
167, 194, 219, 220, 231, 232 

Surface creation — custom  187 
Surface creation — dual-slope  186 
Surface creation — flat  145, 184, 185 
Surface creation — single-slope  185, 186 
Surface display options  133, 139, 143, 148, 

150 
Surface offset tool  132, 142, 143, 145, 146, 

170, 181 
Swing boom — calibration  82, 96 
Swing boom — operation  118, 150, 167 
System overview  2, 4, 6 

T 

 

T-Mobile  65-68 
Tape tool, smart  3, 4, 115, 118, 136, 142, 150, 

167, 176, 216, 218, 223, 232 
Tilt bucket calibration  108 
Tilted chassis calibration  6, 25, 46, 59, 80, 84, 

98, 100 
Tiltrotator — Engcon  52, 56, 109, 110, 205, 214 
Tiltrotator — Kinshofer NOX  52-54, 109, 111 
Tiltrotator — overview  33, 59, 80, 82, 109-114 
Tiltrotator — Rototilt  56, 109, 112 
Tiltrotator — Steelwrist  52, 109, 113, 205, 214 
Tool icons  142 

Toolbars, side  14, 140, 141 
Transition, chassis sensor  19, 25 
Trenching, utility  135-137, 179 
Troubleshooting  12, 26, 52, 58, 61, 79, 194, 

195, 234 

U 

 

UHF radio  4, 59-62, 70, 78, 80 
Units configuration  121, 132 
Update — remote  6, 14, 19, 21, 26 
Update — USB  12, 14, 19-21 
Updates, software  4, 5, 12, 14, 19, 22-24, 156, 

219, 223, 232 
Utility trenching  135-137, 179 

V 

 

v4 → v5 transition  215, 220 
v4.x legacy releases  215, 216, 232 
v5.x release detail  215, 216, 225 
Verizon  67, 68 
Volumes 1–8 overview  5, 35, 46, 55 

W 

 

Warranty  18, 58, 123, 196, 210, 211, 213 
WebUI  4, 33, 59, 63-65, 69, 70, 72, 74-76, 79 
Wireless sensors  23, 25, 36, 87, 120, 123, 181, 

217, 220, 227, 230, 231 
Work screen  4, 14, 77, 120, 132-134, 136, 139, 

141-143, 146-148, 150, 153, 154, 159-161, 
172, 174, 175, 184, 191-193 

Work settings  14, 63, 65, 68, 120, 122, 125, 
128, 129, 137, 143, 181 

Z 

 

Zoom & focus controls  149 
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